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2 Introduction 

2.1 What is ASAP Utilities? 
ASAP Utilities is a powerful Excel add-in that adds new functionality to Microsoft Excel to 

save time and speed up your work. 

We're proud and happy that, ever its first release in 1999, we can help Excel users all over 

the world. 

ASAP Utilities is called this way because it significantly reduces time-consuming work. ASAP 

is an acronym that stands for "As Soon As Possible". Some choose to spell it out, others 

tend to pronounce it "aysap". The word “utilities” means something that is useful. 

Combined together ASAP Utilities stands for useful time-saving macro tools for Excel. 

During the past 22 years our add-in has grown to become probably one of the world's most 

popular add-ins for Microsoft Excel. 

Over 2,500 users have reviewed ASAP Utilities and given it an average rating of 4.9 out of 5: 

https://www.trustpilot.com/review/asap-utilities.com 

We are proud to mention that ASAP Utilities is currently used worldwide in over 170 

different countries by 750,000+ users and purchased by 23,500+ organizations. 

 

2.2 Our Mission Statement 

“ Our mission is to put a smile on the face of Excel users all over the world, 

by providing a friendly and easy to use add-in, that saves time and 

speeds up their work in Excel. 
” 
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2.3 About this User Guide 
This User Guide will show you what you can do with ASAP Utilities. It will tell you how to 

install this Excel add-in and it gives a description of all the utilities available. 

ASAP Utilities makes YOU rock in Excel! 

In our opinion a good program should be easy to use without the need of any 

documentation. However, during the last years, the need for documentation has increased. 

ASAP Utilities has more tools than ever, and this user guide will help you to get the best out 

of it. 

Besides documenting the utilities in ASAP Utilities, we have also included a “How to” 

chapter. In that chapter (chapter 6, “Practical Tricks to Save Hours in Excel with 

ASAP Utilities” on page 286) we have listed common Excel questions and how to use 

ASAP Utilities to answer them. 

The most recent version of this User Guide is available on our website: 

https://www.asap-utilities.com 

This document currently covers everything available in version 7.9 which is, when this 

edition of the User Guide is released, the latest version.  

2.4 Save paper 
To save paper, this document is optimized for duplex printing. 

To save even more paper, you can read this User Guide in PDF format on your computer, 

tablet or e-reader. 

2.5 Intended audience 
The principal audience for this user guide is people that use Excel on a regular basis. The 

focus is on introducing you to the tools available in ASAP Utilities. 

We assume that you are already familiar with Excel and its structure (workbooks, 

worksheets, ranges etc.). If you do not use the international/English version of Excel then 

we recommend you to read paragraph 2.6, “The Excel screen in English” on page 9. 

2.6 The Excel screen in English 
This documentation is in English since most people that use Excel speak this language.  

Even though most people speak English, translating certain things in Excel might become 

difficult or look odd. That is why we show you the layout of Excel and how certain things 

are called in English. 
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2.6.1 Excel 365, 2021, 2019, 2016, 2013, 2010 and 2007 and 

newer 

 

 

 

  

title bar 

formula bar 

grid lines 

selection or  

range of cells 

page break 

vertical scrollbar 

horizontal scrollbar 

(work)sheet tabs 

column headers 

row headers 

ribbon (menu) 

status bar 

name box 

active cell (B2) 
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2.6.2 Excel 2003 and earlier 

 

 

 

The different sheet types in English: 
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horizontal 
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3 Getting started 

3.1 How to get a copy of ASAP Utilities 

3.1.1 Download from our website 

You can download a copy of ASAP Utilities from our website: 

https://www.asap-utilities.com 

 

  

https://www.asap-utilities.com/
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3.2 System requirements 

3.2.1 Excel versions supported 

ASAP Utilities 7 works with the Windows editions of: 

▪ Excel 365 Desktop (both 32 bit and 64-bit) 

▪ Excel 2021 (both 32 bit and 64-bit) 

▪ Excel 2019 (both 32 bit and 64-bit) 

▪ Excel 2016 (both 32 bit and 64-bit) 

▪ Excel 2013 (both 32 bit and 64-bit) 

▪  Excel 2010 (both 32 bit and 64-bit) 

▪  Excel 365 (both 32 bit and 64-bit) 

▪  Excel 2007 

▪ Excel 2003 

▪ Excel 2002/XP 

▪ Excel 2000 

3.2.2 Windows versions supported 

ASAP Utilities works on both 64-bit and 32-bit Windows versions, including the latest 

Windows 11 and the server editions of Windows. 

The minimum supported Windows version is Windows 2000. 

Basically, if you can run any of the supported Excel versions from paragraph 3.2.1, “Excel 

versions” on page 13, you can use ASAP Utilities. 

3.2.3 Other requirements 

Basically, if you can run any of the supported Excel versions from paragraph 3.2.1, “Excel 

versions” on page 13, then your system is ready to use ASAP Utilities. 

ASAP Utilities needs approximately 35-45 MB of disk space. This is for the program files and 

the PDF User Guide together. 

The recommended minimum screen resolution is 1024 x 768 pixels although ASAP Utilities 

will also work on smaller screens. The recommended screen resolution is 1920 x 1080 (full 

HD) or larger. 

3.2.4 International versions of Excel, all supported 

ASAP Utilities will run in all versions of Excel that meet the system requirements of Excel. 

It doesn’t matter if your Excel is the international (English) version or you have local Dutch, 

French, Spanish, Russian, Chinese, Arabic, Hebrew or any other language version. It works 

in all. 
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3.3 Install and uninstall 
To install ASAP Utilities, just follow the steps in the setup. Detailed and more technical 

information is provided in paragraph 12.1, “Automatic installation“ on page 348. 

Removing ASAP Utilities can be done easily via the Windows Control Panel, just like other 

software. 

3.4 Change the language of ASAP Utilities 
In ASAP Utilities you can choose from the following 10 languages: 

1. English 
2. Dutch (Nederlands) 
3. German (Deutsch) 
4. Spanish (Español) 
5. French (Français) 

6. Portuguese (Brazil) (Português do Brasil) 
7. Italian (Italiano) 
8. Russian (Русский) 
9. Chinese (Simplified) (中文(简体)) 
10. Japanese (日本語) 

On popular demand more languages can be added, please contact us. 

On its first use, ASAP Utilities will display all text in the same language as Excel. 

If your Excel version is not one of the languages that ASAP Utilities has built-in, then 

ASAP Utilities will default to the English language. 

 



FREQUENTLY UPDATED ASAP Utilities User Guide 

 

Getting started     15 

 
 

3.4.1 ASAP Utilities in English 

 
 

 

Descriptions of all tools in ASAP Utilities 

https://www.asap-utilities.com/features.php?lang=en_us 

 

https://www.asap-utilities.com/features.php?lang=en_us
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3.4.2 ASAP Utilities in Dutch (Nederlands) 

 
 

 

 

Beschrijving van alle tools in ASAP Utilities 

https://www.asap-utilities.com/features.php?lang=nl_nl 

 

https://www.asap-utilities.com/features.php?lang=nl_nl
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3.4.3 ASAP Utilities in German (Deutsch) 

 
 

 

 

Beschreibung aller Tools von ASAP Utilities 

https://www.asap-utilities.com/features.php?lang=de_de 

 

https://www.asap-utilities.com/features.php?lang=de_de
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3.4.4 ASAP Utilities in Spanish (Español) 

 
 

 

 

 

Descripciones de todas las herramientas en ASAP Utilities 

https://www.asap-utilities.com/features.php?lang=es_es 

 

https://www.asap-utilities.com/features.php?lang=es_es
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3.4.5 ASAP Utilities in French (Français) 

 

 

 

Descriptions de tous les outils dans ASAP Utilities 

https://www.asap-utilities.com/features.php?lang=fr_fr 
  

https://www.asap-utilities.com/features.php?lang=fr_fr
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3.4.6 ASAP Utilities in Portuguese (Brazil) (Português do 

Brasil) 

  

  
 
 

Descrições de todas as ferramentas em ASAP Utilities 

https://www.asap-utilities.com/features.php?lang=pt_br 
 

https://www.asap-utilities.com/features.php?lang=pt_br
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3.4.7 ASAP Utilities in Italian (Italiano) 

 

 

 

Descrizione di tutti gli strumenti di ASAP Utilities 

https://www.asap-utilities.com/features.php?lang=it_it 
 

  

https://www.asap-utilities.com/features.php?lang=it_it
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3.4.8 ASAP Utilities in Russian (Русский) 

 

   

 

Описания всех инструментов в ASAP Utilities 

https://www.asap-utilities.com/features.php?lang=ru_ru 

  

https://www.asap-utilities.com/features.php?lang=ru_ru
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3.4.9 ASAP Utilities in Chinese (Simplified) (中文(简体)) 

  
 

  

 

ASAP Utilities 中所有工具的说明 

https://www.asap-utilities.com/features.php?lang=zh_hans 

 

  

https://www.asap-utilities.com/features.php?lang=zh_hans
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3.4.10 ASAP Utilities in Japanese (日本語) 

 
 

 

 

ASAP Utilitiesのすべてのツールの説明 

https://www.asap-utilities.com/features.php?lang=ja_jp 

 

  

https://www.asap-utilities.com/features.php?lang=ja_jp
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3.4.11 Office Update 

We recommend you to always install the latest updates and service packs from MS Office 

to improve Office its stability and security. Although it is not necessary to run ASAP Utilities 

it is a good practice to keep your system up-to-date. 

3.4.12 Windows update 

Although it is not necessary to run ASAP Utilities, it is recommended that you install the 

latest service packs and updates to obtain the best out of your computer and keeping it 

more secure. Run Windows update on your system. 

3.5 How to operate ASAP Utilities 
Once you have installed ASAP Utilities it adds an extra button/tab in Excel’s main menu. 

All tools can be accessed via the ASAP Utilities menu and/or its shortcuts. 

3.5.1 ASAP Utilities in Excel 365, 2021, 2019, 2016, 2013, 

2010 or 2007 
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3.5.2 ASAP Utilities in Excel 2003, 2002/XP or 2000 

 

3.6 Undo 

3.6.1 Most (but not all) tools in ASAP Utilities have an undo 

Not all tools in ASAP Utilities have an undo. Therefore, it is a good practice to thoroughly 

test ASAP Utilities with non-critical data before relying on it or save your work before you 

try something new with ASAP Utilities. 

We did not just turn-off the undo or something like that; Excel has no built-in automatic 

undo for macros. We are aware of the importance of global undo capabilities and continue 

working on it. 

3.6.2 No undo in macros are by design of Excel 

By design, Excel nearly always resets the undo when you run a macro. If you run a macro, 

you will see that the undo-history is reset, and the undo-button is disabled. 

To enable undo for macros we must write our own undo routine for ASAP Utilities. 

Basically, this is another macro that stores the settings before running the tool and sets the 

undo to run another macro that restores the original settings. Excel does not allow multi-

step undo for programmers so only the last action in ASAP Utilities can be undone (if 

available). 
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If you need to undo changes that were made prior to running an ASAP Utilities tool the only 

option is to close the workbook without saving. This will revert to the original version, but 

all changes made during the session will be lost. 

Depending on the tools in ASAP Utilities some of the custom undo-routines are relatively 

simple and have been implemented. However, some of the operations require complex 

undo-procedures that have not yet been implemented because they are simply too difficult 

or complex to create in the amount of time that we have available. 

Since ASAP Utilities is under constant development perhaps the undo you are missing right 

now is implemented in the next version. 
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4 Purchase ASAP Utilities 

4.1 Time saved, “return on investment” 
The tools from ASAP Utilities add new functionality to Excel and are guaranteed to save you 

time and speed up your work. 

The time saved with ASAP Utilities will recover the license costs nearly always within a few 

weeks. And the purchase is a one-time free, not a yearly subscription. 

On average ASAP Utilities saves people 32 hours each year (measured among 142,522 users 

in March 2022). 

With the following tool you can see how much time (and money) ASAP Utilities has saved 

you so far: 

ASAP Utilities Options » Report the estimated time that is saved by ASAP Utilities 

 

4.2 Editions 
ASAP Utilities exists in two editions: 

▪ Business edition, 90 Day Trial (with full functionality)  

Free 90-day trial. Price is USD 49 or less with volume discounts 

▪ Home and Student edition 

Free for home projects, schoolwork and use by charitable organizations 

The ASAP Utilities 'Home and Student' edition is free and is (only) for non-commercial use, 

such as home projects, schoolwork and use by charitable/non-profit organizations such as 

the International Committee of the Red Cross, UNICEF, Amnesty International, 

MSF/Doctors Without Borders etc.. 



FREQUENTLY UPDATED ASAP Utilities User Guide 

 

Purchase ASAP Utilities     29 

 
 

4.3 When to buy a license 

4.3.1 Business Edition 

This edition of ASAP Utilities is for companies, governments, etc... 

We offer a free 90-day trial version with functionality. 

To continue to use it after the 90-day trial period, simply purchase a license key. 

4.3.2 Home & Student Edition, Charitable Organizations 

This edition of ASAP Utilities is free to use and only for home projects, schoolwork, and 

charitable organizations. By offering a free version of ASAP Utilities we want to contribute 

to society. 

Purchasing a license is voluntary for this group of users. A reason to purchase can be: 

▪ if you like ASAP Utilities and think it is worth the money 

▪ if you do not want to install an update once or twice a year 

▪ to get priority support 

▪ to support future development  

Note: This Home & Student edition cannot be used for commercial or business use. 

4.4 Key benefits of a license 
▪  Use it in a commercial organization (which is what most companies are)  

▪  Priority support via email  

▪  No forced updates twice a year 

▪  A licensed version will never expire 

▪ Free upgrades for at least 3 years or to all versions 7.x and 8.x, whichever is longer. 

4.5 Who uses ASAP Utilities? 
ASAP Utilities exists since 1999 and is used in a variety of organizations. 

We are proud to mention that our list of clients exceeds 23,500 organizations in more than 

140 countries worldwide (measured in April 2021). 

See also paragraph 8.4, “Our clients, who uses ASAP Utilities?” on page 331. 
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4.6 How to order 
The purchase process is quick, secure, and easy. 

You can choose from several online and offline payment methods, such as credit card, 

bank/wire transfer and several other payment methods. 

https://www.asap-utilities.com/buy.php 

We have also made a walkthrough of the purchase process that shows all the options and 

steps: 

https://www.asap-utilities.com/registration-help.php 

4.6.1 Instant delivery 

Your registration code is sent to you by email immediately after the order is completed and 

the payment is received. 

This is usually within 5-30 minutes when you pay with a credit card. With other payment 

methods such as a bank/wire transfer, invoice, or check/money order it might take a little 

longer. As soon as the money is received the order is processed and you receive your 

license key. 

4.6.2 Secure ordering, online and offline payment methods 

All orders/payments are handled by our reseller/partner MyCommerce (part of 

Digital River) so that we can offer our clients several payment methods worldwide and, 

with clients in over 140 countries, it reduces the worldwide TAX/VAT administration and 

thus we can spend more time on the development and support of ASAP Utilities. 

Orders are processed through a secure SSL connection in a PCI compliant data environment 

from MyCommerce. Your personal information is kept secure and will not be transferred by 

them to other parties. Our e-commerce partner provides a highly secure online payment 

process for most credit cards and they also support offline payments by check and wire 

transfer. 

https://www.asap-utilities.com/buy.php
https://www.asap-utilities.com/buy.php
https://www.asap-utilities.com/registration-help.php
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4.7 How to enter your license details 
To turn your copy of ASAP Utilities into a registered version do the following: 

1. In the Excel menu choose the right-bottom button in the ASAP Utilities Tab in Excel. 

(Trial version…, Enter License… or Home&Student Edition…). 

Then click on the button "Enter registration information". 

Excel 365, 2021, 2019, 2016, 2013, Excel 2010 or Excel 2007: 
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Excel 2003, Excel 2002/XP or Excel 2000: 

 

2. Fill in all the fields exactly the same as in the email with your full license details. 

You received two emails after the order was completed. The email from "ASAP Utilities 

(A Must in Every Office BV)" contains the full license information. 

After you entered the information click on the "Register" button. 

3. We recommend you to use "copy and paste" to avoid typing errors. 

The information is case sensitive. 

You can use the shortcut Control+V to paste the information in the fields. 
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5 Available tools 
In this chapter a short description is given of each tool (utility) as presented in the 

ASAP Utilities menu .  

Most tools provide extra functionality to Excel. Some tools just make Excel’s built-in tools 

easier to access, either because they are hard to find or because now you can add your own 

shortcut to it. 

5.1 English, German, Spanish, French, Portuguese 

(Brazil), Italian, Russian, Chinese (Simplified), 

Japanese and Dutch descriptions 
The most recent descriptions and examples in English, German, Spanish, French, 

Portuguese (Brazil), Italian, Russian, Chinese (Simplified), Japanese and Dutch are available 

on our website: 

https://www.asap-utilities.com/asap-utilities-excel-tools.php 

 

https://www.asap-utilities.com/asap-utilities-excel-tools.php
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5.2 ASAP Utilities in the Excel menu 
The tools from ASAP Utilities can be accessed via the ASAP Utilities menu/tab in Excel: 

5.2.1 In Excel 365, 2021, 2019, 2016, 2013, 2010 and 2007 

 

5.2.2 In Excel 2003, 2002/XP and 2000: 
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5.2.3 Right-click/context menu 

The most popular tools added are added to the right-click/context menu when you click on: 

▪ cells 

▪ column headings 

▪ rows headings/numbers 

▪ sheet tabs 

By default, several tools from ASAP Utilities are shown in the right-click context menu. 

Users with Excel 2000-2003 can optionally turn this off/on via: 

ASAP Utilities » ASAP Utilities Options » Settings, language and contact information... 

1 Cell(s) right-click/context menu 

When you right-click on a cell: 
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2 Column(s) right-click/context menu 

When you right-click on a column heading: 

 

3 Row(s) right-click/context menu 

When you right-click on a row heading: 
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4 Sheet(s) right-click/context menu 

When you right-click on sheet tab: 

 

 

5.3 Save time with keyboard shortcuts 
Studies calculate that using keyboard shortcuts allows to work 10 times faster than working 

with the mouse. The time you spend looking for the mouse and then getting the cursor to 

the position you need is lost time! Reducing the working time by 10 brings you greater 

efficiency. 

You can view or edit the shortcuts to start the tools from ASAP Utilities via: 

ASAP Utilities » Favorites & Shortcuts » Edit your favorite tools and shortcut keys... 

 

By default, ASAP Utilities uses the following shortcuts (which you can customize): 

Shortcut Action 

▪ Ctrl+Alt+A Select adjacent cells in column with the same value 

▪ Ctrl+Alt+B Reload all installed add-ins (rebuilds the menu) 

▪ Ctrl+Alt+C Color each n’th row or column in selection… 

▪ Ctrl+Alt+D Deselect cells… 

▪ Ctrl+Alt+E Set default path to current file 

▪ Ctrl+Alt+F Create a list of filenames and properties in a folder… 

▪ Ctrl+Alt+G Export selection or active sheet as new file… 

▪ Ctrl+Alt+H Find and/or replace in all sheets… 

▪ Ctrl+Alt+I Apply formula/calculation to selected cells… 

▪ Ctrl+Alt+J Start the last used utility again… 

▪ Ctrl+Alt+Shift+Right Arrow Extend selection to the last used column 

▪ Ctrl+Alt+Shift+Down Arrow Extend selection to the last used row 

▪ Ctrl+Alt+M Move or resize selected range… 

▪ Ctrl+Alt+N Add new worksheet (fill in a name)… 

▪ Ctrl+Alt+O Select cells based on content, formatting and more… 
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Shortcut Action 

▪ Ctrl+Alt+P Change formulas to their calculated values 

▪ Ctrl+Alt+Q Quick numbering of selected cells… 

▪ Ctrl+Alt+R Reset Excel’s last cell 

▪ Ctrl+Alt+S Save file and create backup… 

▪ Ctrl+Shift+I Vision Control… 

▪ Ctrl+Alt+X Move selected data (only values)… 

▪ Ctrl+Alt+Y Paste special (with combinations)… 

▪ Ctrl+Shift+D Insert current date and time with seconds 

▪ Ctrl+Shift+T Insert current time with seconds 

▪ Ctrl+Alt+Z Find and run a utility… 

 

5.3.1 In Excel 365, 2021, 2019, 2016, 2013, 2010 and 2007 
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5.3.2 In Excel 2003, 2002/XP and 2000: 
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5.4 Description of the tools in English 

5.4.1 Vision Control... 

This tool shows the immediate result or your changes, for example if you uncheck the grid, 

you will see the effect immediately. 

 

Worksheet settings: 

▪ Gridlines 

▪ Page breaks 

▪ Row & column headers 

▪ Zero values 

▪ Formulas 

▪ Outline symbols 

▪ Zoom, you can use a slider to set the zoom percentage. As you slide you will immediately 

see the result. 

You can quickly apply the settings of the selected worksheets to all worksheets in your 

workbook. 

 

Workbook settings: 

▪ Sheet tabs 

▪ Horizontal scroll bar 

▪ Vertical scroll bar 

▪ Reference style: A1 or R1C1 

▪ Show objects: show all, show placeholders or hide all 

 

Display settings for Excel on the application level: 

▪ Formula bar 

▪ Status bar 

▪ Toolbars 

▪ Full screen 

▪ Comments: none, comment indicator only or comment & indicator 

 

With this tool you can also: 

▪ Browse through all open workbooks. 

▪ Browse through the worksheets in your workbook and quickly see the settings per 

worksheet. 

▪ Quickly change the way your worksheet, workbook or Excel is displayed. 

▪ Remove the selection restrictions in all worksheets. 

▪ Set the default folder to the path of the selected workbook. This causes the dialogs for 

opening and saving files to start in this folder the next time you use them. 
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▪ Reset the statusbar. Useful when the status bar is locked, for example with a certain 

message due to a macro that was not properly finished. 

▪ Reset everything to default application settings. This will reset the statusbar, set the 

calculation to automatic, enable the display of alerts (Application.DisplayAlerts = True), 

set the cursor to default and enable all toolbars. 

 

By default this utility can be started with the shortcut Ctrl+Shift+I. 

 

Example screenshot: 1 Settings for current workbook 

 
 

Example screenshot: 2 Application settings 
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5.4.2 Favorites & Shortcut keys 

A selection of your favorite tools. You can customize the list of tools that is shown here. 

 

1 Edit your favorite tools and shortcut keys... 

ASAP Utilities contains a lot of different utilities. 

With the "Favorites & Shortcut keys" you can add the tools from ASAP Utilities that you use 

most frequently and assign your own shortcuts to them.  

 

By default, ASAP Utilities uses the following shortcuts (which you can customize): 

Shortcut Action 

▪ Ctrl+Alt+A Select adjacent cells in column with the same value 

▪ Ctrl+Alt+B Reload all installed add-ins (rebuilds the menu) 

▪ Ctrl+Alt+C Color each n'th row or column in selection... 

▪ Ctrl+Alt+D Deselect cells... 

▪ Ctrl+Alt+E Set default path to current file 

▪ Ctrl+Alt+F Create a list of filenames and properties in a folder... 

▪ Ctrl+Alt+G Export selection or active sheet as new file... 
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▪ Ctrl+Alt+H Find and/or replace in all sheets... 

▪ Ctrl+Alt+I Apply formula/calculation to selected cells... 

▪ Ctrl+Alt+J Start the last used utility again... 

▪ Ctrl+Alt+Shift+Right Arrow Extend selection to the last used column 

▪ Ctrl+Alt+Shift+Down Arrow Extend selection to the last used row 

▪ Ctrl+Alt+M Move or resize selected range... 

▪ Ctrl+Alt+N Add new worksheet (fill in a name)... 

▪ Ctrl+Alt+O Select cells based on content, formatting and more... 

▪ Ctrl+Alt+P Change formulas to their calculated values 

▪ Ctrl+Alt+Q Quick numbering of selected cells... 

▪ Ctrl+Alt+R Reset Excel's last cell 

▪ Ctrl+Alt+S Save file and create backup... 

▪ Ctrl+Shift+I Vision Control... 

▪ Ctrl+Alt+X Move selected data (only values)... 

▪ Ctrl+Alt+Y Paste special (with combinations)... 

▪ Ctrl+Shift+D Insert current date and time with seconds 

▪ Ctrl+Shift+T Insert current time with seconds 

▪ Ctrl+Alt+Z Find and run a utility... 

 

Example screenshot: Change your favorite utilities and assign your own shortcut 
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5.4.3 Select 

A collection of tools which make the selection of various items easier or now even possible.  

1 Select cells based on content, formatting and more... 

With this tool you can select cells based on their value, formatting style and other 

properties. 

You can for example select all cells between 50 and 250 or all bold cells or all red cells. 

 

You can use the following criteria to select cells based on their contents: 

▪ between 

▪ not between 

▪ equal to 

▪ not equal to 

▪ greater than 

▪ less than 

▪ greater than or equal to 

▪ less than or equal to 

▪ begins with 

▪ does not begin with 

▪ ends with 

▪ does not end with 

▪ contains 

▪ does not contain 

▪ like (text, with use of wildcard characters) 

▪ not like (text, with use of wildcard characters) 

▪ duplicate values 

▪ unique values 

▪ empty cells 

▪ not empty cells 

▪ FALSE 

▪ TRUE 

▪ text length 

▪ values in lowercase 

▪ values in UPPERCASE 

▪ odd numbers 

▪ even numbers 

▪ number (constant) 

▪ number (formula) 

▪ number (link to sheet) 

▪ number (link to file) 

▪ formula with reference to file 

▪ formula with reference to sheet 

▪ contains any of the values specified in a range 

▪ does not contain any of the values specified 

in a range 

▪ contains any of the full words specified in a 

range 

▪ does not contain any of the full words 

specified in a range 

▪ equals a value specified in a range 

▪ does not equal a value specified in a range 

▪ does not equal a value specified in a range 

▪ contains all values specified in a range 

▪ contains all full words specified in a range 

▪ matches regular expression 

 

 

You can use the following criteria to select cells based on formatting and more: 

▪ cell color 

▪ font color 

▪ font name 

▪ font size 

▪ font = bold 

▪ font <> bold 

▪ font = underline 

▪ font <> underline 

▪ font = italic 

▪ font <> italic 

▪ strikethrough 

▪ has hyperlink 

▪ has comment 

▪ protected cells 

▪ unprotected cells 

▪ odd rows 

▪ even rows 

▪ odd columns 

▪ even columns 

▪ visible cells 
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▪ hidden value/formula 

▪ number format contains 

▪ merged cells 

▪ unmerged cells 

 

 

You can use the following criteria to select cells based on their date: 

▪ between 

▪ not between 

▪ equal to 

▪ not equal to 

▪ greater than 

▪ less than 

▪ greater than or equal to 

▪ less than or equal to 

▪ Weekday 

▪ Month 

▪ Year 

▪ Quarter

 

Some people use this utility as an alternative for or addition to Excel's AutoFilter. 

 

By default this utility can be used with the shortcut Ctrl+Alt+O. 

 

Remark: 

The speed of the utility decreases if the matching cells are in many non-contiguous blocks 

of cells. The speed can be increased by first sorting your data. 

You cannot use this utility to select cells on a condition that is set via conditional 

formatting. 

Due to a limit in Excel, this utility can select a maximum of 8192 non-contiguous blocks of 

cells. More information about this is on the Microsoft website: 

https://support.microsoft.com/kb/832293/en-us 

 

Example screenshot: 1 Select cells based on their value 

  

https://support.microsoft.com/kb/832293/en-us
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Example screenshot: 2 Select the cells with duplicated values 

 
 

Example screenshot: 3 Select by text length 

 
 

Example screenshot: 4 Select cells by their formatting and more such as bold cells 
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Example screenshot: 5 Select the cells with the same color as cell A2 (yellow) 

 
 

Example screenshot: 6 Select all cells that are strikethrough (perhaps marked for 

deletion) 

 
 

Example screenshot: 7 Select cells by date such as all dates that are on Tuesday 
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2 Conditional row and column select, hide or delete... 

This utility allows you to select, hide or remove rows or columns based on a certain 

condition. 

 

You can use the following criteria to select, hide of remove the entire rows or columns: 

▪ between 

▪ not between 

▪ equal to 

▪ not equal to 

▪ greater than 

▪ less than 

▪ greater than or equal to 

▪ less than or equal to 

▪ like (text, with use of wildcard characters) 

▪ not like (text, with use of wildcard characters) 

▪ duplicate values (you can choose to keep the 

first value) 

▪ unique values 

▪ odd rows 

▪ even rows 

▪ every n'th row number 

▪ odd columns 

▪ even columns 

▪ every n'th column number 

▪ empty cells 

▪ completely empty rows 

▪ completely empty columns 

 

With the criteria for text and duplicate or unique values you can choose if you want the 

utility to be case sensitive. 

When looking for duplicates the program also searches in hidden cells in your selection, 

with the other search options hidden cells are skipped. 

 

Some people use this utility as an alternative for or addition to Excel's AutoFilter. 

 

Example screenshot: 1 Conditional row and column select hide or delete 
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Example screenshot: 2 Create a list of unique brand names 

 
 

Example screenshot: 3 Each brand listed once 
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3 Move or resize selected range... 

With this utility you can easily move or resize your selected range of cells. 

This utility will only change you selected range of cells, not the data underneath it. 

 

This is very powerful tool in combination with for example the "Select cells based on 

content, formatting and more..." utility. For example, if you have to make the cells in 

column B bold where the value in column A is "The Netherlands". You can then use the 

conditional select on column A and then use this "move" utility to move your selected 

range one column to the right. You then have selected all cells in column B that have in the 

same row the value "The Netherlands" in column A. 

 

By default you can start this utility with the shortcut Ctrl+Alt+M. 

 

Example screenshot: 1 Move or resize selected range 
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4 Deselect cells... 

With this utility you can deselect cells, something that is normally not possible in Excel. 

In most MS Windows programs you can deselect by holding the Control-key. That does not 

work in Excel, which is why this utility is very useful. 

 

By default you can start this utility with the shortcut Ctrl+Alt+D. 

 

Example screenshot: 1 Before 

 
 

Example screenshot: 2 After 
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5 Inverse selection... 

This utility will invert your selection.  

It will ask you to select a range, and extract your current selection from it. What remains is 

a selection which consists of the new cells, but without your initial selection. 

This can be useful for example when you want to select a lot of cells, except for a few ones. 

This is a bit of the opposite of the "Deselect cells..." utility. 
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6 Merge selection of selected areas 

This utility merges multiple contiguous selections (areas) of cells into a new selection. 

 

Sometimes Excel needs one selected range to perform certain actions and gives you the 

error "The command you chose cannot be performed with multiple selections. Select a 

single range and click the command again.".  

If the resulting selection is a solid square range you can use this utility to combine the 

multiple selections into a new single selection. 

If the individual selections together make a contiguous rectangle, you can use this tool to 

create a new single selection. 

 

For example when your select the range [A10:A50] and [B10:B50], this tool will make it one 

selection: [A10:B50]. 

 

Example screenshot: 1 Excel error, select a single range 

 
 

Example screenshot: 2 Your selected areas transformed to one single range 
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7 Select adjacent cells below active cell with the same value 

This utility will expand your selection to include all adjacent cells which have the same 

value below your active cell. 
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8 Select adjacent cells in column with the same value 

This utility will expand your selection to include all adjacent cells which have the same 

value above and below your active cell. 

 

By default you can start this utility with the shortcut Ctrl+Alt+A. 

 

 

9 Extend selection to the last used row 

This utility will extend your selected range to the last used row on your worksheet. 

This way you can easily extend your selection without having to scroll down. 

 

This is very useful when you cannot use Excel's built in shortcuts such as 'Ctrl+Shift+Arrow 

key down' because of empty cells in between or 'Ctrl+Shift+End' because you only want to 

extend your selection down and not include the columns to the right. 

You can for example use this to quickly copy a formula down to the last used row without 

having the difficulty of scrolling and finding the end of your data manually. 

 

By default you can start this utility with the shortcut Ctrl+Alt+Shift+Down Arrow. 
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10 Extend selection to the last used column 

This utility will extend your selected range to the last used column on your worksheet. 

This way you can easily extend your selection without having to scroll to the right. 

 

This is very useful when you cannot use Excel's built in shortcuts such as 'Ctrl+Shift+Arrow 

key right' because of empty cells in between or 'Ctrl+Shift+End' because you only want to 

extend your selection to the right and not include the rows at the bottom. 

Very useful when for example you want to copy a formula to the right to the last used 

column. 

You can for example, use this to quickly copy a formula to the right to the last used column 

without having the difficulty of scrolling and finding the end of your data manually. 

 

By default you can start this utility with the shortcut Ctrl+Alt+Shift+Right Arrow. 
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11 Select cell in selection where value changes 

This utility selects the cell in a selected range where the value changes. 

 

This is helpful when dealing with a large number of adjacent cells with the same value in a 

column and you want to "jump" down to the cell where the value changes. 
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12 Select cells with the smallest number 

This utility selects the cells with the smallest number in your selected range. 

Excel's =MIN() function is used to determine the smallest value and then this utility selects 

the cells with that value. 
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13 Select cells with the largest number 

This utility selects the cells with the largest number in your selected range. 

Excel's =MAX() function is used to determine the largest value and then this utility the cells 

with this value 
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14 Select all cells with an error 

This utility will select all cells on your worksheet with a formula that results in an error 

value. 

 

Tip: 

If you want to hide these errors, for example if you use a =VLOOKUP() formula, the 

following tool from ASAP Utilities can be useful: 'Custom formula error message' 
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15 Select all sheets in your workbook 

This utility will select all sheet tabs in your workbook. 

 

This can also be done in Excel by right clicking on a sheet tab and then choosing to select all 

sheets, but a lot of people don't know this. 

The advantage of this tool in ASAP Utilities is that you can assign your own shortcut to this 

action. 

 

 

16 Select all objects on current worksheet 

This utility selects all objects on your current worksheet. 

These objects are for example shapes, text boxes, pictures, wordart, clip art, charts, forms 

toolbar controls, control toolbox controls, etcetera. 
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17 Print preview selection 

This utility will show you a print preview of only your selection.  

18 Print selection 

This utility will print your selection immediately to the default printer.  

19 Set current selection to all worksheets 

This utility selects the currently selected range on all worksheets in your workbook. 

This way you can for example quickly set the selected range to A1 on all sheets at once. If 

you use your workbook as a form for completion such as a weekly report this can be very 

useful. 
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5.4.4 Sheets 

1 Add new worksheet (fill in a name)... 

This utility asks you for a name and then adds a new worksheet with that name. 

This way a new worksheet is added at then end of your sheets with the name you provide. 

It is easier than inserting a sheet; double-click it and then typing the name. If you use the 

shortcut to start this utility it is faster too. 

 

By default this utility can be started with the shortcut Ctrl+Alt+N. 

If you just want to insert a worksheet without specifying a name you can use Excel's 

shortcut Shift+F11. 

 

 

2 Insert multiple sheets (uses the cell values as sheet names)... 

This utility quickly adds new worksheets based on the information in your selected 

datarange. 

For each cell in your selection a new worksheet will be created and the cell content will be 

used for the name of the new worksheet. 

You can specify to use a certain worksheet as a source/template sheet. This way you can for 

example easily create 52 copies of that worksheet. 

If you use Excel version XP/2002 or newer then you can also specify to use the cell color for 

the sheet-tab color of the new worksheets. 

 

Usage: 

1. Select a range of cells that contain the names for the new sheets. (You can use the "Quick 

numbering of selected cells" utility from ASAP Utilities, or Excel's built in fill tools to help 

you quickly create a list of names). 

2. Start this utility, set the options and a sheet will be created for each and based on each 

cell in your selection. 
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3 Rename current sheet... 

This utility asks you for a new name and then renames the current sheet. 

You can also double-click on the sheet-tab to rename it or do it via Excels Format menu. 

The advantage of this tool in ASAP Utilities is that you can assign a shortcut to it via the 

favorites menu. 

 

 

4 Quickly rename multiple sheets at once... 

This tool allows you to quickly rename multiple or all sheets in your workbook at once. 

You can: 

▪ Use "Find & Replace" in sheet names 

▪ Insert text before sheet names 
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▪ Insert text after sheet names 

▪ Automatically generate sheet names from the values in selected cells. 

 

 

Note: 

This “Quickly rename multiple sheets at once...” tool is not available in the 32-bits edition 

of ASAP Utilities for Excel 2000-2007. This tool requires the universal 32+64-bits edition for 

Excel 2010 and later. 
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5 Change name of selected sheets to selected cell's value 

With this utility you can rename the selected worksheets based on the value in a certain 

cell. 

You can rename all selected worksheets by giving them as a name the value of for example 

cell A1 on each worksheet. 

 

 

  



ASAP Utilities User Guide FREQUENTLY UPDATED 

 

68 Chapter 5 

 

 

6 Insert sheet(s) name in selected cell(s) 

This utility inserts the name of the worksheet into your selected range in each of your 

selected worksheets. 

You can for example use this to insert the sheet name into cell A1 on every selected 

worksheet. 

 

 

  



FREQUENTLY UPDATED ASAP Utilities User Guide 

 

Available tools     69 

 
 

7 Sort all sheets... 

With this utility you can sort the sheets in your workbook. 

You can sort the sheets alphanumeric (text), numerically (numbers) or by their tab-color. 

You can also specify to sort the sheets ascending or descending. 

 

To be able to sort by the tab-colors you need at least Excel 2002/XP. 

 

 

Example screenshot: Sort sheets by their value or color 

 

8 Create an index page with links to all sheets (clickable)... 

This utility will create a clickable index page; a new worksheet with a hyperlink to all 

worksheets and chart sheets in your workbook. 

You can see this as a menu for your workbook with the names of- and a link to all sheets 

and a quick navigation back to the main menu (index worksheet). 

This can be useful when you are dealing with large files with a large quantity of worksheets 

and/or chart sheets. 

 

To quickly return to the index sheet ASAP Utilities has added a new name to your workbook 

that refers to cell A1 on the index sheet. This name is "___INDEX_SHEET___ASAP_Utilities". 

To quickly return to the index sheet select this name in the name box in the formula bar. 

 

Remark: 

In Excel it is not possible to create a hyperlink to a chart sheet. To be able to link to a chart 

sheet ASAP Utilities uses a macro for this. This has a side effect if you workbook contains 

chart sheets and you use this tool and then the file is used by someone that does not have 

ASAP Utilities. When they then click on a link to a chart sheet they will receive an error that 

the macro cannot be found. 
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9 Split the selected range into multiple worksheets... 

With this tool you can quickly split your selected data into multiple sheets. 

You can do this either by value/group in a column or you can specify the number of rows to 

create per sheet. 

 

Examples: 

Create a new sheet for each company in your table. 

 

Note: 

Your initial data remains unaltered. 

If you want to save the new created worksheets as separate files, then you can do this with 

the utility "Export » Export worksheets as separate files...". 

We have also received the request for this tool from people that used workbooks with over 

500 000 rows (Excel 2007+) and then needed to create a file that could be opened in Excel 

2003. In order to do that they had to split the information into pieces of a max of 65536 

rows per worksheet because that is the maximum amount of rows that a sheet in Excel 
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2003 can contain. With this tool you can quickly have ASAP Utilities do that for you. 

 

 

10 Export worksheets as separate files... 

With this utility you can save all or the selected worksheets in your workbook as separate 

files. 

You can choose a folder in which you want the worksheets to be saved. 

 

The worksheets can be saved in the following file formats: 

▪ Excel Workbook (*.xlsx) (only available if you have Excel 2007 or later) 

▪ Excel Binary Workbook (*.xlsb) (only available if you have Excel 2007 or later) 

▪ Excel 97-2003 Workbook (*.xls) 

▪ CSV (Comma delimited) (*.csv) 

▪ Text (Delimited by semicolon ';') (*.txt) 

▪ Text (Tab delimited) (*.tsv) 

▪ Formatted Text (Space delimited) (*.prn) 
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▪ Text (Pipe (|) delimited) (*.txt) 

▪ Text (Delimited by tilde '~') (*.txt) 

▪ DBF 4 (dBASE IV) (*.dbf) (only with Excel 2000, 2002/XP and 2003) 

▪ DBF 3 (dBASE III) (*.dbf) (only with Excel 2000, 2002/XP and 2003) 

▪ Web Page (*.htm, *.html) 

▪ Single File Web Page (*.mht, *.mhtml) (only with Excel 2002/XP, 2003, 2007 and 2010) 

▪ PDF (*.pdf) (only with Excel 2010 or later or Excel 2007 SP2 or SP1 with the MS 

PDF plugin installed) 

When exporting text files in Unicode format, you can choose between the standard UTF-16 

character coding from Excel, or the commonly used UTF-8 character coding. 

 

Your last used settings will be remembered. 

 

Remark: 

In Excel 2007 and later the export to dBASE will not work; Microsoft has removed the 

option to save files in dBASE format from this Excel version and ASAP Utilities needs this 

built-in facility from Excel. 

 

Example screenshot: 1 
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Example screenshot: 2 

 
 

Example screenshot: 3 

 

11 Remove all empty worksheets 

This utility removes all empty worksheets in your workbook that do not contain any data 

and formatting or objects. 

You can use this to clean up your workbook, for example before a colleague or client has to 

work with it. This way the focus is only on the worksheets that are in use.  
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12 Unhide all sheets 

This utility will unhide all sheets. 

Normally in Excel you can only unhide one hidden sheet at a time. Now you can quickly 

make them all visible in one step.  

13 Hide selected sheets 

This utility will hide the selected sheets. 

 

You can already do this in Excel but the advantage of this tool ASAP Utilities is that you can 

now assign your own shortcut to it.  

14 Hide selected sheets extra (xlVeryHidden) 

This utility will hide the selected sheets with the so called "xlVeryHidden" feature. 

This way the sheet cannot be made visible the normal way in Excel (Format > Sheets > 

Unhide). You can only unhide the sheet by using a macro (VBA-code), or by using a tool 

such as "Unhide all sheets" in ASAP Utilities.  

15 Protect multiple sheets at once... 

This utility allows you to protect the selected or all sheets in your workbook with the same 

password at once.  

 

The built in method of Excel allows you to only protect one sheet at a time. If you want to 

protect multiple sheets in Excel you have to protect them one by one. This can take a long 

time if you have many sheets and might result in accidentally forgetting one. 

With this tool protecting your sheets is much easier and furthermore a lot faster. 

 

Depending on your Excel version you can set additional settings, just like in the normal 

Excel protection dialog. 
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Example screenshot: Protect multiple sheets at once 

 

16 Unprotect multiple sheets at once... 

This utility allows you to unprotect the selected or all sheets in your workbook with the 

same password at once.  

 

The built in method of Excel allows you to only unprotect one sheet at a time. If you want 

to remove the protection from multiple sheets you have to unprotect them one by one. 

This can take a long time if you have many sheets. 

With this tool unprotecting your sheets is much easier and furthermore a lot faster. 

 

 

Example screenshot: Unprotect multiple sheets at once 
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17 Print multiple sheets at once... 

Quickly print multiple worksheets or chart sheets at once. 

You can choose which sheets to print or quickly select all. If you specify to create a single 

print job, the page numbering will be continuous; if not the page numbering will start with 

1 on each of the selected sheets. 

 

Example screenshot: Print multiple sheets at once 

 

18 Copy a sheet's page and print settings... 

With this tool you can easily copy the page and print settings from a worksheet to other 

worksheets. 

 

You can copy the following properties: 

▪ Rows to repeat at top 

▪ Columns to repeat at left 

▪ Print area 

▪ Header left 

▪ Header right 

▪ Footer left 

▪ Footer center 

▪ Footer right 

▪ Margin left 

▪ Right margin 

▪ Center header 

▪ Top margin 

▪ Bottom margin 

▪ Header margin 

▪ Footer margin 

▪ Row and column headings 

▪ Gridlines 

▪ Printing quality 

▪ Center on page horizontally 

▪ Orientation 

▪ Draft quality 

▪ Paper size 

▪ Print comments 

▪ First page number 

▪ Print in black and white 

▪ Order 

▪ Zoom/scaling 

▪ Center on page vertically 

▪ Scale to fit page 



 

 

 

Remark: 

The speed of this utility might vary, depending on the type of printer(driver) that is set as 

default when the tool is executed. 

Starting from Excel XP/2002 you can also insert a picture in the header or footer. 

Unfortunately this is something that cannot be copied to other worksheets by using a 

macro. So if you have a picture in the header or footer it will not be copied with this tool in 

ASAP Utilities. From the Microsoft website: "The only way to work with pictures in headers 

or footers for multiple worksheets is to select all the worksheets, and then insert a graphic 

by using the Insert Picture dialog box (click the Insert Picture button), or format the graphic 

by using the Format Picture dialog box (click the Format Picture button). The original 

graphic file is needed for this procedure." 
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19 Set print area on selected worksheets 

This utility sets the currently selected range as the print area on all selected worksheets. 

In Excel you can only set the print area on one sheet at a time. With this utility you can now 

easily set the same print area in multiple sheets at once. 
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20 Clear the print area on selected sheets 

This utility removes the print area on the selected sheets. 

In Excel you can only clear the print area on one sheet at a time. With this utility you can 

now easily clear the print area on multiple sheets at once. 

 

 

21 Remove all page breaks on the selected worksheets 

This utility removes all manually set pages breaks from your selected worksheets. 

In Excel you can only remove all page breaks one sheet at a time by first selecting all cells 

and then choosing "Reset All Page Breaks" in the "Insert" menu. 

With this utility you can now easily remove the page breaks on multiple sheets at once and 

you don't need to select all cells upfront. 
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22 Freeze panes on multiple sheets at once 

This utility freezes the panes in all or all selected worksheets, based on your selected range. 

If you have selected only one sheet the utility works on all worksheets in your workbook. If 

you have selected multiple sheets, it will work on those selected sheets. 

 

Freezing panes allows you to select data that remains visible when scrolling in a sheet. For 

example, keeping row and column labels visible as you scroll. 

 

To freeze the panes, first do one of the following and then start this tool: 

▪ top horizontal pane: select the row below where you want the split to appear. 

▪ left vertical pane: select the column to the right where you want the split to appear. 

▪ both the upper and left panes: click the cell below and to the right of where you want the 

split to appear. 

In Excel you can only freeze the panes on one sheet at a time. With this utility you can now 

quickly do this on multiple sheets at once. 
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23 Unfreeze panes on multiple sheets at once 

This utility unfreezes the panes on all or all selected worksheets at once. 

If you have selected only one sheet the utility works on all worksheets in your workbook. If 

you have selected multiple sheets, it will work on those selected sheets. 

 

In Excel you can only unfreeze the panes on one sheet at a time. With this utility you can 

now quickly remove this on multiple sheets at once. 

 

 

24 Put together rows or columns from several sheets... 

This utility will copy the specified columns or rows from each selected sheet, and combines 

them into a new sheet. 

You can for example put the data from F of each selected worksheet side by side on a new 

worksheet. 

 

Usage: 

1. Select the desired worksheets from which you want to combine the data. 

2. Start this utility and then select the column(s) or row(s) you wish to put together. 

 

If you choose the option "Create dynamic links (cell references)", the new worksheet will 

contain formulas with a cell reference to the original data. If you choose this option the 

display of zero values on the new worksheet will be turned off. The display of zero values is 

an Excel worksheet setting which you can also control with the "Vision Control" utility in 

ASAP Utilities. 
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Example screenshot: Put together rows or columns from several sheets 

 

25 Remove all unused styles on every sheet 

This utility removes all unused styles from every worksheet in your workbook. 

In most of the times this fixes the problems when you get the message "Too Many Different 

Cell Formats" in Excel. 

 

What this message means is explained by Microsoft: 

You receive a "Too many different cell formats" error message in Excel. 

This problem occurs when the workbook contains more than approximately 4000 different 

combinations of cell formats. A combination is defined as a unique set of formatting 

elements that are applied to a cell. A combination includes all font formatting (for example: 

typeface, font size, italic, bold, and underline), borders (for example: location, weight, and 

color), cell patterns, number formatting, alignment, and cell protection. 

Source: https://support.microsoft.com/kb/q213904/  

26 Delete unused empty ending rows/columns 

This utility will remove all empty unused rows and columns at the right and bottom of your 

data range. 

It is useful when the "Reset Excel's last cell" tool from ASAP Utilities can't reset the last cell. 

 

You can use this utility when the end of your worksheet is (far) below or to the right of the 

actual range that is in use. You can test if this is true by pressing Ctrl+End and Excel takes 

you to a blank cell below or to the right of the actual data. 

 

Microsoft describes this problem in article 244435 as: "Microsoft Excel saves only the part 

of each worksheet that is in use, meaning the section that contains data or formatting. 

Sometimes the last cell of a worksheet may be beyond the range of your actual used data. 

This issue may cause you to have a larger file size than necessary, you may print extra 

pages, you may receive "Out of Memory" error messages, or you may experience other 

unusual behavior. Clearing the excess rows and columns to reset the last cell can help to 

resolve these issues. 

You can locate the last cell of the active worksheet by pressing CTRL+END.". 

 

https://support.microsoft.com/kb/q213904/
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Example screenshot: 1 Before 

 
 

Example screenshot: 2 After 

 



ASAP Utilities User Guide FREQUENTLY UPDATED 

 

84 Chapter 5 

 

 

27 Reset Excel's last cell 

This utility causes Excel to recognize the last used cell in your worksheet correct again. 

You can use this utility when the end of your worksheet is (far) below or to the right of the 

actual range that is in use. You can test if this is true by pressing Ctrl+End and Excel takes 

you to a blank cell below or to the right of the actual data. 

 

Two indications that Excel doesn't recognize the last cell correctly are: 

1. The end of your worksheet is (far) below or to the right of the actual range that is in use. 

2. The scrollbars are very small but you don't have that much data. 

 

Microsoft describes this problem in article 244435 as: "Microsoft Excel saves only the part 

of each worksheet that is in use, meaning the section that contains data or formatting. 

Sometimes the last cell of a worksheet may be beyond the range of your actual used data. 

This issue may cause you to have a larger file size than necessary, you may print extra 

pages, you may receive "Out of Memory" error messages, or you may experience other 

unusual behavior. Clearing the excess rows and columns to reset the last cell can help to 

resolve these issues. 

You can locate the last cell of the active worksheet by pressing CTRL+END". 

 

By default this utility can be used with the shortcut Ctrl+Alt+R. 
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5.4.5 Range 

1 Find and/or replace in all sheets... 

With this utility you can find and/or replace in all worksheets at once. 

This makes it easier to find information across you entire workbook. 

The results will be displayed in a list and you can quickly activate a cell from this list. You 

can replace the results one by one or replace them all at once. 

 

One of the advantages in comparison to Excel's default search and replace capabilities is 

that this utility makes is easier to deal with the special characters line feed (Alt+Enter), 

carriage return and tab. 

You can use the following codes to search for these special characters or use them as 

replacement: {lf} = line feed (Alt+Enter/ascii code 10), {cr} = carriage return (ASCII code 13), 

{tab} = tab character. 

Another advantage is it doesn't have Excel's length limit. In Excel you can receive the error 

"Formula is too long". Excel finds what you are looking for but you cannot replace it. This 

error has nothing to do with formulas; you can also get it if your cells contain only text. In 

such a case you can use ASAP Utilities to replace the text, because this utility does not have 

that limitation. 

 

You can configure the following settings: 

▪ Find what: the information to search for. You can use the ? and * wildcard characters; 

use ~? and ~* to find the ? and * characters. 

▪ Replace with: the value to replace the search value with. 

▪ Find/replace in: 

- All worksheets 

- Current worksheet 

- Selected range 

▪ Search: by rows or by columns 

▪ Look in: formulas or values. 

▪ Match Case 

▪ Match entire cell contents 

 

By default you can start this utility with the shortcut Ctrl+Alt+H. 

Your last used settings will be remembered. 
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Example screenshot: 1 

 
 

Example screenshot: 2 

 

2 Advanced sorting... 

This tool extends the options to sort your data. 

You can sort on up to 5 columns at once. Furthermore you can sort on many more 

properties than just the cell values. 

 

With this tool you can sort by: 

▪ Value 

▪ Number format 

▪ Cell Color 

▪ Cell Color Indexnumber 

▪ Font Color 

▪ Font Color Indexnumber 

▪ Font Size 

▪ Font Name 

▪ Bold 

▪ Italic 

▪ Underline 

▪ Strikethrough 

▪ Text Length 

▪ Random order (shuffle) 

▪ Reverse order 

▪ Formula 

▪ Email address host (@...) 
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▪ Alphanumeric content based on the 

numeric portions 

▪ Value, ignore minus sign (-) in numbers 

▪ Year-Month-Day 

▪ Year-Day-Month 

▪ Month-Day-Year 

▪ Month-Year-Day 

▪ Day-Year-Month 

▪ Day-Month-Year 

▪ Day of the week (start on Sunday) 

▪ Day of the week (start on Monday) 
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3 Sort the data in random order 

This utility sorts your selected range in a random order from top to bottom. 

 

You can for example use this to randomly sort your list to pick 5 lottery winners. 

Another example is to make sure that the start of the competitors in a contest is in random 

order. 

 

 

Example screenshot: Sort in random order 

 

4 Sort values inside each cell in selection... 

This tool sorts the contents of each cell in your selection. 

You can choose if the cell contents are: 

▪ Separated by a space 

▪ Separated by a comma 

▪ Separated by a comma + space 

▪ Separated by a line break (Alt+Enter) 

▪ Or enter your own separator 

You can sort either ascending (A-Z) or descending (Z-A) 

 

Tip: You can also use this on a (temporary) extra column in preparation to identify duplicate 

cell values. 
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5 Flip selected cells 

This utility will flip the cells in your selection. 

The utility works on cells in one column or one row at a time. 

 

If you have for example selected four cells in one row (A1:D1) with the values 1, 2, C and D 

then this utility will reverse the values so that the values in the range A1:D1 become D, C, 2 

and 1. 
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6 Move screen (place selection in top-left of screen) 

This utility will scroll the displayed range in your worksheet so that your selected range is 

displayed at the top-left.  

7 Show selection in center of screen 

This utility will scroll the displayed range in your worksheet so that your selected range is 

displayed in the center. 

This can be useful to set the focus to certain cells and because you don't have to use the 

scrollbars to do it manually.  

8 Custom formula error message... 

This utility makes it easy to display a custom error message for formulas that produce an 

error. 

Instead of an error such as #N/A or #VALUE!, you can have your own (more logical) error 

message displayed when a formula results in an error. 

For example, if you have a VLOOKUP formula but no result is found then the formula will 

then display the value #N/A. You use can this utility to tell Excel what it should display when 

the formula results in an error, for example to display nothing (an empty result) when no 

result is found or a user friendly message such as "country not found". 

 

This utility wraps an =IF(ISERROR(old_formula),[value in case of error],old_formula) formula 

around the existing formulas. You can do this manually, but it is easier and faster with help 

of ASAP Utilities. 

 

This utility has two advantages compared to writing the =IF(ISERROR()) formula manually: 

1. It is easier and quicker because you don't have to type in the formula. 

2. You can also use this utility on a range of cells with different formulas. 
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Example screenshot: Hide or replace error values 

 

9 Paste special (with combinations)... 

This utility does a "Paste Special", where you can use a combination from the options. 

With the built in Excel "Paste Special" dialog you can only paste one item at a time. With 

this utility you can now for example past both values, comments and formatting in one 

step. 

 

Follow the following steps to use this: 

1. Copy your datarange (for example with Ctrl+C). 

2. Select the cell or range where you want to paste 

3. Start this utility to paste the information/properties. 

 

By default you can start this utility with the shortcut Ctrl+Alt+Y. 
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10 Paste values and formatting 

This utility pastes both the values and formatting in one single step. 

 

Follow the following steps to use this: 

1. Copy your datarange (for example with Ctrl+C). 

2. Select the cell or range where you want to paste 

3. Start this utility to paste both the values and formatting.  

11 Paste values only 

This will paste the copied data as values only. 

 

You can assign your own shortcut to this via the "Favorites & Shortcut keys" menu. This tool 

can speed things up when you use this often and save you a few strokes/mouse actions 

compared to the "Edit > Paste special > Values" via the menu in Excel when you assign a 

shortcut to it. 

 

 

12 Copy selection and paste into only the visible cells... 

This tool copies the visible cells in your current selection and then pastes these into only 

the visible cells in a given destination range. 

If there are hidden rows or columns in either the source or target range, then those will be 

skipped. The data will then be pasted into the first next visible row or column. 
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This tool can be useful when pasting data into a filtered list. 

 

 

13 Fill cells with their formatted value 

This utility replaces the contents in the selected cells with their formatted value. 

 

For example if you have a cell with the value "384216938" with the cell formatting "000 - 

000 00 00" then it will be displayed as "038 - 421 69 38". 

This utility will then fill the cell with the value "038 - 421 69 38". 

This can for example be useful when you use mailmerge in MS Word because that reads the 

value of the cell and ignores the cell formatting. 
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Example screenshot: Fill cells with their displayed value 

 

14 Copy formulas without changing their cell references... 

This utility copies all formulas without changing the cell references. 

 

Normally Excel adjusts the cell references if you copy your formulas to another location. 

You would then have to "fix" all cell references with a dollar sign (for example change A1 to 

$A$1) to keep the cell references the same. 

With this utility you can now easily copy your formulas to another location without Excel 

having the cell references changed and without the need of adjusting the cell referenced 

first. 

Besides the formulas this utility will also copy the formats, comments and validation.  

15 Move selected data (only values)... 

This utility moves the content of your selected range to another location. 

 

It is a bit similar to "cut" and "paste" but instead of the built in Excel method, it will only 

paste the values. 

Moreover it will not update any cell references. If you move your data Excel automatically 

adjusts the formula references to point to the new location. This utility prevents that. For 

example if you have a formula with a reference to range A1:B10 and you use this utility to 

move the contents of cell A1:B10 to another location, the formula will still use to A1:B10. 

If you your range contains cells with formulas then these will be replaced with their 

calculated value.  
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16 Copy multiple selected ranges... 

With this utility you can copy multiple selected ranges at once. 

 

If you have selected multiple (non-contiguous) ranges you cannot easily copy this in Excel. If 

you try to do this you get an error similar to "The command you chose cannot be 

performed with multiple selections. Select a single range and click the command again.". 

If you can copy it, because the ranges are all on the same columns or rows then Excel 

ignores the empty rows or columns in between. 

With this utility you can now easily copy these cells.  

17 Transpose data with formulas... 

This utility will transpose your data and preserves the cell references. 

Unlike the standard Excel methods which changes the cell references when the data shifts, 

this utility will not change the cell references in your formulas. 

 

Example screenshot: 1 Before 

 
 

Example screenshot: 2 The result, all cell references have been preserved 

 

18 Split the selected range into multiple worksheets... 

With this tool you can quickly split your selected data into multiple sheets. 

You can do this either by value/group in a column or you can specify the number of rows to 

create per sheet. 

 

Examples: 

Create a new sheet for each company in your table. 

 

Note: 

Your initial data remains unaltered. 

If you want to save the new created worksheets as separate files, then you can do this with 

the utility "Export » Export worksheets as separate files...". 

We have also received the request for this tool from people that used workbooks with over 

500 000 rows (Excel 2007+) and then needed to create a file that could be opened in Excel 

2003. In order to do that they had to split the information into pieces of a max of 65536 
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rows per worksheet because that is the maximum amount of rows that a sheet in Excel 

2003 can contain. With this tool you can quickly have ASAP Utilities do that for you. 

 

 

19 Clear duplicated values in selection (leave one original) 

This utility will remove all duplicated values within the selected cells and keep one original. 

The first cell containing a duplicated value will keep its value, all other cells with this same 

value will have their contents cleared. 

This way only one of each value will remain. 

 

You can specify if you want this utility to be case sensitive. 

 

If your selection contains formulas then this utility compares the calculated values. This 

means that this utility considers a cell with the value 12 and a cell with the formula =3*4 as 

a duplicate. 
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Example screenshot: 1 

 
 

Example screenshot: 2 
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20 Count and/or color duplicates in selection... 

This utility tells you how many duplicate values there are in your selected range. 

You can choose to paint all duplicate cells with a certain color. 

 

Remark: 

The utility is case sensitive which means for example that "Excel" and "EXCEL" are not the 

same. 

If your selection contains formulas then this utility compares the calculated values. This 

means that this utility considers a cell with the value 12 and a cell with the formula =3*4 as 

a duplicate. 

 

Example screenshot: 1 Count and color duplicated values 

 
 

Example screenshot: 2 Just count the duplicates without coloring them 

 



FREQUENTLY UPDATED ASAP Utilities User Guide 

 

Available tools     99 

 
 

21 Count duplicates and give each set of duplicates its own color 

This tool counts and colors the duplicate values in your selection.  

Each set of duplicated values is given its own unique color. 

 

This helps to quickly find the duplicated values, by having a set of colors each of which can 

readily be distinguished from one another. 

 

Example: 

If your selection contains 5 cells with the value "London" then those 5 cells will all get the 

same color, for example blue. And if the value "Paris" exists in 3 cells then those 3 cells will 

also get the same, but a different color, such as green. 

 

Remark: 

The utility is case sensitive which means for example that "Excel" and "EXCEL" are not the 

same. 

If your selection contains formulas then this utility compares the calculated values. This 

means that this utility considers a cell with the value 12 and a cell with the formula =3*4 as 

a duplicate. 

 

 

22 Create a list of all range names in the workbook 

This utility creates a report with all named ranges in your workbook. 

 

A new workbook will be created which lists all the names ranges within your workbook and 

their cell references. 

Starting from Excel version 2007 this utility will also report the name comments.  
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23 Replace the range names used in formulas with their cell 

references (on selected sheets) 

This utility replaces the range names, used in formulas in the selected sheets, with their cell 

references. 

For example if you have a value in cell C10 with the range name 'quantity' and you used a 

formula such as '=A1*quantity', then this utility will replace that formula with '=A1*C10'. 

 

 

Example screenshot: 1 Select the sheets and start the utility and the range names will be 

replaced with their cell references 
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Example screenshot: 2 A report with the changes that were made 

 

24 Delete all range names in selection 

This utility removes all range names within your selected range. 

 

Remark: 

If the range name is used in a formula then the formula will result in an error when the 

range name is removed.  

25 Delete all range names in the entire workbook 

This utility removes all range names in your entire workbook. 

 

Remark: 

If the range name is used in a formula then the formula will result in an error when the 

range name is removed.  

26 Delete all range names with an invalid cell reference (#REF!) 

This tool removes all range names that have an invalid reference (#REF!). 

A report with the results will be presented to you.  
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5.4.6 Columns & Rows 

1 Conditional row and column select, hide or delete... 

This utility allows you to select, hide or remove rows or columns based on a certain 

condition. 

 

You can use the following criteria to select, hide of remove the entire rows or columns: 

▪ between 

▪ not between 

▪ equal to 

▪ not equal to 

▪ greater than 

▪ less than 

▪ greater than or equal to 

▪ less than or equal to 

▪ like (text, with use of wildcard 

characters) 

▪ not like (text, with use of wildcard 

characters) 

▪ duplicate values (you can choose to 

keep the first value) 

▪ unique values 

▪ odd rows 

▪ even rows 

▪ every n'th row number 

▪ odd columns 

▪ even columns 

▪ every n'th column number 

▪ empty cells 

▪ completely empty rows 

▪ completely empty columns 

 

With the criteria for text and duplicate or unique values you can choose if you want the 

utility to be case sensitive. 

When looking for duplicates the program also searches in hidden cells in your selection, 

with the other search options hidden cells are skipped. 

 

Some people use this utility as an alternative for or addition to Excel's AutoFilter. 

 

Example screenshot: 1 Conditional row and column select hide or delete 

 
 

Example screenshot: 2 Create a list of unique brand names 
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Example screenshot: 3 Each brand listed once 

 

2 Advanced sorting... 

This tool extends the options to sort your data. 

You can sort on up to 5 columns at once. Furthermore you can sort on many more 

properties than just the cell values. 

 

With this tool you can sort by: 

▪ Value 

▪ Number format 

▪ Cell Color 

▪ Cell Color Indexnumber 

▪ Font Color 

▪ Font Color Indexnumber 

▪ Font Size 

▪ Font Name 

▪ Bold 

▪ Italic 

▪ Underline 

▪ Strikethrough 

▪ Text Length 

▪ Random order (shuffle) 

▪ Reverse order 

▪ Formula 

▪ Email address host (@...) 

▪ Alphanumeric content based on the 

numeric portions 

▪ Value, ignore minus sign (-) in numbers 
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▪ Year-Month-Day 

▪ Year-Day-Month 

▪ Month-Day-Year 

▪ Month-Year-Day 

▪ Day-Year-Month 

▪ Day-Month-Year 

▪ Day of the week (start on Sunday) 

▪ Day of the week (start on Monday) 
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3 Color each n'th row or column in selection... 

Fill every n'th row or column in your selected range with a specified color. This method is 

also known as 'color-banding' and 'alternate shading'. 

This will improve the readability of tables with a lot of data. 

You can specify a color, rows or columns and the steps, for example to make every second 

row in your selection grey. 

 

There are two methods to color the rows or columns: 

▪ Standard coloring.  

This has the option to skip hidden rows/columns. 

▪ Conditional formatting (advanced).  

With this option the colors will be automatically updated when you insert or remove 

rows or columns. To remove the color, choose in the Excel menu 'Format' > 'Conditional 

Formatting' then remove the condition that sets the alternate colors (by default 

condition 1). If you use this option then the possibly existing conditional formatting will 

be removed. 

 

By default you can start this utility with the shortcut Ctrl+Alt+C. 

 

Example screenshot: Example alternate row coloring 

 

4 Detect and visualize adjacent data/group changes... 

With this utility you can easily make the differences visible between groups of cells with the 

same content. 

 

You can do the following when the value in a row changes: 

▪ insert an empty row 

▪ insert a page break 

▪ insert a border line below group. 

▪ alternating colors per group. 
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You can use this for example to identify different groups of data in your worksheet by 

inserting a blank row when the value changes or inserting a line in between. 

 

Your last used settings will be remembered. 

 

Remark: 

This utility only works on the rows (data) in a single column. 

 

Example screenshot: 1 Insert an empty row between groups 

 
 

Example screenshot: 2 Insert a pagebreak between groups 

 
 

 

  



FREQUENTLY UPDATED ASAP Utilities User Guide 

 

Available tools     107 

 
 

Example screenshot: 3 Insert a border line between groups 

 
 

Example screenshot: 4 Color banding per group 
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5 Merge column data (join cells)... 

This utility merges the data from the columns in your selection. 

For each row in your selection the data from the adjacent columns will be concatenated 

into the first cell in the row. 

 

You can specify the following: 

▪ Delimiter to put between the cell values 

▪ Skip empty cells 

▪ Use the value, formula or formatted value from the cells. 

You can use this utility as a quick alternative to Excel's =CONCATENATE() function. 

 

Example screenshot: Merge cell contents of selected columns into one cell 

 

6 Merge row data (selected cells)... 

This utility merges the data from the rows in your selection. 

For each column in your selection the data from the adjacent rows will be concatenated 

into the first cell in the column. 

You can specify a delimiter to put between the cell values. 

 

You can use this utility as a quick alternative to Excel's =CONCATENATE() function. 
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Example screenshot: Combine the data from the rows in your selection 

 

7 Merge row data, separate cells by a line break 

This utility merges the data from the rows in your selection and puts each cell value on a 

new line. 

For each column in your selection the data from the adjacent rows will be concatenated 

into the first cell in the column. 

 

You can use this utility as a quick alternative to Excel's =CONCATENATE() function. 

 

Example screenshot: Merge row data, separate cells by a line break 

 

8 Insert empty rows or columns in between... 

This utility inserts a given number of empty rows or columns between every row or column 

in your selection. 

 

You can specify the following: 

▪ Insert between the rows or columns in your selection. 

▪ The number of rows or columns to insert. 
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▪ To use the standard row height or columns width or specify an adjusted height or width. 

 

Example screenshot: Insert empty rows or columns in between 

 

9 Insert multiple empty rows at once... 

This utility inserts multiple rows at once. 

The utility inserts the specified number of rows above the active cell. 

 

Normally if you want to insert multiple rows at once the standard procedure is to first 

select multiple rows and then use the "Insert" command. 

For example if you want to insert 10 rows between A1 and A2, you first have to select rows 

2:11 and then insert the rows. 

With this utility you can now quickly insert multiple rows at once. 

 

 

Example screenshot: Insert multiple empty rows at once 

 

10 View and manage hidden rows and columns... 

Displays an overview of, and counts all hidden rows and columns within the used range on 

your worksheet. 

You can then easily pick the column and/or rows you want to unhide and make visible 

again. 
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11 Delete all hidden rows and/or columns... 

This utility removes all hidden rows and/or columns from in your current worksheet. 

 

This can be useful if you want to clean up the file before distributing it. 

 

Remark: 

If you have formulas with cell references to cells in the hidden rows or columns you first 

have to update your formulas or replace them with the calculated results. If you don't do 

this then the formulas give error values (#REF!) when the rows and columns are removed. 
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12 Delete all empty rows 

This utility removes all completely empty rows on your current worksheet. 

 

Remark: 

The utility removes all rows without data within the used range in your worksheet. 

It does not reduce the number of available rows in your worksheet. For every row that is 

removed Excel automatically adds a new empty row at the end. 

 

 

13 Delete all empty columns 

This utility removes all completely empty columns on your current worksheet. 

 

Remark: 

The utility removes all columns without data within the used range in your worksheet. 

It does not reduce the number of available columns in your worksheet. For every column 

that is removed Excel automatically adds a new empty column at the end.  
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14 Autofit row height (also on merged cells) 

This tool adjusts the row height in the selected cells so that you can read or print the entire 

content of the cells. 

 

Compared to Excel's built-in "AutoFit Row Height", this tool: 

▪ works on merged cells too. 

▪ ignores data in hidden columns for determining the row height. 

 

In addition to the standard functionality in Excel this tool also adjusts the height properly 

on merged cells (where 'wrap text' is set). In Excel itself the auto adjusting of the row height 

often doesn't work properly on merged cells. 

And unlike Excel itself, this tool adjusts the row height based on the visible cells in the row 

only. 

Any data in hidden columns in your selection is skipped.  Excel's built-in "AutoFit Row 

Height" does not exclude hidden columns so the row height is then also based on the 

values in hidden columns. 

 

Remark: 

If you change the contents afterwards, then you need to run this tool again to have the row 

height adjusted. 

(This it is not a tool that keeps working in the background and keeps adjusting the row 

height when the content is changed.) 
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15 Clean data and formatting... 

This utility helps you to optimize and clean information that you have copied into Excel. 

 

You can choose the following edits: 

▪ remove all hyperlinks 

▪ trim spaces (removes leading and 

trailing spaces) 

▪ remove all cell colors 

▪ remove all font colors 

▪ remove all borders 

▪ unmerge cells 

▪ apply standard font 

▪ apply standard font size 

▪ no wrap-text 

▪ fix (text)numbers 

▪ autofit columns 

▪ autofit rows 

▪ remove all objects/images from your 

worksheet 

 

Your last used settings will be remembered. 

 

 

16 Drawing paper... 

This tool allows you to specify the column width and row height of your cells in 

centimeters, inches or pixels. 

This is helpful if you use the Excel for drawing purposes, such as creating a flowchart or 

when you design your garden or need to create a floor plan. 

It can also be handy for quickly creating square cells. 

 

Remark: 

Due to limitations of how precise you can set the width and height in Excel the actual width 

and height might differ a tenth of a centimeter/inch. 

The dimensions in pixels depend on your Windows display DPI settings. 
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Example screenshot: 1 

 
 

Example screenshot: 2 
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17 Transpose column in multiple steps... 

Transposes data from one column to several columns in steps. 

Useful when you have to deal with a large amount of data in one column and have to 

transpose every X rows. 

 

Formulas and formatting will be preserved. 

 

Example screenshot: Transpose column in multiple steps 

 

18 The paper saver (split columns)... 

Split long columns in order to save paper while printing. 
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19 Put together rows or columns from several sheets... 

This utility will copy the specified columns or rows from each selected sheet, and combines 

them into a new sheet. 

You can for example put the data from F of each selected worksheet side by side on a new 

worksheet. 

 

Usage: 

1. Select the desired worksheets from which you want to combine the data. 

2. Start this utility and then select the column(s) or row(s) you wish to put together. 

 

If you choose the option "Create dynamic links (cell references)", the new worksheet will 

contain formulas with a cell reference to the original data. If you choose this option the 

display of zero values on the new worksheet will be turned off. The display of zero values is 

an Excel worksheet setting which you can also control with the "Vision Control" utility in 

ASAP Utilities. 

 

 

Example screenshot: Put together rows or columns from several sheets 

 

20 Delete unused empty ending rows/columns 

This utility will remove all empty unused rows and columns at the right and bottom of your 

data range. 

It is useful when the "Reset Excel's last cell" tool from ASAP Utilities can't reset the last cell. 

 

You can use this utility when the end of your worksheet is (far) below or to the right of the 

actual range that is in use. You can test if this is true by pressing Ctrl+End and Excel takes 

you to a blank cell below or to the right of the actual data. 

 

Microsoft describes this problem in article 244435 as: "Microsoft Excel saves only the part 

of each worksheet that is in use, meaning the section that contains data or formatting. 

Sometimes the last cell of a worksheet may be beyond the range of your actual used data. 

This issue may cause you to have a larger file size than necessary, you may print extra 

pages, you may receive "Out of Memory" error messages, or you may experience other 

unusual behavior. Clearing the excess rows and columns to reset the last cell can help to 
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resolve these issues. 

You can locate the last cell of the active worksheet by pressing CTRL+END.". 

 

Example screenshot: 1 Before 

 
 

Example screenshot: 2 After 
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21 Reset Excel's last cell 

This utility causes Excel to recognize the last used cell in your worksheet correct again. 

You can use this utility when the end of your worksheet is (far) below or to the right of the 

actual range that is in use. You can test if this is true by pressing Ctrl+End and Excel takes 

you to a blank cell below or to the right of the actual data. 

 

Two indications that Excel doesn't recognize the last cell correctly are: 

1. The end of your worksheet is (far) below or to the right of the actual range that is in use. 

2. The scrollbars are very small but you don't have that much data. 

 

Microsoft describes this problem in article 244435 as: "Microsoft Excel saves only the part 

of each worksheet that is in use, meaning the section that contains data or formatting. 

Sometimes the last cell of a worksheet may be beyond the range of your actual used data. 

This issue may cause you to have a larger file size than necessary, you may print extra 

pages, you may receive "Out of Memory" error messages, or you may experience other 

unusual behavior. Clearing the excess rows and columns to reset the last cell can help to 

resolve these issues. 

You can locate the last cell of the active worksheet by pressing CTRL+END". 

 

By default this utility can be used with the shortcut Ctrl+Alt+R. 
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5.4.7 Numbers & Dates 

1 Apply formula/calculation to selected cells... 

With this utility you can quickly perform a calculation on the selected range. 

For example quickly multiply all cells in your selection by 10 without having to add an extra 

column and enter a formula to do this. 

 

A formula will be built around the original formula or value in your cell. For example if you 

have a formula '=(12*2)' in a cell and you use ASAP Utilities to apply the formula /24 the 

result will be: '=(12*2)/24'. 

The formula will be applied to all cells in your selection except for cells with errors, empty 

cells, cells contain text or cells that contain an array formula. 

If the new formula would result in an error you will get a warning upfront and no changes 

will be applied. 

 

Users of the non-English Excel versions can type in the formula in their local language. For 

example in the Dutch version you can use the comma as decimal separator and the local 

version of worksheet formulas, for example '+SOM(G20:G40)' instead of the English 

'+SUM(G20:G40)'. 

There are many formulas you can enter such as for example '/1000', '+4', '*2,55', '*C33'. 

This utility is also often used for unit conversions, such as for example converting 

kilometers to meters. 

 

The last 100 used formulas are remembered so you can easily re-use them. 

By default this can be started with the shortcut Ctrl+Alt+I. 
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Example screenshot: 1 Perform a quick calculation in selected cells 

 
 

Example screenshot: 2 The result 
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2 Change formulas to their calculated values 

This utility replaces the formulas in the selected cells with their calculated values. 

 

The utility works the same as Excel's 'Copy » Paste special » Paste values' but in one step 

and it also works with multiple selections at once. 

Normally the utility changes the formulas to their calculated values in both visible and 

hidden cells. If you have selected cells in a filtered list only the visible cells are changed. 

 

As an example, a cell with the formula '=A2*(C19/12)' which has '124' as the calculated 

result will be replaced with the value 124. 

This can be useful, for example if you want to speed up the calculation of your workbook or 

if you don't want someone to see the underlying formulas you used if you give the 

workbook to somebody else. 

 

By default you can start this utility with the shortcut Ctrl+Alt+P. 

 

 

Example screenshot: 1 Change formulas to their calculated values 

 
 

Example screenshot: 2 Formulas to values in a filtered list is something that you normally 

can't do in Excel 
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3 Convert unrecognized numbers (text?) to numbers 

This utility changes the numbers that behave like text to real numerical numbers which 

Excel recognizes. 

 

You might have experienced that sometimes Excel treats numbers as text; they are left 

aligned, they don't work in your formulas or don't sort properly. 

This problem often occurs when data is imported or copied from other programs. 

This utility will also help you get errors in your =VLOOKUP() formulas because Excel treats 

the numbers as text and therefore can't find a matching value. 

You can also use this utility to remove leading zeros from numbers or to make Excel 

recognize empty cells properly as empty again. 

 

Remark: 

This utility does not convert numbers with decimal separators different then specified in 

the language settings in MS Windows or in the "International" options of your workbook. 

For example often people in The Netherlands have problems with imported text files when 

the numbers are stored as for example "120.00" where a point is used as decimal separator 

instead of a comma. 

In such a case you can use Excel to replace (Ctrl+H) the point (or whatever) to your decimal 

separator to have Excel recognize the numbers correctly. 
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4 Change values to text values (adding ' in front) 

This utility changes all numbers in the selected cells to text values. 

This is done by placing an apostrophe (') in front of each value. 

Cells with formulas that have a numeric result will be filled with their calculated values. 

Cells with text or a date are skipped. 

 

Remark: 

If you want to spell out numbers you can use the utility "Spell numbers or amounts (EN, DE, 

NL)".  

5 Fill cells with their formatted value 

This utility replaces the contents in the selected cells with their formatted value. 

 

For example if you have a cell with the value "384216938" with the cell formatting "000 - 

000 00 00" then it will be displayed as "038 - 421 69 38". 

This utility will then fill the cell with the value "038 - 421 69 38". 

This can for example be useful when you use mailmerge in MS Word because that reads the 

value of the cell and ignores the cell formatting. 

 

 

Example screenshot: Fill cells with their displayed value 
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6 Change negative numbers to positive and vice versa... 

With this utility you can change positive numbers to negative and negative numbers to 

positive. 

You can also make all numbers in your selection negative or positive. 

 

You can choose from: 

▪ Reverse positive and negative 

▪ Make all numbers positive 

▪ Make all numbers negative 

This can also be useful if you have a balance sheet with debit and credit figures. 

 

Remark: 

Cells with formulas will be skipped. 

 

Example screenshot: Change negative numbers to positive and vice versa 
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7 Move minus sign from back to front (e.g. 65- to -65) 

This utility will corrects numbers that have a trailing minus for negative numbers. 

For example a number such as "65-" will be converted into "-65" so that it is a number that 

Excel recognizes and that you can use in your calculations. 

 

This utility is especially useful when you have to deal with certain imported text files 

because some (finance) system report negative numbers with the minus sign at the end. 

 

 

8 Use a significant number of decimals... 

This utility changes the number format in your cells to show a significant number of 

decimals. 

The difference between this utility and general rounding is that it ignores the zeros that 

come directly after the decimal separator. 

 

For example if you enter the number 3, then the cells will be formatted to show at least 3 

decimals, other than zero. 

A cell with the value "12.0123123" is then shown as "12.0123" instead of "12.012". 

A cell with the value "12.00002134" is then shown as "12.0000213" instead of "12.000". 

9 Subscript the numbers in Chemical Formulas 

This will subscript the numbers in chemical notations such as C8H10N4O2, Al(OH)3, AlF6Li3, 

AlO2, Al(NO3)3, Au2(SeO4)3, Ca(VO4)2, H6TeO6, KAlMg3Si3O12H2, Ca(NO3)2 · 4H2O, etc. 
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It turns it into C8H10N4O2, Al(OH)3, AlF6Li3, AlO2, Al(NO3)3, Au2(SeO4)3, Ca(VO4)2, H6TeO6, 

KAlMg3Si3O12H2, Ca(NO3)2 · 4H2O, etc. 

This tool automatically detects which numbers should be formatted as subscript. 

 

10 Convert percentages to numbers (e.g. 5% to 5) 

This utility changes percentages to numbers by removing the percent sign (%). 

For example 5% will be converted to 5.  

11 Spell/write out numbers or amounts (EN, DE, FR, NL)... 

This utility spells out the numbers in your selection. 

For example the number "12.75" written out in English in the currency dollar becomes 

Twelve Dollars and Seventy Five Cents. 

This utility replaces the numbers in your selection with the written numbers. 

 

You can choose to write out the numbers as numbers or as an amount (for example to use 

on a check). 

You can choose between the languages English, German, French and Dutch. 

The default currencies are none, dollars or euro. You can also type in another currency. 

If a number contains more than two decimals this function will spell out the number as if it 

were rounded to two decimals. 
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12 Round numbers (not formatting, but changing)... 

This utility replaces the numbers in the selected cells with the rounded values. 

Instead of rounding the number by using cell formatting this tool will actually change the 

value in the cells. 

 

The utility will ask you to give a number to specify how to round, similar to Excel's 

=ROUND() function: 

▪ positive number: rounds a number to a specified number of digits. 

▪ zero: rounds the value to the nearest integer. 

▪ negative number: the number is rounded to the left of the decimal point for example to 

tens, hundreds, thousands etc. 

For example a cell with the value 105.326 rounded to 1 will be changed to 105.3, rounded 

to 0 it will become 105 and rounded to -1 it will become 110. 

 

Example screenshot: A Round the selected numbers to 2 decimals 
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Example screenshot: B Round the selected numbers to the nearest integer (zero decimal 

places) 

 
 

Example screenshot: C Round the selected numbers to the nearest multiple of 100 
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13 Fill up with leading zeros... 

This utility fills the numbers in the selected cells up with leading zeros to a given length. 

The utility will actually add the zeros and therefore change the data. If you only need the 

number to be displayed as if they have leading zeros then it is better to use cell formatting 

with a number format such as for example '000000'. 

Numbers with decimals will be rounded to the nearest integer. 

 

For example if you specify a length of 3 then a cell with the value 1 becomes 001, 34 

becomes 034 and numbers greater than 100 will not be changed because they already have 

a length of 3 characters or more 

If a formula in your selection has a number as a result then the calculated value will be 

filled it up with the zeros and the original formula is replaced. 
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14 Quick numbering of selected cells... 

This utility helps you to quickly fill the selected cells with a series or numbered list. 

The utility is flexible and offers several options to choose from. 

 

You can configure the following settings: 

Series setting: 

▪ Create a series with numbers: 

- The number to start with. 

- The number to increment with. 

- Restart counting after a certain value. 

- Fill up the numbers with leading zeros to a specified length. 

▪ Create a series based on the letters from alphabet in lowercase (a, b, c, etc.). 

▪ Create a series based on the letters from alphabet in uppercase (A, B, C, etc.). 

Options: 

▪ You can specify to restart the counting if the value in a certain column changes. You can 

use this for example if you have a list with city names and you want to restart the 

counting when the name of the city changes. You can also specify to put the value of the 

changing column in front of and/or after the value in the series. 

▪ You can add a value in front of and/or after each value in the series. This way you can for 

example create series with week numbers and add the text 'Week ' in front of each value 

in the series. 

▪ You can specify the cell alignment. 

 

By default you can start this utility with the shortcut Ctrl+Alt+Q. 

 

Example screenshot: 1 Example 1 
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Example screenshot: 2 Example 2 

 
 

Example screenshot: 3 Example 3 
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Example screenshot: 4 Example 4 

 
 

Example screenshot: 5 Example 5 
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Example screenshot: 6 Example 6 

 
 

Example screenshot: 7 Example 7 
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Example screenshot: 8 Example 8 

 
 

Example screenshot: 9 Example 9 
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15 Random numbering of cells (without duplicates) 

This utility fills the selected cells with unique random integers. 

 

This can be useful if you want to quickly create a list of random numbers without 

duplicates. 

The lowest created number in the list is 1 and the largest number is the number of cells in 

your selection. 

 

 

16 Convert/recognize dates... 

This utility helps you to convert the not recognized dates in the selected cells. 

Sometimes Excel treats dates as text. This problem often occurs when data is imported or 

copied from other programs. The problem is often caused by a difference between the date 

formats in your data and the local settings on your computer. 
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When Excel doesn't recognize these dates are left aligned, the cell formatting to display the 

dates doesn't work and you can't use them in your calculations. 

 

With this utility you can quickly convert them so that Excel recognizes them as proper 

dates. 

The text-date values all have to be constructed in a similar logical way in order for this 

utility to convert them. 

 

Your last used settings will be remembered. 

 

 

17 Change Julian dates to normal dates 

This tool will convert Julian dates to normal dates. 

 

A Julian date is sometimes used in the computer industry to refer to a date format that is a 

combination of the current year and the number of days since the beginning of the year. 

For example, January 1, 2011 is represented as 2011001 and December 31, 2011 is 

represented as 2011365. Note that this format is not based on the Julian calendar. 

 

Besides the yyddd and yyyyddd the JD Edwards (AS/400) cyyddd format is also supported 

by this tool. Their system adds a 0 or 1 in front of the year representing the century (0 = 

1900, 1 = 2000, Jan 15, 1910 is 010015, Jan 15, 2010 is 110015). 
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5.4.8 Text 

1 Insert before and/or after each cell in your selection... 

This utility adds a value in front of and/or at the end of the content of each cell in your 

selection. 

The utility will show you an example of the resulting values. 

 

You can specify the following: 

▪ The value to insert before at the front of each cell 

▪ The value to add at the end of each cell 

▪ Use the value, formula or displayed (formatted) value from the cells. 

▪ Include hidden cells 

▪ Skip empty cells 

 

The 'reset' button clears the insert before and after values and resets the options to their 

default values. This can be useful because this tool always remembers your previous 

settings. 

You can also use this utility to build a formula around the current values. 

 

Example screenshot: 1 
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Example screenshot: 2 

 

2 Change to UPPERcase 

This utility makes all text in your selected cells uppercase. 

For example 'this is a test' becomes 'THIS IS A TEST'. 

 

This can be useful with for example city names, article codes and postal codes. 
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3 Change to lowercase 

Make all text in your selected cells lowercase. 

For example 'This Is A Test' becomes 'this is a test' . 

 

 

4 Start first word with Uppercase 

This utility changes the first character in each of the selected cells to a capital. 

The rest of the characters will be unaffected. 

For example 'this is a test' is changed to 'This is a test'. 
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5 Make first character Uppercase, the rest lowercase 

This utility changes the first character in each of the selected cells to a capital. The 

remaining characters will be converted to lowercase. 

For example both the text 'THIS IS A TEST' and the text 'this is a test' is changed to 'This is a 

test'. 

 

 

6 Start Each Word With Uppercase 

This utility will start each word in the selected cells with a capital. 

All other characters will be converted to lowercase. 

For example the text 'new york' is changed to 'New York'. 

 

You can use this as a quick alternative for Excel's =PROPER() function. There is however a 

difference. This utility only converts the first letter of every word (the first word and 

everything after a space) to uppercase. But Excel's =PROPER() also capitalizes all letters in 

the text that follow any character other than a letter. 

 

This utility can be useful with for example city names. 
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7 Change Case (with options)... 

This tool changes the text in the selected cells to uppercase, lowercase or other common 

capitalizations. 

 

You can change the text in selected cells to: 

▪ lowercase 

▪ UPPERCASE 

▪ tOGGLE cASE 

▪ Sentence case (first letter of each sentence in uppercase) 

▪ Glossary case (first letter of each sentence in lowercase) 

▪ Capitalize Each Word (Optionally make the first letter of each word uppercase, and the 

rest of the word lower case. And if required you can specify the characters (in addition to 

a space) that indicate that a new word starts.) 

 

Options: 

▪ Choose to preserve all capitalized text (useful in converting glossaries with 

abbreviations). 

▪ Set words to preserve/exclude. 
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8 Spell/write out numbers or amounts (EN, DE, NL)... 

This utility spells out the numbers in your selection. 

For example the number "12.75" written out in English in the currency dollar becomes 

Twelve Dollars and Seventy Five Cents. 

This utility replaces the numbers in your selection with the written numbers. 

 

You can choose to write out the numbers as numbers or as an amount (for example to use 

on a check). 

You can choose between the languages English, German and Dutch. 

The default currencies are none, dollars or euro. You can also type in another currency. 

If a number contains more than two decimals this function will spell out the number as if it 

was rounded to two decimals. 
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9 Convert/recognize dates... 

This utility helps you to convert the not recognized dates in the selected cells. 

Sometimes Excel treats dates as text. This problem often occurs when data is imported or 

copied from other programs. The problem is often caused by a difference between the date 

formats in your data and the local settings on your computer. 

When Excel doesn't recognize these dates are left aligned, the cell formatting to display the 

dates doesn't work and you can't use them in your calculations. 

 

With this utility you can quickly convert them so that Excel recognizes them as proper 

dates. 

The text-date values all have to be constructed in a similar logical way in order for this 

utility to convert them. 

 

Your last used settings will be remembered. 
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10 Delete leading and trailing spaces 

This utility removes all spaces from the beginning and end of the values in your selected 

cells. 

 

For example if you have a cell with the value "  Excel " then this utility changes the value to 

"Excel" without the spaces at the front and end. 

 

 

11 Delete leading, trailing and excessive spaces 

This utility removes all spaces except for single spaces between words in the selected cells. 

All the spaces at the beginning and end of each cell value will be removed and all repetitive 

spaces will be replaced by a single space. 

 

For example the value '  Lennox Street   141' will be replaced with 'Lennox Street 141'. 

This utility is a quick alternative for Excels =TRIM () function. 

 

Example screenshot: 1 Before 
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Example screenshot: 2 Strip the leading, trailing and duplicated spaces 

 
 
Example screenshot: 3 After 

 

12 Clean data and formatting... 

This utility helps you to optimize and clean information that you have copied into Excel. 

 

You can choose the following edits: 

▪ remove all hyperlinks 

▪ trim spaces (removes leading and 

trailing spaces) 

▪ remove all cell colors 

▪ remove all font colors 

▪ remove all borders 

▪ unmerge cells 

▪ apply standard font 

▪ apply standard font size 

▪ no wrap-text 

▪ fix (text)numbers 

▪ autofit columns 

▪ autofit rows 

▪ remove all objects/images from your 

worksheet 
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Your last used settings will be remembered. 

 

 

13 Advanced character remove or replace... 

This utility removes or replaces certain characters in your worksheet or selected cells. 

You can pick one or more characters from a list, including numbers, letters, special 

characters, symbols, tabs, new line characters (enters) and invisible spaces and characters. 

 

A few practical examples of this utility: 

▪ remove all line breaks such as carriage returns and linefeeds (Alt+Enter) from your data 

▪ remove invisible characters 

▪ extract numbers from text 

▪ remove everything except for certain characters 

Several buttons allow you to quickly select or deselect certain characters. 

 

Your last used settings will be remembered. 

 

Note: 

You can use the following codes to use these special characters as replacement: {lf} = line 

feed (Alt+Enter/ascii code 10), {cr} = carriage return (ASCII code 13), {tab} = tab character. 

If you have selected only one single cell then the utility will edit all the cells on your 

worksheet. 
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Example screenshot: Remove or replace certain characters in selected cells in Excel 

 
 

Example screenshot: Remove or replace certain characters 
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14 Replace accented characters (á, ë, ñ etc.)... 

This utility replaces all accented characters in the selected cells with the non-accented 

version. 

Bother lower- and uppercase accented characters will be replaced with the non-accented 

version in lower- or uppercase. 

The utility works on both vowels and consonants. 

 

For example the character é will be replaced with e, ñ replaced with n and Ä replaced with 

A. 

You can customize the characters and your last used settings will be remembered. 

By pressing the "Reset" button you can revert to the default settings for the accented and 

replacement characters. 

 

 

  



ASAP Utilities User Guide FREQUENTLY UPDATED 

 

152 Chapter 5 

 

 

15 Delete all text characters (a-z) in selected cells 

This utility will remove all letters from the values in the selected cells. 

 

All letters from the alphabet (abcdefghijklmnopqrstuvwxyz), both uppercase and lowercase 

will be removed from every cell in your selection. Cells with a formula will be skipped. 

If you have selected only one single cell then the utility will edit all the cells on your 

worksheet. 

 

For example a cell with the value '8011LB' will be replaced with '8011'. 

 

 

16 Delete all numbers in selection 

This utility will remove all numbers from the values in the selected cells. 

 

The numbers 1, 2, 3, 4, 5, 6, 7, 8, 9 and 0 will be removed from every cell in your selection. 

Cells with a formula will be skipped. 

If you have selected only one single cell then the utility will edit all the cells on your 

worksheet. 

 

For example a cell with the value '8011LB' will be replaced with LB'. 
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17 Remove ending carriage return (Alt+Enter) 

This utility removes the carriage returns (Alt+Enter character) that are at the end of in each 

cell in your selection. 

 

If you want to remove or replace all carriage returns/linefeeds, you can use the "Advanced 

character remove or replace..." utility. 
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18 Delete number of leading characters... 

This utility removes a given number of characters from the front of the selected  cells. 

 

The utility works on both cells with numbers and text. Cells with dates will be skipped. 

If a cell has a formula or an array formula then it will first be replaces with its calculated 

value and then the characters will be stripped. 

 

You can for example use it to quickly remove the first two characters from all the selected 

cells. 

 

Example screenshot: Delete leading characters 
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19 Delete number of ending characters... 

This utility removes a given number of characters from the end of the selected  cells. 

 

The utility works on both cells with numbers and text. Cells with dates will be skipped. 

If a cell has a formula or an array formula then it will first be replaces with its calculated 

value and then the characters will be stripped. 

 

You can for example use it to quickly remove the last four characters from all the selected 

cells. 

 

Example screenshot: Delete characters from the end 

 

20 Delete all after a given number of characters... 

This utility removes all characters that come after a given length in the selected cells. 

 

The utility works on both cells with numbers and text. Cells with dates will be skipped. 

If a cell has a formula or an array formula then it will first be replaces with its calculated 

value and then the characters will be stripped. 

 

You can for example use it to quickly remove everything after the first 10 characters in your 

datarange. 

You can use this as a quick alternative for Excel's =LEFT() function. 
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Example screenshot: Keep the first characters 

 

21 Subscript the numbers in Chemical Formulas 

This will subscript the numbers in chemical notations such as C8H10N4O2, Al(OH)3, AlF6Li3, 

AlO2, Al(NO3)3, Au2(SeO4)3, Ca(VO4)2, H6TeO6, KAlMg3Si3O12H2, Ca(NO3)2 · 4H2O, etc. 

It turns it into C8H10N4O2, Al(OH)3, AlF6Li3, AlO2, Al(NO3)3, Au2(SeO4)3, Ca(VO4)2, H6TeO6, 

KAlMg3Si3O12H2, Ca(NO3)2 · 4H2O, etc. 

This tool automatically detects which numbers should be formatted as subscript. 
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22 Make last character superscript 

This utility makes the last character superscript in your selected cells. 

 

For example a cell with the value 'm3' will be changed to 'm³'. 

 

23 Make last character subscript 

This utility makes the last character subscript in your selected cells. 

 

 

24 Reverse text in selected cells 

This utility reverses the text in the selected cells.  

For example ''Excel' becomes 'lecxE' and '123456' becomes '654321'. 
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25 Sort values inside each cell in selection... 

This tool sorts the contents of each cell in your selection. 

You can choose if the cell contents are: 

▪ Separated by a space 

▪ Separated by a comma 

▪ Separated by a comma + space 

▪ Separated by a line break (Alt+Enter) 

▪ Or enter your own separator 

You can sort either ascending (A-Z) or descending (Z-A) 

 

Tip: You can also use this on a (temporary) extra column in preparation to identify duplicate 

cell values. 
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5.4.9 Formulas 

1 Change formulas to their calculated values 

This utility replaces the formulas in the selected cells with their calculated values. 

 

The utility works the same as Excel's 'Copy » Paste special » Paste values' but in one step 

and it also works with multiple selections at once. 

Normally the utility changes the formulas to their calculated values in both visible and 

hidden cells. If you have selected cells in a filtered list only the visible cells are changed. 

 

As an example, a cell with the formula '=A2*(C19/12)' which has '124' as the calculated 

result will be replaced with the value 124. 

This can be useful, for example if you want to speed up the calculation of your workbook or 

if you don't want someone to see the underlying formulas you used if you give the 

workbook to somebody else. 

 

By default you can start this utility with the shortcut Ctrl+Alt+P. 

 

Example screenshot: 1 Change formulas to their calculated values 

 
 

Example screenshot: 2 Formulas to values in a filtered list is something that you normally 

can't do in Excel 
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2 Apply formula/calculation to selected cells... 

With this utility you can quickly perform a calculation on the selected range. 

For example quickly multiply all cells in your selection by 10 without having to add an extra 

column and enter a formula to do this. 

 

A formula will be built around the original formula or value in your cell. For example if you 

have a formula '=(12*2)' in a cell and you use ASAP Utilities to apply the formula /24 the 

result will be: '=(12*2)/24'. 

The formula will be applied to all cells in your selection except for cells with errors, empty 

cells, cells contain text or cells that contain an array formula. 

If the new formula would result in an error you will get a warning upfront and no changes 

will be applied. 

 

Users of the non-English Excel versions can type in the formula in their local language. For 

example in the Dutch version you can use the comma as decimal separator and the local 

version of worksheet formulas, for example '+SOM(G20:G40)' instead of the English 

'+SUM(G20:G40)'. 

There are many formulas you can enter such as for example '/1000', '+4', '*2,55', '*C33'. 

This utility is also often used for unit conversions, such as for example converting 

kilometers to meters. 

 

The last 100 used formulas are remembered so you can easily re-use them. 

By default this can be started with the shortcut Ctrl+Alt+I. 

 

Example screenshot: 1 Perform a quick calculation in selected cells 
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Example screenshot: 2 The result 

 

3 Custom formula error message... 

This utility makes it easy to display a custom error message for formulas that produce an 

error. 

Instead of an error such as #N/A or #VALUE!, you can have your own (more logical) error 

message displayed when a formula results in an error. 

For example, if you have a VLOOKUP formula but no result is found then the formula will 

then display the value #N/A. You use can this utility to tell Excel what it should display when 

the formula results in an error, for example to display nothing (an empty result) when no 

result is found or a user friendly message such as "country not found". 

 

This utility wraps an =IF(ISERROR(old_formula),[value in case of error],old_formula) formula 

around the existing formulas. You can do this manually, but it is easier and faster with help 

of ASAP Utilities. 

 

This utility has two advantages compared to writing the =IF(ISERROR()) formula manually: 

1. It is easier and quicker because you don't have to type in the formula. 

2. You can also use this utility on a range of cells with different formulas. 
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Example screenshot: Hide or replace error values 

 

4 Transpose data with formulas... 

This utility will transpose your data and preserves the cell references. 

Unlike the standard Excel methods which changes the cell references when the data shifts, 

this utility will not change the cell references in your formulas. 

 

Example screenshot: 1 Before 

 
 

Example screenshot: 2 The result, all cell references have been preserved 

 

5 Copy formulas without changing their cell references... 

This utility copies all formulas without changing the cell references. 

 

Normally Excel adjusts the cell references if you copy your formulas to another location. 

You would then have to "fix" all cell references with a dollar sign (for example change A1 to 

$A$1) to keep the cell references the same. 

With this utility you can now easily copy your formulas to another location without Excel 
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having the cell references changed and without the need of adjusting the cell referenced 

first. 

Besides the formulas this utility will also copy the formats, comments and validation.  

6 Change formula reference style (e.g. A1 to $A1 etc.)... 

This utility will change the formula reference style in the formulas you your selected cells. 

 

You can change the reference style to: 

▪ Relative referencing (A1) 

▪ Relative rows and absolute columns ($A1) 

▪ Absolute rows and relative columns (A$1) 

▪ Absolute referencing ($A$1) 

 

For example a cell with the formula '=A1*(B12/100)' changed to absolute referencing 

becomes '=$A$1*($B$12/100)'.  

 

The advantage of this utility is that you can quickly change the reference style in multiple 

formulas at once. 

 

 

7 Replace the range names used in formulas with their cell 

references (on selected sheets) 

This utility replaces the range names, used in formulas in the selected sheets, with their cell 

references. 

For example if you have a value in cell C10 with the range name 'quantity' and you used a 

formula such as '=A1*quantity', then this utility will replace that formula with '=A1*C10'. 
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Example screenshot: 1 Select the sheets and start the utility and the range names will be 

replaced with their cell references 

 
 

Example screenshot: 2 A report with the changes that were made 
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8 Rebuild array formulas 

This utility will re-enter all formulas in your selected cells as array formulas. 

 

When you enter an array formula you have to press Ctrl+Shift+Enter instead of just Enter to 

insert the formula. You must do this the first time you insert the array formula into your 

worksheet and whenever you edit it. If you do this correct then Excel will display the 

formula between curly braces {}. 

If you have forgotten to do this it can be a tedious task to select each cell, edit it and then 

press Ctrl+Shift+Enter to have it properly inserted as an array formula. 

This utility automates this process.  

9 Insert an apostrophe (') in front of each formula in the 

selected cells 

This tool inserts an apostrophe (') in front of each formula in the selected cells, which turns 

them to text. 

 

Note: 

To turn the changed formulas to actual calculating formulas again, you can use the 

following tool from ASAP Utilities: 

"Numbers & Dates » Change not recognized numbers (text?) to numbers" 
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10 Report the formulas used in the worksheets in your 

workbook 

This tool will report all formulas used in the worksheets on your workbook. 

 

The report shows the following information: 

▪ Sheet; The name of the worksheet the formula is on 

▪ Cell; The cell address the formula is in. You can click on the address to jump to it, it is a 

hyperlink. 

▪ Value; The calculated result 

▪ Displayed value; The displayed result. This uses the cell's number format. 

▪ Formula; The formula 

 

 

11 Insert "international" formula... 

With this utility you can insert a formula in "international" notation into the selected cells. 

An "international" formula is a formula that uses English worksheet formula names, a 

comma as list separator and a point as decimal separator. 

 

This utility can be very useful if you do not use an English version of Excel or if you use 

different country settings. 

On the Internet you can find an enormous quantity of example formulas for Excel. Most 

examples on the Internet and in Excel books use the "international" formula notation. 

With this utility you can now easily use such formulas, independent from your Excel version 

or country settings. ASAP Utilities converts them automatically to be used in your Excel 

version. 

For example if you use the Dutch version of Excel with the Dutch country settings in 

Windows, then this utility translates the "international" formula 

"=SUMIF(A2:A13,">50")*1.19" automatically to "=SOM.ALS(A2:A13;">50")*1,19" when you 

insert the formula. 

 

You can use this utility for both regular- and array formulas. 
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Example screenshot: Easily paste English formulas into your local Excel version 

 

12 Insert function from the ASAP Utilities library... 

With this utility you can insert a formula from the ASAP Utilities functions library into the 

active cell. 

 

The ASAP Utilities functions library includes the following functions: 

=ASAPCELLCOLORINDEX(cell) 

Returns the color index number of the cell. 

If you afterwards change the color in the cell, you have to press Ctrl+Alt+F9 to have the 

formula recalculated. 

This function does not recognize formatting if it is applied via conditional formatting. 

 

Parameters: 

▪ cell = The cell to get Excel's number for the fill color 

from. 

=ASAPCOUNTBYCELLCOLOR(reference, color_index_nr) 

Counts the number of cells in the given range that have a certain fill color. 

If you afterwards change the fill color in any of the referenced cells, you have to press 

Ctrl+Alt+F9 to have the formulas recalculated. 

This function does not recognize formatting if it is applied via conditional formatting. 
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Parameters: 

▪ reference = The range of cells to search in. 

▪ color_index_nr = The cell that has the fill color to count, 

or the color index number (1-56) from Excel. 

=ASAPCOUNTBYFONTCOLOR(reference, color_index_nr) 

Counts the number of cells in the given range that have a certain font color. 

If you afterwards change the font color in any of the referenced cells, you have to press 

Ctrl+Alt+F9 to have the formulas recalculated. 

This function does not recognize formatting if it is applied via conditional formatting. 

 

Parameters: 

▪ reference = The range of cells to search in. 

▪ color_index_nr = The cell that has the font color to count, 

or the color index number (1-56) from Excel. 

=ASAPCOUNTCHAR(within_text, find_text) 

Counts the number of times a character occurs in a text 

This way you can for example count the number of commas in a cell. This function is case 

sensitive. 

 

Parameters: 

▪ within_text = The text containing the character you want to 

count. 

▪ find_text = The character to count the occurrences of. This 

has to be a single character. 

=ASAPCOUNTSHADES(reference) 

Counts the number of colored cells in your range. 

If you afterwards change the fill color in any of the referenced cells, you have to press 

Ctrl+Alt+F9 to have the formulas recalculated. 

This function does not recognize formatting if it is applied via conditional formatting. 

 

Parameters: 

▪ reference = The range of cells to count the number of cells 

that have a fill color. 

=ASAPEXTRACTFILENAME(text, optional path_separator) 

Returns the file name from a full path and filename. By default the formula uses a backslash 

(\) as separator, but optionally you can specify another separator. 

For example =ASAPEXTRACTFILENAME("D:\Projects\Archive\Client 1\Balance.xls") returns 

"Balance.xls". 
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Parameters: 

▪ text = The value or cell address from which you want to 

extract only the file name. 

▪ path_separator = The path separator. Optional, if omitted a 

backslash (\) is used. 

=ASAPEXTRACTFOLDERNAME(text, optional path_separator) 

Returns the folder name from a combined filepath and filename. By default the formula 

uses a backslash (\) as separator, but optionally you can specify another separator. 

For example =ASAPEXTRACTFOLDERNAME("D:\Projects\Archive\Client 1\Balance.xls") 

returns "D:\Projects\Archive\Client 1". 

 

Parameters: 

▪ text = The value or cell address from which you want to 

extract only the folder name. 

▪ path_separator = The path separator. Optional, if omitted a 

backslash (\) is used. 

=ASAPEXTRACTNUMBERS(text) 

Returns the numbers from a text string. 

For example the formula =ASAPEXTRACTNUMBERS("8011 LB") returns 8011. 

 

Parameters: 

▪ text = The value or cell address from which you want to 

extract the numbers from. 

=ASAPFILENAME() 

Returns the name of your workbook. This is the name of the workbook without the filepath 

(folder). 

For example "Balance.xls". 

 

=ASAPFILEPATH() 

Returns the filepath (the folder) where your workbook is stored. 

For example: "D:\Projects\Archive\Client 1". 

 

=ASAPFILEPROPERTIES(property_name_or_id) 

Returns the value of one of the built-in document properties for the current workbook. 

You can refer to document properties either by index value or by their English name. 

The following list shows the available built-in index values and document property names: 

   1  Title 

   2  Subject 

   3  Author 

   4  Keywords 
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   5  Comments 

   6  Template 

   7  Last Author 

   8  Revision Number 

   9  Application Name 

  10  Last Print Date 

  11  Creation Date 

  12  Last Save Time 

  13  Total Editing Time * 

  14  Number of Pages * 

  15  Number of Words * 

  16  Number of Characters * 

  17  Security 

  18  Category 

  19  Format 

  20  Manager 

  21  Company 

  22  Number of Bytes * 

  23  Number of Lines * 

  24  Number of Paragraphs * 

  25  Number of Slides * 

  26  Number of Notes * 

  27  Number of Hidden Slides * 

  28  Number of Multimedia Clips * 

  29  Hyperlink Base 

  30  Number of Characters (with spaces) *

* Excel isn't required to define values for every built-in document property. 

If Microsoft Excel doesn't define a value for one of the built-in document properties, 

reading the Value property for that document property results in an error. 

You have to press Ctrl+Alt+F9 to have the formula recalculated. 

 

Example: 

=ASAPFILEPROPERTIES("Last Print Date")   

 

Parameters: 

▪ property_name_or_id = The id or English name of the built-in 

document property. 

=ASAPFONTCOLORINDEX(cell) 

Returns the color index number of the font of a cell. 

If you afterwards change the font color in the cell, you have to press Ctrl+Alt+F9 to have the 

formula recalculated. 

This function does not recognize formatting if it is applied via conditional formatting. 

 

Parameters: 

▪ cell = The cell to get Excel's number for the text color 

from. 

=ASAPFULLFILENAME() 

Returns the full filename of your workbook. This is the name of the workbook including the 

folder (filepath) where it is saved. 

For example "D:\Projects\Archive\Client 1\Balance.xls". 

=ASAPGETCOMMENT(cell) 

Returns the text from the comment a cell. 

If you afterwards change the comment in the cell, you have to press Ctrl+Alt+F9 to have the 

formula recalculated. 



FREQUENTLY UPDATED ASAP Utilities User Guide 

 

Available tools     171 

 
 

 

Parameters: 

▪ cell = The cell to get the text from the comment from. 

=ASAPGETDOMAIN(text, optional show_protocol = False) 

Returns the (sub)domain from a given hyperlink (website address/url). 

For example if cell A1 contains the value "https://www.asap-utilities.com/download-asap-

utilities.php" then these are the formula results: 

=ASAPGETDOMAIN(A1) returns "www.asap-utilities.com" 

=ASAPGETDOMAIN(A1;TRUE) returns "https://www.asap-utilities.com" 

 

Parameters: 

▪ text = The value or cell address from which you want to 

extract the domain. 

▪ show_protocol = Optional, logical value, if omitted the 

default is FALSE. If TRUE this function will also return the 

protocol of the link, which is the part before the domain 

such as http://, ftp:// etc.. 

=ASAPGETFONTNAME(cell) 

Returns the name of the font in a cell. 

If you afterwards change the font in the cell, you have to press Ctrl+Alt+F9 to have the 

formula recalculated. 

This function does not recognize formatting if it is applied via conditional formatting. 

 

Parameters: 

▪ cell = The cell to get the font from. 

=ASAPGETFONTSIZE(cell) 

Returns the font size of a cell. 

If you afterwards change the font size in the cell, you have to press Ctrl+Alt+F9 to have the 

formula recalculated. 

This function does not recognize formatting if it is applied via conditional formatting. 

 

Parameters: 

▪ cell = The cell to get the font size from. 

=ASAPGETFORMULA(cell) 

Returns the formula of a cell. 

 

Parameters: 

▪ cell = The cell to get the formula from. 
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=ASAPGETFORMULAINT(cell) 

Returns the formula of a cell in the "international" notation. 

The English names for the formulas will be used, the list separator is a comma and the 

decimal separator is a point. 

The largest resources on the Internet on Excel are in English. On these websites the 

"international" formulas and style are used. If you use a local version of Excel then you can 

now easily create an "international" example of the formula you used. 

 

Parameters: 

▪ cell = The cell to get the formula from. 

=ASAPGETHYPERLINK(cell, optional text_no_link) 

Returns the hyperlink from a cell. The hyperlink can be one of the following types: 

 - existing file or web page 

 - place in your document 

 - e-mail address 

If you afterwards change the hyperlink in the cell, you have to press Ctrl+Alt+F9 to have the 

formula recalculated. 

 

Parameters: 

▪ cell = The cell to read the hyperlink from. 

▪ text_no_link = Optional, this text will be displayed if the 

cell doesn't have a hyperlinks. If omitted, the formula will 

give an empty result for cells without hyperlinks. 

=ASAPGETNUMBERFORMAT(cell) 

Returns the number format of a cell. 

If you afterwards change the number format in the cell, you have to press Ctrl+Alt+F9 to 

have the formula recalculated. 

 

Parameters: 

▪ cell = The cell to get the number format from. 

=ASAPISBOLD(reference) 

Returns TRUE if the cell is bold or FALSE if it isn't. 

If you afterwards change the bold setting in the cell, you have to press Ctrl+Alt+F9 to have 

the formula recalculated. 

This function does not recognize formatting if it is applied via conditional formatting. 

=ASAPISFORMULA(cell) 

Returns TRUE if the cell has a formula or FALSE if it doesn't. 
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=ASAPLOADIMAGE(image_fullname, optional width_in_pixels, optional 

height_in_pixels) 

Inserts the specified image as an object and puts it at the left-top of your cell. 

 

To update the image, you can replace the formula with a new image name. 

To remove the image you have to remove both the formula and the image. (The image isn't 

removed if only the formula is removed.) 

You have to press Ctrl+Alt+F9 to have the formula recalculated. 

 

Example: 

=ASAPLOADIMAGE("D:\products\images\art782.gif") 

 

Parameters: 

▪ image_fullname = The full path and file name of an image of 

the type that Excel supports. 

▪ width_in_pixels = Optional. You can specify the width 

pixels. If omitted, the width will be proportionally based 

on the image's height. 

▪ height_in_pixels = Optional. You can specify the height in 

pixels. If omitted, the height will be the height of the 

cell the formula is in. 

=ASAPMERGECELLS(reference, optional delimiter = "", optional 

skip_empty_cells = True) 

Joins several text strings into one text string. 

An easy alternative for the Excel =CONCATENATE() function. The benefit of this 

ASAP Utilities function: 

 - You can specify a range to join, for example "A1:G1". 

 - The numberformat of the values will be used. For example, if a cell has the value 

"12.23072" and the number format is to display only one decimal then this function uses 

the value "12.2". 

 - You only have to specify a delimiter once. 

 - By default empty cells will be ignored. 

 

Parameters: 

▪ reference = A contiguous range of cells to join the values 

from. When reading the cell values, their number format will 

be used. 

▪ delimiter = Optional, a character to insert between the cell 

values. If omitted then no delimiter is used. 

▪ skip_empty_cells = Optional, is a logical value: to skip 

empty cells = TRUE or omitted; to include empty cells in the 

result = FALSE. 
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=ASAPRANDOMPASSWORD(optional length = 8, optional use_symbols = True) 

Returns a random string that can be used as a password. 

This function will return a strong password which contains of: 

▪ both uppercase and lowercase letters 

▪ numbers 

▪ special characters, such as ~!@#$%^*()[]\/<>:-=+_ 

 

Parameters: 

▪ length = Optional, the length of the password. If omitted, 

then the length will be 8 characters. If the length given is 

less than 8, still a password of 8 characters will be 

returned. 

▪ use_symbols = Optional, is a logical value: to use special 

characters in the password = TRUE or omitted; to create a 

password without special characters = FALSE. 

=ASAPREGEXMATCH(read_value, regular_expression, optional ignorecase) 

Returns TRUE if the value matches the regular expression and FALSE if it does not. 

 

Parameters: 

▪ read_value =  The text to be tested against the regular 

expression. 

▪ regular_expression = The regular expression to test the text 

against. 

▪ ignorecase = Optional. Specifies case-insensitive matching. 

If omitted it is assumed to be FALSE. 

 

Examples: 

value expression result formula 

Molenweg 242 [0-9]+ TRUE =ASAPREGEXMATCH(A2, B2) 

Today's offer is $99.00 [0-9]*\.[0-9]+[0-9]+ TRUE =ASAPREGEXMATCH(A3, B3) 

The appointment is at 15:00 \d{2}\:\d{2} TRUE =ASAPREGEXMATCH(A4, B4) 

 

= ASAPREGEXEXTRACT(read_value, regular_expression, optional ignorecase) 

Returns the text that matches the regular expression. 

 

Parameters: 

▪ read_value = The text to be tested against the regular 

expression.  

▪ regular_expression = The regular expression to test the text 

against. 
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▪ ignorecase = Optional. Specifies case-insensitive matching. 

If omitted it is assumed to be FALSE. 

 

Examples: 

value expression result formula 

Molenweg 242 [0-9]+ 1 =ASAPREGEXEXTRACT(A2, B2) 

Today's offer is $99.00 [0-9]*\.[0-9]+[0-9]+ 99.00 =ASAPREGEXEXTRACT(A3, B3) 

The appointment is at 15:00 \d{2}\:\d{2} 15:00 =ASAPREGEXEXTRACT(A4, B4) 

 

= ASAPREGEXREPLACE(read_value, regular_expression, replacement_value, 

optional replace_all, optional ignorecase) 

Returns a modified version of the text string based on a regular expression. 

 

Parameters: 

▪ read_value = The text to be tested against the regular 

expression.  

▪ regular_expression = The regular expression to test the text 

against. 

▪ replacement_value = The text to replace the matched groups 

with. 

▪ replace_all = Optional. Specifies to replace all matches. If 

omitted it is assumed to be TRUE. 

▪ ignorecase = Optional. Specifies case-insensitive matching. 

If omitted it is assumed to be FALSE. 

 

Examples: 

value expression replacement result formula 

Molenweg 242 [0-9]+ 200 Molenweg 200 =ASAPREGEXREPLACE(A2,B2,C2) 

Today's offer is $99.00 [0-9]*\.[0-9]+[0-9]+ 49.99 Today's offer is $49.99 =ASAPREGEXREPLACE(A3,B3,C3) 

The appointment is at 15:00 \d{2}\:\d{2} 10:30 The appointment is at 10:30 =ASAPREGEXREPLACE(A4,B4,C4) 

The color is (green) \(([A-Za-z]+)\) red The color is red =ASAPREGEXREPLACE(A4,B4,C4) 

 

=ASAPSHEETNAME(optional reference) 

Returns the name of the worksheet this formula is used on. 

 

Parameters: 

▪ reference = Optional, a cell on the sheet that you want to 

get the name from. If omitted then the name of the current 

sheet is returned. 
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=ASAPSPELLNUMBER(ByVal number, optional strLanguage = "EN", optional 
blnCurrency = False, optional strSingular, optional strPlural, optional 

strComma, optional strCentSingular, optional strCentPlural) 

Returns a spelled-out number or amount. 

 

A few examples if cell A1 contains the value 142.23 

=ASAPSPELLNUMBER(A1,"EN", TRUE, "Dollar", "Dollars", , "Cent", "Cents") returns One 

Hundred Forty-Two Dollars and Twenty-Three Cents 

=ASAPSPELLNUMBER(A1,"EN", FALSE,,,"Comma") returns One Hundred Forty-Two Comma 

Twenty-Three Hundredths 

=ASAPSPELLNUMBER(A1,"NL") returns honderdtweeënveertig en drieëntwintig 

honderdsten 

=ASAPSPELLNUMBER(A1,"FR", TRUE, "euro", "euros", , "cent", "cents") returns cent 

quarante-deux euros et vingt-trois cents 

=ASAPSPELLNUMBER(A1,"DE", TRUE, "Euro", "Euros", , "Cent", "Cent") returns 

einhundertzweiundvierzig Euros und dreiundzwanzig Cent 

 

If a number contains more than two decimals this function will spell out the number as if it 

was rounded to two decimals. 

A practical example where this function can be useful is to write out amounts on cheques. 

 

Parameters: 

▪ number = The number or cell with a number you want to spell. 

▪ language = Optional, text string representing in which 

language the number is spelled out: English = EN or omitted, 

Dutch = NL, German = DE, French = FR. 

▪ currency = Optional, logical value: to spell the number as a 

currency = TRUE; to spell the number just as a number = 

FALSE or omitted. For example spell the number 2 as "two 

dollars and no cents" or just "two". 

▪ cur_singular = An optional text string for the currency 

spelled singular. For example "dollar". 

▪ cur_plural = An optional text string for the currency 

spelled plural. For example "dollars". 

▪ comma = An optional text string for the decimal separator 

used. For example the comma sign (",") or point (".") or the 

word "comma". If omitted then it will be automatically 

filled depending on the given language: English = "comma", 

Dutch and German = "komma". 

▪ cur_cent_singular = An optional text string for the word 

used with currency for the amount behind the comma, 

singular. For example "cent". 
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▪ cur_cent_plural = An optional text string for the word used 

with currency for the amount behind the comma, plural. For 

example "cents". 

=ASAPSTRIPNUMBERS(text) 

Removes all numbers from a text string and removes all spaces at the beginning and end of 

the result. 

For example the formula =ASAPSTRIPNUMBERS("8011 LB") returns "LB". 

 

Parameters: 

▪ text = The value or cell address from which you want to 

strip the numbers. 

=ASAPSUMBYCELLCOLOR(reference, color_index_nr) 

Adds the cells that have a certain fill color. 

If you afterwards change the color in any of the referenced cells, you have to press 

Ctrl+Alt+F9 to have the formulas recalculated. 

This function does not recognize formatting if it is applied via conditional formatting. 

 

Parameters: 

▪ reference = The range of cells to search in. 

▪ color_index_nr = The cell that has the fill color to sum, or 

the color index number (1-56) from Excel. 

=ASAPSUMBYFONTCOLOR(reference, color_index_nr) 

Adds the cells that have a certain font color. 

If you afterwards change the font color in any of the referenced cells, you have to press 

Ctrl+Alt+F9 to have the formulas recalculated. 

This function does not recognize formatting if it is applied via conditional formatting. 

 

Parameters: 

▪ reference = The range of cells to search in. 

▪ color_index_nr = The cell that has the font color to sum, or 

the color index number (1-56) from Excel. 

 

Example screenshot: 1 
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Example screenshot: 2 Calculate the sum of cells that have a specific color 

 
 

Example screenshot: 3 Retrieve the comments 

 

13 Correct the link to the ASAP Utilities worksheet functions 

This tool can be used to correct the reference in your workbook to the ASAP Utilities 

worksheet functions. 

This can be useful if your workbook is used on another computer where ASAP Utilities is 

installed in a different folder. For example, the default installation folder of ASAP Utilities 
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differs between a 32-bit and 64-bit Windows version. 
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5.4.10 Fill 

1 Fill empty cells in selection... 

This utility fills all empty cells in your selection with a specified value. 

 

If only one cell is selected then all empty cells within the used range of your worksheet will 

be filled.  

2 Overwrite filled cells in selection... 

This utility fills all non-empty cells in your selection with a specified value. 

 

If only one cell is selected then all filled cells within the used range of your worksheet will 

be filled with the new value.  

3 Copy values to empty cells below filled cells in selection 

This utility fills all empty cells in your selection with the value from the first filled cell found 

above. 

 

This can be very useful if you want for example to prepare your data for a pivot table. 
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4 Fill up with leading zeros... 

This utility fills the numbers in the selected cells up with leading zeros to a given length. 

The utility will actually add the zeros and therefore change the data. If you only need the 

number to be displayed as if they have leading zeros then it is better to use cell formatting 

with a number format such as for example '000000'. 

Numbers with decimals will be rounded to the nearest integer. 

 

For example if you specify a length of 3 then a cell with the value 1 becomes 001, 34 

becomes 034 and numbers greater than 100 will not be changed because they already have 

a length of 3 characters or more 

If a formula in your selection has a number as a result then the calculated value will be 

filled it up with the zeros and the original formula is replaced. 
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5 Insert before and/or after each cell in your selection... 

This utility adds a value in front of and/or at the end of the content of each cell in your 

selection. 

The utility will show you an example of the resulting values. 

 

You can specify the following: 

▪ The value to insert before at the front of each cell 

▪ The value to add at the end of each cell 

▪ Use the value, formula or displayed (formatted) value from the cells. 

▪ Include hidden cells 

▪ Skip empty cells 

 

The 'reset' button clears the insert before and after values and resets the options to their 

default values. This can be useful because this tool always remembers your previous 

settings. 

You can also use this utility to build a formula around the current values. 

 

Example screenshot: 1 
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Example screenshot: 2 

 

6 Fill 'between values' linear in selection (vertical) 

This utility fills your selection with a series based on the values of the cells in your selection. 

The utility fills in a series in each column within your selected range. 

It uses Excel's Fill method with the following settings: 

Series in: Columns 

Trend: Yes 

Type: Linear  

7 Fill 'between values' linear in selection (horizontal) 

This utility fills your selection with a series based on the values of the cells in your selection. 

The utility fills in a series in each row within your selected range. 

It uses Excel's Fill method with the following settings: 

Series in: Rows 

Trend: Yes 

Type: Linear  

  



ASAP Utilities User Guide FREQUENTLY UPDATED 

 

184 Chapter 5 

 

 

8 Quick numbering of selected cells... 

This utility helps you to quickly fill the selected cells with a series or numbered list. 

The utility is flexible and offers several options to choose from. 

 

You can configure the following settings: 

Series setting: 

▪ Create a series with numbers: 

- The number to start with. 

- The number to increment with. 

- Restart counting after a certain value. 

- Fill up the numbers with leading zeros to a specified length. 

▪ Create a series based on the letters from alphabet in lowercase (a, b, c, etc.). 

▪ Create a series based on the letters from alphabet in uppercase (A, B, C, etc.). 

Options: 

▪ You can specify to restart the counting if the value in a certain column changes. You can 

use this for example if you have a list with city names and you want to restart the 

counting when the name of the city changes. You can also specify to put the value of the 

changing column in front of and/or after the value in the series. 

▪ You can add a value in front of and/or after each value in the series. This way you can for 

example create series with week numbers and add the text 'Week ' in front of each value 

in the series. 

▪ You can specify the cell alignment. 

 

By default you can start this utility with the shortcut Ctrl+Alt+Q. 

 

Example screenshot: 1 Example 1 
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Example screenshot: 2 Example 2 

 
 

Example screenshot: 3 Example 3 
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Example screenshot: 4 Example 4 

 
 

Example screenshot: 5 Example 5 
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Example screenshot: 6 Example 6 

 
 

Example screenshot: 7 Example 7 
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Example screenshot: 8 Example 8 

 
 

Example screenshot: 9 Example 9 
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9 Random numbering of cells (without duplicates) 

This utility fills the selected cells with unique random integers. 

 

This can be useful if you want to quickly create a list of random numbers without 

duplicates. 

The lowest created number in the list is 1 and the largest number is the number of cells in 

your selection. 
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10 Insert current date and time with seconds 

This utility inserts the current date and time into the active cell. 

Unlike Excel's built in shortcut Ctrl+; this utility also inserts the seconds. 

 

 

11 Insert current time with seconds 

This utility inserts the time into the active cell. 

Unlike Excel's built in shortcut Ctrl+: this utility also inserts the seconds. 

 

 

12 Insert workbook's path and name in header, footer or cell... 

This utility allows you to put the folder and filename of your workbook into your header, 

footer or selected cells. 

 

You can insert the following information in the selected cells: 

▪ Path and filename 

▪ Filename 

▪ Path 

The path and filename in the cell are automatically updated when you change the name or 

location of your file. 

 

Or you can insert the path and filename into: 

▪ Header left section 

▪ Header center section 

▪ Header right section 

▪ Footer left section 

▪ Footer center section 

▪ Footer right section 

 

The path and filename in the header or footer are automatically updated when the name or 

location of your file changes. An exception for this is when you use Excel 2000. In that case 

you need to run this tool again to have the information updated. 
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13 Create a list of filenames and properties in a folder... 

This utility will create a list of all filenames in a specified folder. 

This way you can for example import on a worksheet the names from all files on a cd-rom. 

 

You can configure the following settings: 

▪ The folder to be searched. 

▪ Search subfolders. 

▪ Create hyperlinks to the files. 

▪ Show only certain file types. For example to report only Excel files you can enter '*.xl*'. 

▪ Sort the results, for example by filename, foldername, date, etc. 

▪ Show only files modified or created within the past specified number of days. 

▪ Create the list of files in a new workbook or on a new worksheet in your current 

workbook.. 

This utility reports the following information about the files: 

▪ Parent Folder 

▪ Filename 

▪ Size (KB) 

▪ Type 

▪ Created (date) 

▪ Last Accessed (date) 

▪ Last Modified (date) 

▪ Full name (foldername and filename together) 

 

By default you can start this utility with the shortcut Ctrl+Alt+F. 

Your last used settings will be remembered. 
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Example screenshot: Create a list of filenames and properties in a folder 

 

14 Insert sheet(s) name in selected cell(s) 

This utility inserts the name of the worksheet into your selected range in each of your 

selected worksheets. 

You can for example use this to insert the sheet name into cell A1 on every selected 

worksheet. 
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5.4.11 Format 

1 Copy a sheet's page and print settings... 

With this tool you can easily copy the page and print settings from a worksheet to other 

worksheets. 

 

You can copy the following properties: 

▪ Rows to repeat at top 

▪ Columns to repeat at left 

▪ Print area 

▪ Header left 

▪ Header right 

▪ Footer left 

▪ Footer center 

▪ Footer right 

▪ Margin left 

▪ Right margin 

▪ Center header 

▪ Top margin 

▪ Bottom margin 

▪ Header margin 

▪ Footer margin 

▪ Row and column headings 

▪ Gridlines 

▪ Printing quality 

▪ Center on page horizontally 

▪ Orientation 

▪ Draft quality 

▪ Paper size 

▪ Print comments 

▪ First page number 

▪ Print in black and white 

▪ Order 

▪ Zoom/scaling 

▪ Center on page vertically 

▪ Scale to fit page 

 

Remark: 

The speed of this utility might vary, depending on the type of printer(driver) that is set as 

default when the tool is executed. 

Starting from Excel XP/2002 you can also insert a picture in the header or footer. 

Unfortunately, this is something that cannot be copied to other worksheets by using a 

macro. So, if you have a picture in the header or footer it will not be copied with this tool in 

ASAP Utilities. From the Microsoft website: "The only way to work with pictures in headers 

or footers for multiple worksheets is to select all the worksheets, and then insert a graphic 

by using the Insert Picture dialog box (click the Insert Picture button), or format the graphic 

by using the Format Picture dialog box (click the Format Picture button). The original 

graphic file is needed for this procedure." 
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2 Insert workbook's path and name in header, footer or cell... 

This utility allows you to put the folder and filename of your workbook into your header, 

footer or selected cells. 

 

You can insert the following information in the selected cells: 

▪ Path and filename 

▪ Filename 

▪ Path 

The path and filename in the cell are automatically updated when you change the name or 

location of your file. 

 

Or you can insert the path and filename into: 

▪ Header left section 

▪ Header center section 

▪ Header right section 

▪ Footer left section 

▪ Footer center section 

▪ Footer right section 

 

The path and filename in the header or footer are automatically updated when the name or 

location of your file changes. An exception for this is when you use Excel 2000. In that case 

you need to run this tool again to have the information updated. 
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3 Empty all headers and footers 

This utility removes the contents of all headers and footers in the selected sheets.  

4 Detect and visualize adjacent data/group changes... 

With this utility you can easily make the differences visible between groups of cells with the 

same content. 

 

You can do the following when the value in a row changes: 

▪ insert an empty row. 

▪ insert a page break. 

▪ insert a border line below group. 

▪ alternating colors per group. 

You can use this for example to identify different groups of data in your worksheet by 

inserting a blank row when the value changes or inserting a line in between. 

 

Your last used settings will be remembered. 

 

Remark: 

This utility only works on the rows (data) in a single column. 
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Example screenshot: 1 Insert an empty row between groups 

 
 

Example screenshot: 2 Insert a pagebreak between groups 
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Example screenshot: 3 Insert a border line between groups 

 
 

Example screenshot: 4 Color banding per group 
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5 Transpose column in multiple steps... 

Transposes data from one column to several columns in steps. 

Useful when you have to deal with a large amount of data in one column and have to 

transpose every X rows. 

 

Formulas and formatting will be preserved. 

 

Example screenshot: Transpose column in multiple steps 

 

6 The paper saver (split columns)... 

Split long columns in order to save paper while printing. 
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7 Wrap text 

This utility will wrap the text in the selected cells. 

This will display long text or text with a manual line break in multiple lines in the cell.  

8 Unwrap text 

This utility will unwrap the text in the selected cells. 

This will display long text or text with a manual line break on a single line in the cells.  

9 Drawing paper... 

This tool allows you to specify the column width and row height of your cells in 

centimeters, inches or pixels. 

This is helpful if you use the Excel for drawing purposes, such as creating a flowchart or 

when you design your garden or need to create a floor plan. 

It can also be handy for quickly creating square cells. 

 

Remark: 

Due to limitations of how precise you can set the width and height in Excel the actual width 

and height might differ a tenth of a centimeter/inch. 

The dimensions in pixels depend on your Windows display DPI settings. 

 

 

Example screenshot: 1 
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Example screenshot: 2 

 

10 Place a border around each page 

This utility places a border around each page on your worksheet. 

The utility asks you up-front if you want to remove all existing borders first.  

11 Delete all borders inside selection 

This utility removes all borders between the cells in your selection. 

Only the borders that possibly exist at the outer border of your selection will remain.  

12 Use a significant number of decimals... 

This utility changes the number format in your cells to show a significant number of 

decimals. 

The difference between this utility and general rounding is that it ignores the zeros that 

come directly after the decimal separator. 

 

For example if you enter the number 3, then the cells will be formatted to show at least 3 

decimals, other than zero. 

A cell with the value "12.0123123" is then shown as "12.0123" instead of "12.012". 

A cell with the value "12.00002134" is then shown as "12.0000213" instead of "12.000".  

13 Unmerge cells in selection 

This utility will unmerge all cells in your selection. 

 

In Excel XP and newer versions you can also click again on the "Merge and center" button 

to unmerge the cells. However in Excel 2000 this is only possible via the cell options and 

then you can use the utility in ASAP Utilities to quickly unmerge all cells in your selection 

instead of having do to this via the cell options. The advantage of this tool ASAP Utilities is 

also that you can assign your own shortcut to this action.  



FREQUENTLY UPDATED ASAP Utilities User Guide 

 

Available tools     201 

 
 

14 Center across selection (without merging) 

This utility centers the values horizontally across the selected empty cells to the right. 

It looks the same as when you merge the cells but it doesn't merge the cell contents nor 

has the disadvantages of merged cells. 

 

You can also do this in Excel via the cell properties. Right-click on the cell and choose 

"Format Cells", select the "Alignment" tab and set the horizontal alignment to "Center 

Across Selection".  

15 Clean data and formatting... 

This utility helps you to optimize and clean information that you have copied into Excel. 

 

You can choose the following edits: 

▪ remove all hyperlinks 

▪ trim spaces (removes leading and trailing 

spaces) 

▪ remove all cell colors 

▪ remove all font colors 

▪ remove all borders 

▪ unmerge cells 

▪ apply standard font 

▪ apply standard font size 

▪ no wrap-text 

▪ fix (text)numbers 

▪ autofit columns 

▪ autofit rows 

▪ remove all objects/images from your 

worksheet 

 

Your last used settings will be remembered. 

 

 

16 Remove all unused styles on every sheet 

This utility removes all unused styles from every worksheet in your workbook. 

In most of the times this fixes the problems when you get the message "Too Many Different 

Cell Formats" in Excel. 

 

What this message means is explained by Microsoft: 
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You receive a "Too many different cell formats" error message in Excel. 

This problem occurs when the workbook contains more than approximately 4000 different 

combinations of cell formats. A combination is defined as a unique set of formatting 

elements that are applied to a cell. A combination includes all font formatting (for example: 

typeface, font size, italic, bold, and underline), borders (for example: location, weight, and 

color), cell patterns, number formatting, alignment, and cell protection. 

Source: https://support.microsoft.com/kb/q213904/  

17 Replace conditional formatting with static formatting in 

selection 

This tool replaces the conditional formatting in the selected cells with regular (static) 

formatting.  

The formatting, that has been applied via conditional formatting rules (number, font, 

border and fill) is verified and then applied as regular (static) formatting. 

The conditional formatting rules are then removed, but not the effects. 

 

A practical example:   

'We work a lot with conditional formatting, but our client wants us to "freeze" the format 

(which means no more use of conditional formatting...) in order to have a classical Excel 

format (mainly cell and font colors). The idea is to do the same thing as we can do with 

formulas or calculations "copy > paste as values" but for conditional formatting.' 

 

Note: 

This tool works in all Excel versions except for Excel 2007. 

Data Bars and Icon Sets cannot be made static with this tool. 

https://support.microsoft.com/kb/q213904/
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18 Remove all conditional formatting in selection 

This utility removes all conditional formatting in the selected cells.  

19 Remove all validations in selected cells 

This utility removes all validation-settings in the selected cells. 

 

In Excel you can only do this on one sheet at a time. 

With this utility you can now quickly do this on multiple sheets at once.  
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20 Count and/or color duplicates in selection... 

This utility tells you how many duplicate values there are in your selected range. 

You can choose to paint all duplicate cells with a certain color. 

 

Remark: 

The utility is case sensitive which means for example that "Excel" and "EXCEL" are not the 

same. 

If your selection contains formulas then this utility compares the calculated values. This 

means that this utility considers a cell with the value 12 and a cell with the formula =3*4 as 

a duplicate. 

 

 

Example screenshot: 1 Count and color duplicated values 

 
 

Example screenshot: 2 Just count the duplicates without coloring them 
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21 Count duplicates and give each set of duplicates its own color 

This tool counts and colors the duplicate values in your selection.  

Each set of duplicated values is given its own unique color. 

 

This helps to quickly find the duplicated values, by having a set of colors each of which can 

readily be distinguished from one another. 

 

Example: 

If your selection contains 5 cells with the value "London" then those 5 cells will all get the 

same color, for example blue. And if the value "Paris" exists in 3 cells then those 3 cells will 

also get the same, but a different color, such as green. 

 

Remark: 

The utility is case sensitive which means for example that "Excel" and "EXCEL" are not the 

same. 

If your selection contains formulas then this utility compares the calculated values. This 

means that this utility considers a cell with the value 12 and a cell with the formula =3*4 as 

a duplicate. 
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22 Copy and apply cell's formatting settings... 

With this utility you can copy certain formatting settings from one cell or the standard 

formatting profile to other cells. 

In Excel you can only copy all formatting settings. With this utility you can now choose to 

only copy certain settings. 

 

You can choose to apply one or more from the following properties: 

▪ Number format 

▪ Font 

▪ Font size 

▪ Font style 

▪ Bold/underline/italic 

▪ Font color 

▪ Horizontal alignment 

▪ Vertical alignment 

▪ Text orientation 

▪ Wrap text 

▪ Cell color 

▪ Cell pattern 

▪ Cell pattern color 

▪ Locked 

▪ Hidden 

 

 

Your last used settings will be remembered. 

 

 

23 Apply standard format to selected cells 

This utility applies the standard formatting to your selected cells. 

 

This standard formatting is defined in the formatting style "normal" in Excel.  
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5.4.12 Objects & Comments 

1 Comment tools... 

This is a collection of tools that can help you with cell comments. 

Extract/report content of comments 

▪ Place the value of the comment cell right next to the comment 

▪ Create report in new workbook 

(sheet name - cell address - range name - cell value - author - comment value) 

Position and size of comments 

You can do the following on the current worksheet or all worksheets in your workbook: 

▪ Reset all comments to their original position 

▪ Autofit/resize all comments 

Set font and font size for comments 

You can change the font and font size for all comments on the current worksheet or on all 

worksheets in your workbook. 

Search and replace in comments 

You can replace text in all comments on the current worksheet or on all worksheets in your 

workbook. 

 

Remark: 

If you want to get the text from a comment into a cell you can also use the  ASAP Utilities 

worksheet formula =ASAPGETCOMMENT(). 
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2 Add cell's value or formula to comment... 

This tool adds the cell's value or formula as comment. 

You can choose to add new comments, replace existing comments or add the cell's value at 

the beginning or the end of an existing comment. 

You can also specify to read the value of a cell to the left or right and use that value or 

formula as comment. 
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3 Select all objects on current worksheet 

This utility selects all objects on your current worksheet. 

These objects are for example shapes, text boxes, pictures, wordart, clip art, charts, forms 

toolbar controls, control toolbox controls, etcetera. 
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4 Delete all objects in selected worksheets 

This utility removes all objects on your current worksheet. 

The objects that will be deleted are for example shapes, text boxes, pictures, wordart, clip 

art, charts, forms toolbar controls, control toolbox controls, etcetera. 
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5 Delete all buttons on selected worksheets 

This utility removes all buttons that are created via the forms toolbar from the selected 

worksheets. 

 

 

6 Resize selected images or OLE objects (%)... 

This utility resizes the selected images or OLE objects relatively to their original size. 

The utility asks you to give a percentage. Based on this percentage the size is changed in 

comparison to the original size (which is 100%).  

7 Remove the border line from selected objects/images 

This utility removes all lines from the selected objects, shapes and pictures.  
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8 Show flowchart toolbars 

This utility will display both the flowchart- and connector toolbar as separate toolbars. 

 

When you work on a flowchart you can select the tools for this via the "Drawing" toolbar. 

Unfortunately it takes several steps. To draw something you first have to click on the 

"AutoShapes" button in the drawing toolbar, then choose "Connectors" or "Flowchart" and 

then you can pick what you want to draw. 

 

By showing the flowchart tools as individual toolbars you can save yourself a few clicks. 

Creating flowcharts will become easier and goes much faster. 

 

Remark: 

This utility does not work in Excel 2007 (and later) because Microsoft has removed the 

toolbars that Excel version.  

If you use Excel 2007 or later then you can choose in the menu (ribbon) 'Insert' > 'Shapes' to 

draw a flowchart. 

If you want to you can add the shapes-group to your quick access toolbar (QAT) by right-

clicking on it. 
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5.4.13 Web 

A collection of tools to help you with data imported from websites, hyperlinks, HTML code 

and more. 

1 Clean data and formatting... 

This utility helps you to optimize and clean information that you have copied into Excel. 

 

You can choose the following edits: 

▪ remove all hyperlinks 

▪ trim spaces (removes leading and 

trailing spaces) 

▪ remove all cell colors 

▪ remove all font colors 

▪ remove all borders 

▪ unmerge cells 

▪ apply standard font 

▪ apply standard font size 

▪ no wrap-text 

▪ fix (text)numbers 

▪ autofit columns 

▪ autofit rows 

▪ remove all objects/images from your 

worksheet 

 

Your last used settings will be remembered. 

 

 

2 Remove all HTML tags in the selected cells... 

This tool will strip all HTML tags in the selected cells, such as for example <br>, <p>, <font>, 

<script>, etc.. 

Besides removing the tags, you can choose to: 

▪ Keep existing line breaks 

▪ Add line breaks at the end of tags such as <br/>, </p>, </h1> etc.. 

 

In addition it will also convert encoded characters such as &nbsp; and &amp; to normal 

characters. 
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3 Decode all URL and HTML encoded text 

This utility decodes all URL-encoded text in your selected cells. 

 

This can be useful when you use Excel for example to analyze reports with website statistics 

or keyword performances. 

The utility will replace the "+" character with a space and it decodes any %## encoded 

character in the cells. 

It will also decode named HTML entities such as &nbsp; and &euro; and it will decode a 

string of text such as %c3%84 and %c3%a7 and unicode characters such as &#169; and 

&#8220;. 

 

This utility will for example decode the text "http%3A%2F%2Fwww%2Emicrosoft%2Ecom" 

to "http://www.microsoft.com", which is more readable. 

 

URL encoding is used when text is place in a query string in the URL to avoid that it gets 

mixed up with the address of the website and it is usually placed behind a question mark (?) 

in the address. This technique is often used when the internet browser sends data via a 

form on the website to the web server. 

The cells in your selection with formulas are skipped. 
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4 Extract hyperlinks... 

This utility extracts the hyperlink addresses from the selected cells and/or extracts them 

from all shapes on your worksheet. 

You can choose to insert the address into the cell itself or in the column right next to the 

cell or shape. 

The shape can be an autoshape, freeform, OLE object, or picture. 

 

Your last used settings will be remembered. 

 

Remark: 

You can also use the ASAP Utilities worksheet function =ASAPGETHYPERLINK() to read the 

hyperlink address from a cell. 
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5 Activate hyperlinks (create from cell values)... 

This utility adds a hyperlink in the selected cells based on content of the cell. 

You can use this for example to transform website- or email addresses into clickable 

hyperlinks. 

 

You can configure the following settings: 

Font format: 

▪ Keep the existing font format in the cells. 

▪ Use Excel's default format for hyperlinks (blue underlined) 

Hyperlink type: 

▪ Use the =HYPERLINK() formula. This is recommended if you have a lot of hyperlinks in 

your file or if you use a shared workbook. 

▪ Regular hyperlinks (via the cell properties) 

 

Your last used settings will be remembered. 
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6 Change all hyperlinks to =HYPERLINK() formulas 

This utility will change all hyperlinks in cells to =HYPERLINK() formulas on the selected 

worksheets. 

The current hyperlink address will be use for the hyperlink part. The text from the screen 

tips will be lost because screentips are not supported by the =HYPERLINK() formula. 

 

Workbooks in Excel can become slow when they contain too much 'normal' cell with 

hyperlinks. The =HYPERLINK() formula does not have that problem. 

 

Remark: 

If the hyperlink address exceeds 255 characters the cell will be skipped, because that is the 

maximum length allowed by Excel in the =HYPERLINK() formula.  

7 Remove all hyperlinks in selected cells 

This utility will remove all the hyperlinks in the selected cells. 

 

Remark: 

This utility will remove regular hyperlink that are set via the cell options. It will not remove 

=HYPERLINK() formulas.  

8 Export selection as HTML table to clipboard... 

Export your selected range as a table in clean HTML-code to the clipboard so that you can 

easily paste it into your webpage. 

This utility has advanced options and is recommended to all web developers. 

Your last used settings will be remembered. 
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Example screenshot: Export your range in clean HTML format 

 

9 Visit our website for more Excel tips and tricks 

This utility will open our website (www.asap-utilities.com) in your default internet browser. 

 

Remark: 

The website is in English. 

This only works if you are connected to the Internet. 

https://www.asap-utilities.com 

 

  

https://www.asap-utilities.com/
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5.4.14 File & System 

1 Save file and create backup... 

This utility saves your file and automatically creates a backup copy in a given folder. 

 

ASAP Utilities will add the date and time to the filename of the backup copy so that you can 

easily see when it was saved. 

For example if you have a file named "Sales.xls" then the name of the backup copy will be 

for example "Sales (backup 2012-08-24 15.28.12).xls". 

 

Example screenshot: Save the file and create a backup copy 

 

2 Save file as... and use the first cell as the suggested filename 

This tool will launch Excel's "save as..." dialog and uses the value of the first filled cell on 

your worksheet as the suggested filename. 
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3 Rename current file... 

Rename your current file without having to close it first. 

 

 

4 Reopen current file without saving changes 

This utility closes your current workbook without saving the changes and then it opens the 

last saved copy of your file. 

 

This can by useful when quickly want to revert to the last saved version of your workbook. 

Which can be for example when you made temporary or incorrect changes that you don't 

want to save. 
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5 Export selection or active sheet as new file... 

With this utility you can save your selected data range or the entire worksheet as a new file. 

You can choose not to include hidden cells in your export. 

 

The data can be exported in the following file formats: 

▪ Excel 97-2003 Workbook (*.xls) 

▪ Excel Workbook (*.xlsx) (only available if you have Excel 2007 or later) 

▪ Excel Binary Workbook (*.xlsb) (only available if you have Excel 2007 or later) 

▪ Formatted text (space delimited) 

▪ Tab delimited text file 

▪ Tab delimited unicode text file 

▪ CSV (comma separated value or custom separated) 

▪ CSV unicode, UTF-16LE / UTF-8 (comma separated value or custom separated)  

▪ dBASE IV (only with Excel 2000, 2002/XP and 2003) 

 

You can also use the CSV option to create your own custom separated file by setting your 

own field separator, field encloser and decimal separator. This way you can for example 

create pipe (|) delimited text files. 

 

You can also choose to copy the information directly to your clipboard in the following 

formats: 

▪ tab delimited 

▪ space delimited 

 

You can choose to export the contents of the cells as: 

▪ Values (for example 12) 

▪ Formulas (for example =3*E6) 

▪ As displayed (for example EUR 12,00) 

 

Your last used settings will be remembered. 

 

Remark: 

In Excel 2007 and later the export to dBASE will not work; Microsoft has removed the 

option to save files in dBASE format from this Excel version and ASAP Utilities needs this 

built-in facility from Excel. 
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6 Export worksheets as separate files... 

With this utility you can save all or the selected worksheets in your workbook as separate 

files. 

You can choose a folder in which you want the worksheets to be saved. 

 

The worksheets can be saved in the following file formats: 

▪ Excel Workbook (*.xlsx) (only available if you have Excel 2007 or later) 

▪ Excel Binary Workbook (*.xlsb) (only available if you have Excel 2007 or later) 

▪ Excel 97-2003 Workbook (*.xls) 

▪ CSV (Comma delimited) (*.csv) 

▪ CSV unicode  (Comma delimited) (*.csv) 

▪ Text (Delimited by semicolon ';') (*.txt) 

▪ Text unicode (Delimited by semicolon ';') (*.txt) 

▪ Text (Tab delimited) (*.tsv) 

▪ Text unicode (Tab delimited) (*.tsv) 

▪ Formatted Text (Space delimited) (*.prn) 

▪ Text (Pipe (|) delimited) (*.txt) 

▪ Text unicode (Pipe delimited) (*.txt) 

▪ Text (Delimited by tilde '~') (*.txt) 

▪ Text unicode (Delimited by tilde '~') (*.txt) 

▪ DBF 4 (dBASE IV) (*.dbf) (only with Excel 2000, 2002/XP and 2003) 

▪ DBF 3 (dBASE III) (*.dbf) (only with Excel 2000, 2002/XP and 2003) 

▪ Web Page (*.htm, *.html) 

▪ Single File Web Page (*.mht, *.mhtml) (only with Excel 2002/XP, 2003, 2007 and 2010) 

▪ PDF (*.pdf) (only with Excel 365, Excel 2021, Excel 2019, Excel 2016, Excel 2013, Excel 

2010 and Excel 2007 SP2 or Excel 2007 SP1 with the MS PDF plugin installed) 
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Your last used settings will be remembered. 

 

Remark: 

In Excel 2007 and later the export to dBASE will not work; Microsoft has removed the 

option to save files in dBASE format from this Excel version and ASAP Utilities needs this 

built-in facility from Excel. 

 

Example screenshot: 1 

 
 

Example screenshot: 2 
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Example screenshot: 3 

 
 

Example screenshot: 4 

 

7 Find and remove external links... 

This utility shows the links in your workbook to other files and it allows you to remove 

them. 

When a link to another workbook exists in a formula and the link is removed, then the 

formula will be replaced with its calculated value. 
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8 Change Excel's default file location (browse)... 

With this utility you can easily change Excel's default file location. 

This is the folder that Excel uses by default when it opens or saves files. 

 

You can also change this folder in Excel via Tools > Options > General (In Excel 2007 or 

newer: Office Button > Excel Options > Save > Default file location). 

The disadvantage of changing this in Excel is that you have to type in the full path manually. 

This utility makes it easier by letting you browse and pick the folder from the list.  

9 Set default path to current file 

This utility will set the default folder to the path of your workbook. 

This causes the dialogs for opening and saving files to start in this folder the next time you 

use them. 

 

 

10 Display the full path and file name in the titlebar 

This utility displays both the folder and the name of your workbook in Excel's title bar. 

An example of when this is useful is when you work on files with similar names but stored 

in different folders. 

 

Remark: 

The information isn't automatically updated. 
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You have to run the utility again if you change the filename, change the folder where the 

file is stored, open a file or create a new one or when you restart Excel. 

If you use this utility often it is useful to include it in your favorites menu and assign a 

shortcut to it. 

 

11 Display file name in titlebar 

This utility displays the name of your workbook in Excel's title bar. 

This is what Excel would normally show in the title bar. 

 

 

12 Close and delete current file 

This utility will close your current workbook and delete it. 

If possible then the file will be sent to your Recycle Bin. If that is not possible then you will 

be asked if you want to permanently delete the file. 
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13 Close all saved files 

This utility closes all files that have been saved. 

Only the files that have been saved and not changed thereafter will be closed. 

 

This can be useful, for example when you have opened a lot of files, looked without making 

any changes, and then quickly want to close them all together.  

14 Close multiple files at once... 

This utility makes it easier to close multiple files at once. 

The utility shows a list of all open workbooks and you can choose which once to close. 

 

When you start the utility then by default all files except for the active workbook are 

selected to be closed. 

You can set the utility give you a warning before a file is closed from which the changes 

haven't been saved yet. In such a case you can choose to save the file first before it is 

closed, not save the changes, or cancel the closing of it. 

 

The utility is useful when you work with a lot of files that are opened in Excel and for 

example when you want to close all files, except for a few. 
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15 Close all open files without saving changes 

This utility closes all workbooks without saving any changes or asking you if you want to 

save them. 

 

Remark: 

Pay good attention when you use this utility because it will also close files that might not 

have been saved.  

16 Add current file to recent files list 

This utility will add your current file to Excel's recent files list. 

This is useful when Excel doesn't add an opened file to the list. This can happen for example 

sometimes when you open a file by double-clicking on it in the Windows Explorer.  

17 Clear recently used files list in the Excel menu 

This utility will reset the recent files in the Excel menu. 

 

This can be useful if you don't want other people on your computer to see which files you 

have been working on.  

18 Remove all macros (VBA code) from current file 

This utility removes all macros (vba-code) from your current workbook. 

 

This can be useful if you want to clean up your workbook before you give it to someone 

else. 

It can also be useful when you get a macro-warning when you open a workbook but you 

don't use any macros from the file. 
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Remark: 

This utility will only remove the macros in the VBA project. Excel 4.0 macro-sheets and Excel 

5.0 dialogs are not removed.  

19 Macro/VBA information (beta, English)... 

This utility shows you information on the macro's that are in a workbook. 

You can quickly see the references the vba-project has, view the modules and you can 

export the code or remove the comment lines in your code. 

This utility is in English because the Visual Basic Editor and the vba macro code is also in 

English.  

20 Resize the Excel window to standard screen resolutions... 

This utility allows you to change the size of the Excel window to the most commonly used 

screen resolutions. 

This way you can easily test and see how your document or application will look on 

computers with different screen resolutions. 

 

Remark: 

The maximum size of the window is limited (by Excel) to your current screen resolution. 
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21 Save current file (developers)... 

This utility enables you to save your workbook if saving is disabled by a macro. 

It does this by ignoring the workbook's Workbook_BeforeSave event.  

22 Create a list of all add-ins 

This utility creates a report with information from the installed add-ins. 

 

A new workbook will be created which lists all installed add-ins, their names, location, type 

and whether they are active or not. 

 

Example screenshot: Create a list of all add ins 

 

23 Reload all installed add-ins (rebuilds the menu) 

This utility rebuilds the Excel menu. 

The worksheet- and the chart menu bar (the main menu bars) are reset and then all active 

add-ins will be reloaded.  

24 Create a list of filenames and properties in a folder... 

This utility will create a list of all filenames in a specified folder. 

This way you can for example import on a worksheet the names from all files on a cd-rom. 

 

You can configure the following settings: 

▪ The folder to be searched. 

▪ Search subfolders. 

▪ Create hyperlinks to the files. 

▪ Show only certain file types. For example to report only Excel files you can enter '*.xl*'. 

▪ Sort the results, for example by filename, foldername, date, etc. 

▪ Show only files modified or created within the past specified number of days. 

▪ Create the list of files in a new workbook or on a new worksheet in your current 

workbook. 

This utility reports the following information about the files: 

▪ Parent Folder 

▪ Filename 

▪ Size (KB) 
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▪ Type 

▪ Created (date) 

▪ Last Accessed (date) 

▪ Last Modified (date) 

▪ Full name (foldername and filename together) 

 

By default you can start this utility with the shortcut Ctrl+Alt+F. 

Your last used settings will be remembered. 

 

 

Example screenshot: Create a list of filenames and properties in a folder 

 

25 Easily create a lot of folders based on the values in selected 

cells... 

This utility allows you to quickly create multiple folders, based on the cell contents. 

 

The utility asks you to pick a folder. In this folder it will then create a new folder for each 

cell in your select and used the value in the cell for the foldername. 
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Example screenshot: 1 Create folders from cell values 

 
 

Example screenshot: 2 Create folders and subfolders by using the backslash character in 

the cells 
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5.4.15 Information 

Collection of "Information" tools  

1 Fast calculation on selected cells... 

This utility performs a fast calculation on the selected datarange. 

 

The utility shows you the following information: 

▪ the number of selected cells 

▪ the number of numeric cells 

▪ the number of text cells 

▪ the number of blank cells 

▪ the sum 

▪ the average 

▪ the minimum value 

▪ the maximum values 

▪ the number of duplicates (values that appear more than once) 

▪ the number of unique values 

▪ values that appear only once 

You can choose to have a new workbook created with these results. 

 

Remark: 

The following rules apply for counting the duplicates and unique values: 

The utility is case sensitive which means for example that "Excel" and "EXCEL" is not the 

same. 

If your selection contains formulas then this utility compares the calculated values. This 

means that this utility considers a cell with the value 12 and a cell with the formula =3*4 as 

a duplicate. 
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Example screenshot: 1 

 
 

Example screenshot: 2 
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2 File and selection info... 

This utility will show you some information about your file, worksheet and current 

selection. 

 

The utility shows the following information: 

▪ Filename 

▪ File size 

▪ Date modified 

▪ Number of sheets 

▪ Name of the active sheet 

▪ Used range address 

▪ Last row 

▪ Last column 

▪ Total cells in the used range 

▪ Total cells with formulas 

▪ Total cells with blanks 

▪ Total cells with constants 

▪ Total cells with errors 

▪ Total cells with logical values 

▪ Total cells with text values 

▪ Total cells with numbers 

▪ Active cell's address 

▪ Column number of the active cell 

▪ Row number of the active cell 

▪ Selected range's address 

▪ Number of columns in the selected 

range 

▪ Number of rows in the selected range 

▪ Number of cells in the selected range 
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3 Copy the path and filename of current workbook to clipboard 

This will put the path and filename of your current workbook to the clipboard. You can then 

paste it into another application. 

This can for example be useful if you're working on a file and want to inform a collegue and 

tell him/her in an email where he/she can find the file. 

 

 

4 Get the page number of the active cell 

This utility mentions the page number of the page where the active cell is located. 

 

An example of when this is useful is when you only want to print certain pages. 
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5 Count and/or color duplicates in selection... 

This utility tells you how many duplicate values there are in your selected range. 

You can choose to paint all duplicate cells with a certain color. 

 

Remark: 

The utility is case sensitive which means for example that "Excel" and "EXCEL" are not the 

same. 

If your selection contains formulas then this utility compares the calculated values. This 

means that this utility considers a cell with the value 12 and a cell with the formula =3*4 as 

a duplicate. 

 

 

Example screenshot: 1 Count and color duplicated values 

 
 

Example screenshot: 2 Just count the duplicates without coloring them 
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6 Count duplicates and give each set of duplicates its own color 

This tool counts and colors the duplicate values in your selection.  

Each set of duplicated values is given its own unique color. 

 

This helps to quickly find the duplicated values, by having a set of colors each of which can 

readily be distinguished from one another. 

 

Example: 

If your selection contains 5 cells with the value "London" then those 5 cells will all get the 

same color, for example blue. And if the value "Paris" exists in 3 cells then those 3 cells will 

also get the same, but a different color, such as green. 

 

Remark: 

The utility is case sensitive which means for example that "Excel" and "EXCEL" are not the 

same. 

If your selection contains formulas then this utility compares the calculated values. This 

means that this utility considers a cell with the value 12 and a cell with the formula =3*4 as 

a duplicate. 
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7 Count the different unique values in selection 

This utility tells you how many different unique values there are in your selected range. 

It counts the values that appear only once in your selection. 

You can choose if you want include the hidden cells in your selection. 

 

Remark: 

The utility is case sensitive which means for example that "Excel" and "EXCEL" are not the 

same. 

If your selection contains formulas then this utility compares the calculated values. This 

means that this utility considers a cell with the value 12 and a cell with the formula =3*4 as 

a duplicate. 
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8 Count number of characters in selected cell 

This tool will tell you how many characters there are in your active cell. 

For example if the cell contains the value 'Microsoft Excel' this tool will tell you it is 15 

characters. 

 

In your worksheet you can also use Excel's worksheet function =LEN(). 

 

 

9 Create a list of all built in workbook properties (title, author 

etc.) 

This utility creates a report with all document properties. 

A new workbook will be created which lists all the properties from your workbook (title, 

author, etc.). 
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10 Create a list of all range names in the workbook 

This utility creates a report with all named ranges in your workbook. 

 

A new workbook will be created which lists all the names ranges within your workbook and 

their cell references. 

Starting from Excel version 2007 this utility will also report the name comments.  

11 Create a list of all sheet names 

This utility creates a report with the names of the sheets in your workbook. 

 

A new workbook will be created which lists all the names of the sheets in your workbook. 

 

Remark: 

You might also be interested in the "Create an index page with links to all sheets 

(clickable)..." utility.  

12 Report the formulas used in the worksheets in your 

workbook 

This tool will report all formulas used in the worksheets on your workbook. 

 

The report shows the following information: 

▪ Sheet; The name of the worksheet the formula is on 

▪ Cell; The cell address the formula is in. You can click on the address to jump to it, it is a 

hyperlink. 

▪ Value; The calculated result 

▪ Displayed value; The displayed result. This uses the cell's number format. 

▪ Formula; The formula 

 

 

13 Create a list of all type of cell values 

This utility creates a new workbook that reports the data types of your current worksheet. 

The new workbook is a copy of your worksheet without the actual data but where the cells 

with formulas, numbers, text and external links are marked with different colors. 

The following colors are used to display which information is stored in a cell: 
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▪ Blue: Formula 

▪ Yellow: Number 

▪ Green: Text 

▪ Red: External link 

 

This can for example be useful to quickly see the structure of your worksheet and see 

where formulas are used.  

14 Create a list of filenames and properties in a folder... 

This utility will create a list of all filenames in a specified folder. 

This way you can for example import on a worksheet the names from all files on a cd-rom. 

 

You can configure the following settings: 

▪ The folder to be searched. 

▪ Search subfolders. 

▪ Create hyperlinks to the files. 

▪ Show only certain file types. For example to report only Excel files you can enter '*.xl*'. 

▪ Sort the results, for example by filename, foldername, date, etc. 

▪ Show only files modified or created within the past specified number of days. 

▪ Create the list of files in a new workbook or on a new worksheet in your current 

workbook. 

 

This utility reports the following information about the files: 

▪ Parent Folder 

▪ Filename 

▪ Size (KB) 

▪ Type 

▪ Created (date) 

▪ Last Accessed (date) 

▪ Last Modified (date) 

▪ Full name (foldername and filename together) 

 

By default you can start this utility with the shortcut Ctrl+Alt+F. 

Your last used settings will be remembered. 
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Example screenshot: Create a list of filenames and properties in a folder 

 

15 Display selection type 

This utility tells you the type of the selection you have selected. 

These are English names, the utility uses the programming code TypeName(Selection) to 

get the name. 

This can for example be range, chart, rectangle, etc. and it can be useful if you are 

programming and need to know how something is called.  

16 Count number of sheets 

This utility tells you how many sheets there are in your workbook. 
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17 Find bad cell references (#REF!) 

This utility selects all cells on your worksheets that have a formula with a bad cell 

references. 

Excel displays the value #REF! in such cells.  

18 Find too narrow columns (####) 

This utility will inspect your worksheet for columns that are too narrow to display the 

contents. 

When a column is too small to display a number or date, Excel will show cross hatches 

(####) in the cell instead of the actual value. 

Especially when your worksheet contains a lot of data then this utility can be useful. 

 

Remark: 

The utility only reports columns that are too small to display numbers or dates.  

19 Display your screen resolution 

This utility shows you what your current screen resolution is. 

The screen resolution is set in the "Display Properties" in Windows. 

 

For working in Excel generally the bigger these numbers are, the better. This is because you 

then show more information on your screen at once. 

 

 

20 Display the country settings of your computer 

This utility will display a few of the country settings from your computer. 

 

The utility shows you the following settings that your computer uses: 

▪ the decimal separator; 

▪ the thousand separator; 

▪ the date separator; 

▪ the order in which the dates are shown (for example day-month-year or month-day-year, 

etc.) 
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We have created this utility so you can quickly view this information because it is 

sometimes difficult to quickly find this information on a computer where these settings are 

blocked by the IT department. 

 

 

21 Create a list of all add-ins 

This utility creates a report with information from the installed add-ins. 

 

A new workbook will be created which lists all installed add-ins, their names, location, type 

and whether they are active or not. 

 

Example screenshot: Create a list of all add ins 

 

22 List all fonts in new workbook 

This utility reports all fonts that are available in Excel on your computer. 

 

A new workbook is creates that shows all font names and an example of the display of the 

fonts. 

You can use this for example as a quick reference to see the fonts available, or to see how 

text will look in certain fonts. 
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5.4.16 Import 

A collection of tools that help you with importing and merging data.  

1 Insert Excel file... 

With this utility you can import an Excel file into your workbook. 

 

The sheets of the imported file will be placed at the end of your workbook. 

If the name of a sheet already exists then an incrementing number between parenthesis () 

is added to the end of the name. 

 

Remark: 

Any macros that might exist in the file that is imported are ignored and not imported.  

2 Insert (delimited) text file... 

With this utility you can import a (delimited) text file into your worksheet at the position of 

your active cell. 

 

You can configure the following settings: 

▪ How are the fields in the text file separated: 

- space 

- tab 

- comma (csv) 

- semicolon (;) 

- pipe (|) 

- exclamation mark (!) 

- other: you can specify a custom 
delimiter 

- not separated 

Text qualifier: none, ' or " 
Start import at row 
File origin 

▪ Date settings 

- The utility uses the date settings as set in the Regional Settings in the Windows 

control panel. 

▪ Field settings 

- Let Excel detect the field types (default) 

- Treat all fields as text values (this can for example help when you have problems 

with leading zeros that are lost). 

▪ Settings used to recognize numeric data 

- Decimal separator 

- Thousand separator 

- Trailing minus for negative numbers 

▪ Options 

- AutoFit column widths 
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- Remove leading and trailing spaces 

 

Your last used settings will be remembered. 

 

Example screenshot: Import a delimited text file 

 

3 Insert dBASE file... 

This utility inserts a dBASE file into your worksheet at the position of your active cell.  

4 Insert text file separated by space... 

This utility inserts a space separated text file into your worksheet at the position of your 

active cell.  

5 Insert text file separated by tab... 

This utility inserts a tab separated text file into your worksheet at the position of your 

active cell.  

6 Insert text file separated by comma (csv file)... 

This utility inserts a comma separated text file (CSV) into your worksheet at the position of 

your active cell.  
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7 Insert text file separated by "|" (pipe/bar)... 

This utility inserts a pipe (|) delimited text file into your worksheet at the position of your 

active cell. 

 

From Wikipedia: Although not as common as commas or tabs, the vertical bar can be used 

as a delimiter in a text file. The symbol "|" has various names. 

Source: https://en.wikipedia.org/wiki/Vertical_bar  

8 Insert text file separated by "!" (exclamation mark)... 

This utility inserts a text file that is delimited by an exclamation mark (!) into your 

worksheet at the position of your active cell.  

9 Insert text file (with options)... 

This utility inserts a text file into your worksheet at the position of your active cell. 

The Excel "Text Import Wizard" will ask you to specify how the file is built.  

10 Merge and/or import multiple files... 

This utility will merge multiple files from a folder together into one new file. You can also 

use it to import multiple files at once into your workbook. 

 

Excel has no built-in method for merging files. It can therefore be time consuming and 

frustrating if you for example need to import or merge 200 Excel or CSV files. Fortunately 

you can use ASAP Utilities to do this quick and easy. 

 

You can configure the following settings: 

▪ Start the import from a certain row, with the option to make an exception for the first 

file. This can be useful if you have files with fieldnames and only want these listed once. 

▪ Import the files into your current workbook or a new workbook. 

▪ Create a new worksheet for each file, or merge the data into one new sheet. With this 

second option the data from the files will be placed below each other. 

You can import/merge the following file formats: 

▪ CSV, comma delimited 

▪ Text, space delimited 

▪ Text, tab delimited 

▪ Text, pipe (|) delimited 

▪ Text file, semicolon (;) delimited 

▪ Text file, delimited by specified character 

▪ dBASE 

▪ Excel* 

https://en.wikipedia.org/wiki/Vertical_bar
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▪ Lotus 123* 

▪ Quattro Pro* 

* Only data from the active sheet is imported 

 

Your last used settings and chosen folder will be remembered. 

 

Example screenshot: Import multiple files 

 

11 Create a list of filenames and properties in a folder... 

This utility will create a list of all filenames in a specified folder. 

This way you can for example import on a worksheet the names from all files on a cd-rom. 

 

You can configure the following settings: 

▪ The folder to be searched. 

▪ Search subfolders. 

▪ Create hyperlinks to the files. 

▪ Show only certain file types. For example to report only Excel files you can enter '*.xl*'. 

▪ Sort the results, for example by filename, foldername, date, etc. 

▪ Show only files modified or created within the past specified number of days. 

▪ Create the list of files in a new workbook or on a new worksheet in your current 

workbook. 

This utility reports the following information about the files: 

▪ Parent Folder 

▪ Filename 

▪ Size (KB) 

▪ Type 
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▪ Created (date) 

▪ Last Accessed (date) 

▪ Last Modified (date) 

▪ Full name (foldername and filename together) 

By default you can start this utility with the shortcut Ctrl+Alt+F. 

Your last used settings will be remembered. 

 

Example screenshot: Create a list of filenames and properties in a folder 
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5.4.17 Export 

A collection of tools that help you with the exporting of data and pictures or charts in 

various file formats.  

1 Export selection or active sheet as new file... 

With this utility you can save your selected data range or the entire worksheet as a new file. 

You can choose not to include hidden cells in your export. 

 

The data can be exported in the following file formats: 

▪ Excel 97-2003 Workbook (*.xls) 

▪ Excel Workbook (*.xlsx) (only available if you have Excel 2007 or later) 

▪ Excel Binary Workbook (*.xlsb) (only available if you have Excel 2007 or later) 

▪ Formatted text (space delimited) 

▪ Tab delimited text file 

▪ Tab delimited unicode text file 

▪ CSV (comma separated value or custom separated) 

▪ CSV unicode, UTF-16LE / UTF-8 (comma separated value or custom separated) 

▪ dBASE IV (only with Excel 2000, 2002/XP and 2003) 

 

You can also use the “CSV” option to create your own custom separated file by setting your 

own field separator, field encloser and decimal separator. This way you can for example 

create pipe (|) delimited text files. 

 

You can also choose to copy the information directly to your clipboard in the following 

formats: 

▪ tab delimited 

▪ space delimited 

 

You can choose to export the contents of the cells as: 

▪ Values (for example 12) 

▪ Formulas (for example =3*E6) 

▪ As displayed (for example EUR 12,00) 

 

Your last used settings will be remembered. 

 

Remark: 

In Excel 2007 and later the export to dBASE will not work; Microsoft has removed the 

option to save files in dBASE format from this Excel version and ASAP Utilities needs this 

built-in functionality from Excel. 
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2 Export selection as HTML table to clipboard... 

Export your selected range as a table in clean HTML-code to the clipboard so that you can 

easily paste it into your webpage. 

This utility has advanced options and is recommended to all web developers. 

Your last used settings will be remembered. 

 

 

Example screenshot: Export your range in clean HTML format 
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3 Export selected chart or range as image (file)... 

With this utility you can save your selected range or chart as a picture in GIF-, PNG-, JPG-, 

TIF or EMF-format. 

 

You can use the following file formats: 

▪ GIF: Recommended when your selection or chart has only a few different colors. Perfect 

for publications on the internet. 

▪ JPG: Recommended when your selection of chart has a lot of different colors (as in a 

photo). Perfect for publications on the internet. 

▪ PNG: Better quality then JPG, but not yet supported by all software (email). Works in all 

recent internet browsers. 

▪ TIF: Best quality for photo quality color images. Usually also the largest file size. Not 

available in Excel 2003 and later, in that case, please use PNG instead. 

▪ EMF: A vector graphic in EMF (enhanced version of WMF) format can be scaled and fully 

edited in MS Office and other Windows applications. 

 

Your last used settings will be remembered. 

 

Remark: 

When you export a large range or a large chart a part of the exported image might be 

truncated or colors might be lost. This is not an ASAP Utilities bug, Excel has a limit on the 

size of the exported images. This limit depends on your Windows and Excel version. Starting 

from Excel XP/2002 in combination with Windows XP much larger images can be produced. 

In some cases when your image gets truncated exporting your image as EMF file might be a 

solution. Another solution is to copy the chart or range and paste the result in your favorite 

image-editing program or MS Office application. You can do this by using by copying in a 

special way in Excel. In Excel 2000, 2002/XP and 2003 hold down the shift-key and then in 

the menu choose "Edit" and then "Copy Picture". Another option to place the selection as a 

picture on your clipboard is to use the tools in the ASAP Utilities export submenu. 
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4 Export worksheets as separate files... 

With this utility you can save all or the selected worksheets in your workbook as separate 

files. 

You can choose a folder in which you want the worksheets to be saved. 

 

The worksheets can be saved in the following file formats: 

▪ Excel Workbook (*.xlsx) (only available if you have Excel 2007 or later) 

▪ Excel Binary Workbook (*.xlsb) (only available if you have Excel 2007 or later) 

▪ Excel 97-2003 Workbook (*.xls) 

▪ CSV (Comma delimited) (*.csv) 

▪ CSV unicode  (Comma delimited) (*.csv) 

▪ Text (Delimited by semicolon ';') (*.txt) 

▪ Text unicode (Delimited by semicolon ';') (*.txt) 

▪ Text (Tab delimited) (*.tsv) 

▪ Text unicode (Tab delimited) (*.tsv) 

▪ Formatted Text (Space delimited) (*.prn) 

▪ Text (Pipe (|) delimited) (*.txt) 

▪ Text unicode (Pipe delimited) (*.txt) 

▪ Text (Delimited by tilde '~') (*.txt) 

▪ Text unicode (Delimited by tilde '~') (*.txt) 

▪ DBF 4 (dBASE IV) (*.dbf) (only with Excel 2000, 2002/XP and 2003) 

▪ DBF 3 (dBASE III) (*.dbf) (only with Excel 2000, 2002/XP and 2003) 

▪ Web Page (*.htm, *.html) 

▪ Single File Web Page (*.mht, *.mhtml) (only with Excel 2002/XP, 2003, 2007 and 2010) 

▪ PDF (*.pdf) (only with Excel 365, Excel 2021, Excel 2019, Excel 2016, Excel 2013, Excel 

2010 and Excel 2007 SP2 or Excel 2007 SP1 with the MS PDF plugin installed) 

Your last used settings will be remembered. 

 

Remark: 

In Excel 2007 and later the export to dBASE will not work; Microsoft has removed the 

option to save files in dBASE format from this Excel version and ASAP Utilities needs this 

built-in facility from Excel. 
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Example screenshot: 1 

 
Example screenshot: 2 
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Example screenshot: 3 

 

5 Copy selection as values to clipboard 

This utility copies the values of the selected cells to your clipboard. 

 

You might experience that Excel sometimes resets the range you have copied and then you 

cannot past the information without first having to copy it again. 

This utility puts the values of the selected range in your clipboard and can make it easier to 

copy the information. 

 

Sometimes Excel puts double quotes (") around the data when you want to paste it into 

another application. This utility doesn't do that and can be useful in such cases too. 

 

Example screenshot: 1 Standard copy in Excel can cause double quotes around the data 
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Example screenshot: 2 The result of copying with ASAP Utilities 

 

6 Copy sum of selection to clipboard 

Copy the calculated sum of selected cells to your clipboard. Just like you can see in the 

statusbar of Excel.  

7 Copy average of selection to clipboard 

Copy the calculated average of selected cells to your clipboard. Just like you can see in the 

statusbar of Excel.  

8 Put the selection as bitmap-image on the clipboard (as on 

screen) 

This utility places the selection as it looks on the screen as a bitmap-image on the clipboard. 

You can then paste the picture into a program such as for example MS Word or a photo-

editor. 

 

You can also do this in Excel itself but the advantage of having it in ASAP Utilities is that it 

takes less steps and you can assign a shortcut to it. 

▪ Excel 2003/2002/XP/2000: 

Hold down the Shift key and click in the menu on "Edit". Then choose "Copy Picture..." 

and choose the options "As shown on screen" and "Bitmap". 

▪ Excel 365/2021/2019/2016/2013/2010/2007:  

Select the Home-tab in the ribbon. Then choose "Paste" > "As Picture" > "Copy as 

picture..." and choose the options "As shown on screen" and "Bitmap". 
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9 Put the selection as image on the clipboard (as on screen) 

This utility places the selection as it looks on the screen as an image on the clipboard. 

You can then paste the picture into a program such as for example MS Word. 

 

You can also do this in Excel itself but the advantage of having it in ASAP Utilities is that it 

takes less steps and you can assign a shortcut to it. 

▪ Excel 2003/2002/XP/2000:  

Hold down the Shift key and click in the menu on "Edit". Then choose "Copy Picture..." 

and choose the options "As shown on screen" and "Picture". 

▪ Excel 365/2021/2019/2016/2013/2010/2007: 

Select the Home-tab in the ribbon. Then choose "Paste" > "As Picture" > "Copy as 

picture..." and choose the options "As shown on screen" and "Picture". 

10 Put the selection as image on the clipboard (as on printer) 

This utility places the selection as it would look when printed as an image on the clipboard. 

You can then paste the picture into a program such as for example MS Word. 

 

You can also do this in Excel itself but the advantage of having it in ASAP Utilities is that it 

takes less steps and you can assign a shortcut to it. 

▪ Excel 2003/2002/XP/2000: 

Hold down the Shift key and click in the menu on "Edit". Then choose "Copy Picture..." 

and choose the options "As shown when printed" and "Picture". 

▪ Excel 365/2021/2019/2016/2013/2010/2007: 

Select the Home-tab in the ribbon. Then choose "Paste" > "As Picture" > "Copy as 

picture..." and choose the options "As shown when printed" and "Picture". 
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5.4.18 Start 

A collection of tools to quickly start the most used standard Windows applications. 

1 Special Characters 

This utility will start the MS Windows "Special Character" program. 

 

We have added this to ASAP Utilities so that you can easily select special characters from 

Excel. 

Remember that if you use special characters from another font than used in your cell, then 

you have to adjust the font in your cell too. 

 

 

2 Calculator 

This utility starts the MS Windows Calculator program. 

Perhaps unnecessary in Excel, but some people find this easy to make a quick calculation or 

to check their formula results. 
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3 Windows Explorer 

This utility starts the MS Windows Explorer program. 

 

This can be easy on computers in some companies where the link to the Windows Explorer 

is removed from the start menu.  

4 Windows Explorer (start in current file's folder) 

This utility will start the MS Windows Explorer program and opens it with the folder where 

your current file is stored. 

You will be surprised how useful this is.  

5 Clipboard Viewer 

This utility starts the MS Windows Clipboard Viewer program.  

6 Notepad 

This utility start the MS Windows Notepad program. 
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7 Funny (error) messages (English) 

This utility displays random funny (error) messages. 

These will make you smile (at least some of them should...) and give you a little distraction 

from your work in Excel. 

 

The messages are in English. 

 

 

Example screenshot: File not found 

 
 

Example screenshot: Mouse error 

 
 

Example screenshot: Press 
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5.4.19 ASAP Utilities Options 

1 Settings, language and contact information... 

Here you can change the settings of ASAP Utilities. 

 

When you press the "OK" button the changes will be saved, except for the language. If you 

change the language this is immediately saved. 

General 

▪ Ask for confirmation before starting certain utilities (recommended) 

You can switch on/off the question that sometimes is asked before running the utility. 

For example a question such as "Do you want to convert all text in the selected cells to 

UPPERCASE?". 

By default this option is checked. 

▪ Enable undo where available (recommended) 

Turn the undo on or off. Sometimes to increase the speed you might want to turn off the 

undo. 

▪ Use the F11 key to switch between full screen and normal view. 

Excel does not have a shortcut to switch between full screen and normal view. In most 

internet browsers you can use the F11 key to do this. 

You can now choose to use the F11 key to switch between full screen mode in Excel with 

ASAP Utilities. By default, Excel uses the F11 key inserts a chart sheet in Excel but you can 

also do that with the key combination Alt+F1. 

▪ Use numbered menu (recommended) 

You can choose if you want the menu to be numbered. This option is only available in 

Excel 2000/2002/XP and 2003. 

▪ Use numbered submenu-items (recommended) 

You can choose if you want the menu items in the submenus to be numbered. This can 

make it easier to quickly find a tool in the menu. 

▪ Show the ASAP Utilities menu also in the Add-ins tab ('classic' menu). 

This option is only available in the ribbon of Excel 2007 or later. 

▪ Show in right-click context menu (recommended) 

▪ Help improve ASAP Utilities 

Allow ASAP Utilities to report anonymous usage statistics. These usage statistics do not 

include personal information, such as the data you work with. Usage statistics do include 

the following information from your computer: Windows version and language, Excel 

version and language, ASAP Utilities version and language, and the id's of the 10 tools 

used most often and your ip address. 

This information helps with the further development of ASAP Utilities and its 

documentation and translations. 

▪ Language used in menus and dialogs 

Here you can change the language of ASAP Utilities into one of the available languages. 
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Folder settings 

This tab shows you in which folder ASAP Utilities is installed. 

▪ Folder to store your "Favorites and shortcuts" file. 

Here you can specify the folder where your favorites menu file is stored. If you work on 

multiple computers it can be useful to store the favorites menu file on a network folder 

so that it is accessible from both computers. 

If you pick a folder that doesn't have a favorites menu file yet, a file with the default 

settings will be created. 

▪ Default path to save a backup. 

Here you can specify where the backups are saved that are created with the "Save file 

and create backup" utility. 

File size Toolbar 

Here you can turn the file size toolbar on or off from here. 

You can also change the refresh time to update the file size toolbar. 

This option is only available in Excel 2000/2002/XP and Excel 2003. 

Contact information 

If you encounter problems and you contact us, then please provide the information 

displayed here. 

It will give us information about the version of Excel and ASAP Utilities that you use, 

including some other important information. 

When you click on the button "Copy info to clipboard for use in email" the information will 

be put on your clipboard and you can easily paste it into an email to use where you 

describe the problem. 

More information about contacting us is written in Chapter 8, Troubleshooting FAQ of the 

User Guide (English). 

The following page on our website shows how to report a bug: 

https://www.asap-utilities.com/contact-support-bug-report.php 

https://www.asap-utilities.com/contact.php 

Important: We can only help you if you communicate in English or Dutch. 

Debug 

In some cases, you will be advised by the ASAP Utilities support team to turn on this debug 

setting to help solve specific problems.  

This log file records certain steps in ASAP Utilities and can help detect at which point 

https://www.asap-utilities.com/contact-support-bug-report.php
https://www.asap-utilities.com/contact.php
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something goes wrong. 

 

2 Edit your favorite tools and shortcut keys... 

ASAP Utilities contains a lot of different utilities. 

With the "Favorite tools" you can add the tools from ASAP Utilities that you use most 

frequently and assign your own shortcuts to them.  

 

By default, ASAP Utilities uses the following shortcuts (which you can customize): 

Shortcut Action 

▪ Ctrl+Alt+A Select adjacent cells in column with the same value 

▪ Ctrl+Alt+B Reload all installed add-ins (rebuilds the menu) 

▪ Ctrl+Alt+C Color each n'th row or column in selection... 

▪ Ctrl+Alt+D Deselect cells... 

▪ Ctrl+Alt+E Set default path to current file 

▪ Ctrl+Alt+F Create a list of filenames and properties in a folder... 

▪ Ctrl+Alt+G Export selection or active sheet as new file... 

▪ Ctrl+Alt+H Find and/or replace in all sheets... 

▪ Ctrl+Alt+I Apply formula/calculation to selected cells... 

▪ Ctrl+Alt+J Start the last used utility again... 

▪ Ctrl+Alt+Shift+Right Arrow Extend selection to the last used column 

▪ Ctrl+Alt+Shift+Down Arrow Extend selection to the last used row 

▪ Ctrl+Alt+M Move or resize selected range... 

▪ Ctrl+Alt+N Add new worksheet (fill in a name)... 

▪ Ctrl+Alt+O Select cells based on content, formatting and more... 

▪ Ctrl+Alt+P Change formulas to their calculated values 
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Shortcut Action 

▪ Ctrl+Alt+Q Quick numbering of selected cells... 

▪ Ctrl+Alt+R Reset Excel's last cell 

▪ Ctrl+Alt+S Save file and create backup... 

▪ Ctrl+Shift+I Vision Control... 

▪ Ctrl+Alt+X Move selected data (only values)... 

▪ Ctrl+Alt+Y Paste special (with combinations)... 

▪ Ctrl+Shift+D Insert current date and time with seconds 

▪ Ctrl+Shift+T Insert current time with seconds 

▪ Ctrl+Alt+Z Find and run a utility... 

 
Example screenshot: 1 The favorites and shortcuts menu 

 



ASAP Utilities User Guide FREQUENTLY UPDATED 

 

268 Chapter 5 

 

 

Example screenshot: 2 Change your favorite utilities and assign your own shortcut 

 

3 Start the last used utility again... 

Start the utility you last used from ASAP Utilities. 

 

By default you can start this utility with the shortcut Ctrl+Alt+J. 

 

Example screenshot: 1 Excel 365, 2021-2007 
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Example screenshot: 2 Excel 2003,Excel 2002, Excel 2000 
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4 Find and run a utility... 

Quickly find the utility you need. 

 

With this utility you can search in the names and descriptions of all available tools in 

ASAP Utilities. 

You can also immediately run the utility from the results box or click the ?-button to view 

the details and a screenshot (if available) on our website. 
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5 Open the ASAP Utilities User Guide (English, PDF)... 

Start the English User Guide (PDF-document) of ASAP Utilities. 

 

In my opinion a good program should be easy to use without the use of documentation. 

During the last years the need for documentation has increased. In this document you will 

find detailed information about the installation, the use of the tools and a chapter where 

we show you how to solve frequently occurring problems (or challenges) with the help of 

ASAP Utilities. 

 

6 Read the latest news on ASAP Utilities 

This utility will open the news section from our website (www.asap-utilities.com) in your 

default internet browser. 

 

Remarks: 

The news is in English. 

This only works if you are connected to the Internet.  

7 Visit the online FAQ: Frequently Asked Questions about 

ASAP Utilities 

This utility will open the support section from our website (www.asap-utilities.com) in your 

default internet browser. 

Do you have a question about ASAP Utilities or do you encounter a problem? Then please 

first read our list of frequently asked questions (FAQ) on our website because chances are 

big that you will find the answer there. 

 

Remarks: 

The support section is in English. 

This only works if you are connected to the Internet.  
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8 Check for new version on the ASAP Utilities website 

This utility will open our website (www.asap-utilities.com) in your default internet browser 

and shows you if there is a newer version of ASAP Utilities available. 

If you want to be informed by email when a new version is released, you can subscribe to 

our newsletter: 

https://www.asap-utilities.com/asap-utilities-newsletter.php 

 

Remarks: 

The website is in English. 

This only works if you are connected to the Internet. 

 

 

9 (Re) build the ASAP Utilities toolbar 

This utility creates or rebuilds the ASAP Utilities toolbar. 

This is a toolbar that contains a few of the most used tools from ASAP Utilities. 

 

You can adjust the size of the toolbar by dragging its border. 

If you wish to remove toolbar buttons you never use, select in the Excel menu View » 

Toolbars » Customize. Then drag the unwanted buttons away from the toolbar. When 

you're finished, click Close to close the Customize dialog box. 

 

Remark: 

This utility does not work in Excel 2007 (and later) because Microsoft has removed the 

toolbars that Excel version. 

You might also be interested in the utility "(Re) build the ASAP Utilities Favorites menu 

toolbar". 
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10 (Re) build the ASAP Utilities Favorites menu toolbar 

This utility creates or rebuilds the ASAP Utilities favorites toolbar. 

This is a toolbar that contains your favorite tools. You can customize the contents of this via 

the tool "Edit your favorite tools and shortcut keys...". 

 

You can adjust the size of the toolbar by dragging its border. 

If you wish to remove toolbar buttons you never use, select in the Excel menu View » 

Toolbars » Customize. Then drag the unwanted buttons away from the toolbar. When 

you're finished, click Close to close the Customize dialog box. 

 

Remark: 

This utility does not work in Excel 2007 (and later) because Microsoft has removed the 

toolbars that Excel version. 
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11 New tools in development (English only) 

 
New tools that are currently in development. These tools are available in English because 
they are still in development. 

Bulk replace: replace multiple values at once 

This tool allows you to do multiple replacements at once. 

You can specify a range with 2 columns with search and replace values, which allows you to 

do many replacements automatically after each other. The target can be a certain range, 

your current worksheet, all selected worksheets, the entire workbook or any other 

workbook that is opened. 

The search/replace is done in both cell values and hyperlinks. 

The range with these search and replace values are always excluded from the target range. 

Your last used settings are remembered.  

Change cells to MAC Address formatting... 

This tool changes the MAC addresses (such as 0123456789ab) in your selected cells into a 

more readable and standardized format. 

 

You can choose between the following styles: 

▪ 01:23:45:67:89:ab 

▪ 01-23-45-67-89-ab 

▪ 0123.4567.89ab 

If required this tool will automatically remove any spaces, hyphens (-), colons (:) or points(.) 

first, so that you can also easily convert it from one format to another. 

Convert long HEX values to ASCII text in selected cells 

This tool converts (long) HEX values in the selected cells to ASCII text. 

For example, it converts 

"446f6e277420796f75207468696e6b207468617420457863656c2069732067726561743f" 

to "Don't you think that Excel is great?". 

It converts values like the following: 

▪ 446f6e277420796f75207468696e6b207468617420457863656c2069732067726561743f 

▪ 44-6f-6e-27-74-20-79-6f-75-20-74-68-69-6e-6b-20-74-68-61-74-20-45-78-63-65-6c-20-69-73-20-67-72-65-61-74-3f 

▪ 44~6f~6e~27~74~20~79~6f~75~20~74~68~69~6e~6b~20~74~68~61~74~20~45~78~63~65~6c~20~69~73~20~67~72~65~61~74~3f 

▪ 44 6f 6e 27 74 20 79 6f 75 20 74 68 69 6e 6b 20 74 68 61 74 20 45 78 63 65 6c 20 69 73 20 67 72 65 61 74 3f 

▪ 44:6f:6e:27:74:20:79:6f:75:20:74:68:69:6e:6b:20:74:68:61:74:20:45:78:63:65:6c:20:69:73:20:67:72:65:61:74:3f 

Detect adjacent row/column data and merge cells 

This tool detects adjacent cells with the same value and merges those cells into a single 

merged cell using Excel's merge. 

You can choose to: 
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▪ merge cells vertically, per column, merge cells with the same value below it 

▪ merge cells horizontally, per row, merge cells with the same value next to it 

▪ set the alignment 

▪ add borders 

Useful for quick styling of tables for presentation purposes. 

Insert a space before Capital Letters (e.g. 'BigBearLake' > 'Big Bear Lake') 

This tool puts a space in front of Captital letters in the text in your selected cells. 

For example "NewYork" becomes "New York". 

This tool is smart enough to detect when a space should be inserted and when not. 

A space is only inserted before uppercase characters when it is not already preceded by a 

space and also when it is not preceded by any of the following characters: - " ' ( | = ` [ { <  " 

? 

Keep or delete certain Rich Text formatted characters... 

This tool allows you to keep or delete the characters inside the cells in your selection that 

have a certain formatting applied (* Rich text formatting). 

You can choose to either keep or delete bold charters, italic characters, strikethrough 

characters, single underline characters, double underlined characters or normal characters 

within each cell in your selection. 

(* Rich text formatting is a combination of font, font size, font style (for example, bold or 

italic) and underlining formatting in a single cell.) 

Manage duplicated records 

With this utility you can easily remove the duplicated records from your sheet. 

You can also have it remove records from your sheet that already exist on another sheet, 

which can for example be useful if you are working with mailing lists. 

Put all data from the worksheet into one single column 

This tool takes the data in each of the columns on your worksheet and puts this data below 

each other in column A. 

Refresh all external data ranges and PivotTable reports 

This tool refreshes all pivot tables and external data ranges in your entire workbook. 

Remove duplicated values per row in your selection* 

This will remove the duplicated values per row in your selection. 

*Not available in the 32-bits edition of ASAP Utilities for Excel 2000-2007. 

Report pivot table(s) information 

This tool creates a report in a new workbook with information about the pivot tables in 

your workbook. 

The report shows the following information: Sheet, Data Source, Name, DataBodyRange, 
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DataLabelRange, RowRange, ColumnRange, TableRange1, TableRange2, Date last 

refreshed, Refreshed by, RefreshOnFileOpen, Fields in source, Record in source, Fields 

shown, SourceType, SourceDataFile, Connection, CommandText. 

Show indented structure of formula in current cell 

This tool shows the indented structure of your formula.  

This is useful when you have a nested formula. That way you can more easily see if the 

brackets are placed properly. You can also edit the formula. 

Show or hide formatting marks in selected cells 

With this tool you can make spaces, tabs and linebreaks visible. This can be useful because 

sometimes characters such as these mess up your lookup formulas. 

The following characters are used to show these characters: 

? = space 

¬ = tab          

¶ = line breaks 

This tool changes your data when you choose "Show" but you can quickly switch back to 

the original when you choose "Hide". Basically the method is quite simple. It replaces 

spaces, tabs and line-breaks with a unique character. Then the "Hide" option changes these 

special characters back to spaces, tabs or linebreaks again. 

Unfortunately it is not possible to make it work without changing the values like  the 

hide/show formatting marks in MS Word. However we think that this tool is a useful 

alternative. 

Sort each column in selection individually ascending (top to bottom) 

This tool sorts each column in your selection individually from top to bottom. 

Sort each row in selection individually ascending (left to right) 

This tool sorts each row in your selection individually from left to right. 

Text to Columns based on in-cell formatting changes (split by bold, italic, color etc.) 

This tool allows you to split the values inside the cells into separate columns, based on a 

change in the applied formatting (* Rich text formatting). 

It is a similar to Excel's Data > Text to Columns, however in this case the splitting is done 

based on changes in the applied formatting. 

For example, cell with the value "Drum [in bold] Tambour [normal] (f) [italic]" is then split 

into three columns; Bold, Tambour, (f) 

(* Rich text formatting is a combination of font, font size, font style (for example, bold or 

italic) and underlining formatting in a single cell.) 

Transform table into 3 column matrix (reverse pivot table) 

This tool transforms a table into a 3 column table that you can easily use as a source for for 

example a pivot table.  
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Trim leading and trailing line breaks 

This will trim all leading and trailing line break characters in the selected cells. 

Ungroup all grouped columns in the selected worksheets 

This tool ungroups all the grouped columns in the selected worksheets. 

Ungroup all grouped rows in the selected worksheets 

This tool ungroups all the grouped rows in the selected worksheets. 

 

Example screenshot: 01 New tools in development 
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Example screenshot: 02 Bulk replace. Multiple find and replace actions at once 

 

 
 

Example screenshot: 03 Change cells to MAC Address formatting 
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Example screenshot: 04 Detect adjacent row column data and merge cells 

 

 
 

Example screenshot: 05 Insert a space before Capital Letters 
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Example screenshot: 06 Keep or delete certain Rich Text formatted characters 

 
 
Example screenshot: 07 
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Example screenshot: 08 Text to Columns based on in cell formatting changes split by bold 
italic color etc 
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12 Close ASAP Utilities 

Close ASAP Utilities. 

ASAP Utilities will be closed and disappears from the menu bar. 
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13 Show me the time that I saved by using ASAP Utilities 

This tool creates a report in a new workbook with in it which tools you have used, how 

often you used them and how much time this has saved you approximately. (Only 

completely executed tools are counted.) 

You can enter your hourly rate to estimate how much money you have saved. 

You can also use this report to show your colleagues and friends which tools you use the 

most. 
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5.4.20 Find and run a utility... 

Quickly find the utility you need. 

 

With this utility you can search in the names and descriptions of all available tools in 

ASAP Utilities. 

You can also immediately run the utility from the results box or click the ?-button to view 

the details and a screenshot (if available) on our website. 
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5.4.21 Info... 

Information about the tools available in ASAP Utilities, version number etc.. 
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6 Practical Tricks to Save Hours 

in Excel with ASAP Utilities 

6.1 Latest tips on our website 
Discover how ASAP Utilities makes YOU rock in Excel. 

These short tutorials are guaranteed to save you time and speed up your work in Excel: 

https://www.asap-utilities.com/tips.php 

https://www.facebook.com/ASAPUtilities 

6.2 How to... examples 
In this paragraph we show you some of the most asked questions we received either by 

email or found in the newsgroups or online forums, and that can be (or have been) solved 

by using ASAP Utilities. 

Several questions can be similar here and have the same answer. Despite, we still list them 

all because in those cases the problem was described in a different way. 

We would like to use this opportunity to say a big THANK YOU to everybody who is active 

on the Excel newsgroups and forums answering questions; especially those writing how to 

solve problems with the help of ASAP Utilities. 

We think reading this chapter might give you an idea how to solve certain issues with the 

use of ASAP Utilities. 

1 Delete only the even rows in your spreadsheet 

Is there a way I can delete only the even rows in my spreadsheet? 

I have over 6000 rows and I only need the odd ones  

ASAP Utilities » Select » Select cells based on content, formatting and more... 

In the form choose “even rows” then “select”. When selected right-click on a cell in your 

selection and choose “Delete…” and select “Entire row” 

2 Automatically alternate row colors 

How can I set up alternating row colors in Excel? I don't want to have to change the row 

colors every time I insert, delete, or move a row 

ASAP Utilities » Columns & Rows » Color each n’th row or column in selection... 

https://www.asap-utilities.com/tips.php
https://www.facebook.com/ASAPUtilities
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3 Create a hyperlink to each sheet 

ASAP Utilities » Sheets » Create an index page with links to all sheets (clickable)... 

4 Copy a long list of file names 

I have a long list of file names (240 from a search) that I need to put into Excel. Copy won't 

do it.  How now? 

ASAP Utilities » Fill » Create a list of filenames and properties in a folder... 

5 How can I importing a folder of filenames into Excel? 

I would like to download file names from a directory to MS Excel. 

ASAP Utilities » Fill » Create a list of filenames and properties in a folder... 

6 Extract value 

How can I get the numeric value from the cell:  "$4.57 dividend"? 

ASAP Utilities » Text » Advanced character remove or replace... 

Then select all except the numbers and the decimal character, which in this case is a point. 
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7 Removing spaces in cells with data in it 

We have a personnel roster that is kept in a database. Occasionally, this roster is exported 

into Excel and sent out to members of the department. In one column are dates that each 

person was employed. When I try to sort the entire roster, it doesn't come up right because 

most of the cells that contain the date have spaces in front of it. 

Sometimes it is 1 or 2, sometime more, other times there are no spaces. 

In order for me to sort the entire roster correctly, I'm having to manually remove the 

spaces in front of the date, then sort the roster according to date. 

There are over 500 entries in this roster, is there a better way to remove the spaces other 

than manually? 

ASAP Utilities » Text » Delete leading, trailing and excessive spaces 

8 Extracting Text only 

I'm trying to extract text only from a column of cells with varying text and number strings. 

Sometimes the cell starts with numbers, other times text. There is no constant for the 

number at the beginning of the cells. 

ASAP Utilities » Text » Delete all numbers in selection 

or 

ASAP Utilities » Text » Advanced character remove or replace... 

Then select all except the letters. 

9 Strip leading spaces from cell 

I need a formula to remove/delete leading spaces from a cell. Column b contains data 

imported from another application. Unfortunately, some of these cells have padded leading 

blanks added. I need to remove these, but 3000+ cells individually will take hours. 

ASAP Utilities » Text » Delete leading and trailing spaces. 

(note: this will also delete trailing spaces in each cell). 

10 How to make duplicate entries blank 

I want to make a column that lists "city name" to only show each name once, and then 

leave each repeat of the name blank. Is there a formula for this? 

ASAP Utilities » Range » Clear duplicated values in selection (leave one original) 
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11 Printing a Column in Multiple Segments on One Page 

I have a list of names in a spreadsheet column. The data takes up, say, ¼ of the page 

horizontally. Let's say I have 200 names, and want to print them in columns of 50. In other 

words, they should all be able to fit on one page - 1-50 in column 1, etc. I can cut and paste, 

but that's rather labor intensive. I can print 4-up, but that reduces the font size so that it's 

practically invisible. 

Is there anything else I can do? 

ASAP Utilities » Format » The paper saver (split columns) 

12 Trailing negatives imported from ASCII file 

How do I change a column of trailing negatives for example 123- to -123? 

ASAP Utilities » Numbers & Dates » Move minus sign from back to front (e.g. 65- to -65) 

13 Deleting empty rows 

Is there an easy (quick) way of deleting empty rows in a large spreadsheet? 

ASAP Utilities » Columns & Rows » Delete all empty rows 

14 Delete rows if Col C has a 0 value in it 

What formula please will delete rows if Col C has a 0 value in the cell? 

ASAP Utilities » Columns & Rows » Conditional row and column select, hide or delete... 

15 Inserting rows 

I have a spreadsheet that is approx. 200 rows long and I need to insert a new row after each 

existing row. 

ASAP Utilities » Columns & Rows » Insert empty rows or columns in between... 

16 White Space in a Cell 

I 'm collating a lot of spreadsheets that many other people have filled in onto one big 

spreadsheet template. 

My problem is that there is a free text cell and, because people don’t know about the 'alt & 

enter' option, they've hit the space bar many, many times make it look like a new point 

starts on a new line. 
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In Word, you have the option of showing all the keyboard strokes so you can tell what 

people have done - but I'm finding I have to go into each free text cell and hit delete, then 

the cell magically shifts up so that there is no white space. 

Any ideas? My document is currently 200 pages long and I'm nowhere near done! 

ASAP Utilities » Text » Delete leading, trailing and excessive spaces 

17 How do I conditionally delete rows based on cell contents? 

ASAP Utilities » Columns & Rows » Conditional row and column select, hide or delete... 

18 Coloring every other row in a range 

ASAP Utilities » Columns & Rows » Color each n’th row or column in selection... 

19 Removing Carriage Returns in Excel 

To remove only trailing carriage returns: 

ASAP Utilities » Text » Remove ending carriage return (alt+enter character) 

 

To remove all carriage returns (the so called character 10 and 13): 

ASAP Utilities » Text » Advanced character remove or replace... 

Then select the “line breaks” button: 
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20 How to shade every third row? 

ASAP Utilities » Columns & Rows » Color each n’th row or column in selection... 

Choose a color and set the steps to 3. 

 

21 How can I translate a comment to text in a cell? 

You can the function =ASAPGETCOMMENT() to read the comment of a cell. 

Or you can use: 

Objects & Comments » Comment tools... 

And then choose “Extract/report content of comments” 
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22 How to convert Excel imported numbers from text to 

numbers? 

We have a software package from which we can export data to MS Excel.  However, when 

exported it arrives in Excel as text.  Even though they are numbers, they act like text.  The 

only way to convert them text to numbers is to edit the cell (press F2) and hit enter.  I've 

tried every other method of copying and pasting (even pasting special), but nothing seems 

to work.  

ASAP Utilities » Numbers & Dates » Convert unrecognized numbers (text?) to numbers 

23 Sorting Excel worksheets by worksheet title 

ASAP Utilities » Sheets » Sort all sheets... 

24 Beginning zeros won't hold in field when saving as .CSV 

When saving an Excel spreadsheet as a .CSV (comma delimited) file, beginning zeros 

disappear. The only way I know to keep the zeros is to format the field as 'text.'  However, 

.CSV files wipe out all formatting.  Is there a way to KEEP the zero in the number '08' 

instead of '8' when saving as .CSV? 

ASAP Utilities » Export » Export selection or active sheet as new file... 

 

In the “How to export” select “As displayed”, and in the “Format to export” select CSV. 

25 Print multiple sheets in one print job 

I want to print several worksheets (e.g. sheet1, sheet 4, and sheet5) in one print job.  This is 

a frequent task for users of one spreadsheet and would be much more convenient for 

them.  I could probably write a macro to print each sheet individually, but it would be nice 

to print all at one time and have the printer staple them together. 

ASAP Utilities » Sheets » Print multiple sheets at once... 

26 Reverse the sign in a range of cells? 

I have a spreadsheet that is generated from an accounting program. It generates the debits 

as positive numbers and the credits as negative numbers. Is there a way to highlight a 

group of cells and reverse the sign on that group or range? 

There a few ways to do this. You can either multiply all values with -1: 
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ASAP Utilities » Formulas » Apply formula/calculation to selected cells... 

or 

ASAP Utilities » Numbers & Dates » Change negative numbers to positive and vice versa... 

27 Ending spaces need to be removed 

I have exported an SQL database table to a text file and need to do some work on it in 

Excel.  Each field is comma-delimited.  However, the table must have used fixed field 

lengths because the data now has blank spaces at the end of every field.  I want to remove 

the extra spaces. 

ASAP Utilities » Text » Delete leading and trailing spaces. 

(note: this will also delete leading spaces each cell). 

28 Auto-naming of Sheets? 

I have a list of numbers all 8 digits in length (roughly 200 numbers). I need a separate 

worksheet for each number. Is there a way of taking each number, inserting a worksheet 

and naming it according to the number? 

Select the cells with the numbers and then: 

ASAP Utilities » Sheets » Insert multiple sheets (uses the cell values as sheet names)... 

29 Printing question on a long list 

I have a fairly long excel sheet, it's about 800-something rows but there aren't too many 

columns. How can I make it wrap up and print what would normally be 2 pages on to one 

page? The printer settings aren't working right and I’m getting it to be terribly small when I 

try and change those to fit.  Do any of you know how i could do this? I’m pretty sure this is a 

really simple task and I just have never had to use excel for anything this long before or 

cared about manipulating it so that it could be done again. 

ASAP Utilities » Columns & Rows » The paper saver (split columns)... 

30 Mass Remove Hyperlinks 

I want to remove 1200 Hyperlinks, is it possible to do it mass? 

ASAP Utilities » Web » Remove all hyperlinks in selected cells 
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31 Automate naming of tabs 

In Excel 2002 XP I have a workbook with 13 spreadsheets.  I need to automate the naming 

of the tabs on each spreadsheet so that each spreadsheet assumes the name of the 

contents of cell P1 for that respective spreadsheet.  For instance, if the contents of cell P1 

are 1999, the tab needs to be 1999.  If the contents of cell P1 are changed to 2000, I need 

the tab to be 2000. 

ASAP Utilities » Sheets » Change name of selected sheets to selected cell’s value 

32 Leading zero conversion problem 

I have exported data from Outlook 2002 Contacts into an Excel file.  In the export process, 

all the leading zeros in the zip codes have become "'".  For example, a Contacts zip code of 

01075 has become '1075 in Excel. I tried using Excel "Find and Replace" to replace "'" with 

"0", but Excel can't find the "'" in the spreadsheet, although it shows in the cells. 

You can either use the number format “00000” to have the values displayed with leading 

zeros, or use ASAP Utilities to add the zeros: 

ASAP Utilities » Fill » Fill up with leading zeros... 

33 Protecting multiple worksheets easily 

Is there a way to protect worksheets without having to do each one individually? 

ASAP Utilities » Sheets » Print multiple sheets at once... 

34 Sorting Worksheet Tabs 

I really need to sort multiple worksheet tabs within a workbook.  I would like to sort them 

numerically. 

ASAP Utilities » Sheets » Sort all sheets... 

35 Newspaper Columns 

I have a long list of data consisting of three narrow columns.  When I print the sheet, I'd like 

to repeat the set of three columns a few times per page (exactly like a telephone book) to 

prevent wasting paper. 

ASAP Utilities » Columns & Rows » The paper saver (split columns)... 
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36 Changing range of cells to absolute references? 

I am trying to figure out a way to change a table of formulas with multiple cell references to 

absolute cell references.  Does anyone know how to do this without going into each cell 

and editing each one manually? 

ASAP Utilities » Formulas » Change formula reference style (e.g. A1 to $A1 etc.)... 

37 Mainframe download to Excel has minus sign at the end of 

the number 

The report has positive and negative numbers in columns.  The positive amounts do not 

have a sign and are recognized in Excel as number format.  The negative amounts have a "-" 

sign at the end of the number. Excel recognizes these as text format.  Is there an easy way 

to reformat all the amounts with a negative sign to be recognized as number format in 

Excel? 

ASAP Utilities » Numbers & Dates » Move minus sign from back to front (e.g. 65- to -65) 

38 Unhide hidden Sheets 

Is there a way to unhide multiple sheets at one time without code? 

ASAP Utilities » Sheets » Unhide all sheets 

39 Making Cells Absolute 

I have a spreadsheet that has 75 columns with data that is from two other sheets. Stupid 

me when I did the formula I did not make it absolute, so now when I sort it the formulas 

change.  Is there any way I can make the formulas absolute without going into every cell 

and changing? 

ASAP Utilities » Formulas » Change formula reference style (e.g. A1 to $A1 etc.)... 

40 Save selection as jpeg 

I have just bought a mobile phone which allows me to view jpeg images. I would like to 

carry around some information that I have on Excel sheets. Can I convert a sheet or a 

selection on a sheet into a jpeg image? 

ASAP Utilities » Export » Export selected chart or range as image (file)... 
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41 Password protecting multiple sheets 

Is there a way to set a password for multiple sheets without having to set each one 

separately?  I have over 60 sheets in one of my workbooks.  I don't want to protect the 

whole workbook with a password because the file is used by other users but rather lock 

cells in each of the sheets with a password thereby allowing users to only edit certain cells.  

Because I have many packages to do, I don't want to be setting these passwords for over 

600 sheets. 

ASAP Utilities » Sheets » Protect multiple sheets at once... 

42 Reversing a cell 

I need a function that will reverse the data in a cell. For example if the value in a cell A1 is 

"xyzzy", then REV(A1) would be yzzyx. If the value in cell Z19 is "32767" then REV(Z19) 

would be 76723. 
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ASAP Utilities » Text » Reverse text in selected cells 

43 Edit Data - add *1000 to multiple cells, possible? 

I have a set of data and I want to multiply each cell by 1000 so want to add *1000 in about 

30-40 cells together. Is there any way to do it quickly rather than going into each cell 

manually and entering *1000? 

ASAP Utilities » Formulas » Apply formula/calculation to selected cells... 

44 Printing a Price Guide 

I have a price guide of 4 columns with about 6000 rows. In Word, you can specify the file to 

print multiple columns on a page before creating the next page. I have scaled the output to 

65% and would like the 4 column worksheet to print at the top of the next print column 

instead of creating the next page. How would I do this? 

ASAP Utilities » Columns & Rows » The paper saver (split columns)... 

45 Is there a quick way to merge workbooks? 

Is there a quick way to merge workbooks, either by merging open workbooks or by merging 

them before they are opened? 

ASAP Utilities » Import » Merge and/or import multiple files... 

46 Printing Long Columns 

I have a simple worksheet with order numbers in column A and corresponding completion 

dates in column B. Since there are over 1,000 orders, it takes many pages to print the sheet, 

with a great deal of paper wasted on the blank area to the right of the two columns. Other 

than the tedious process of cutting and pasting, is there a way to arrange the information 

into multiple columns across the page? 

ASAP Utilities » Columns & Rows » The paper saver (split columns)... 

47 Converting numbers into text 

I am trying to convert numbers into text. I have tried formatting but it does not work. I am 

importing these excel data into SAS and SAS does not recognize the formatting. I think I 

need a quick way to add an apostrophe in front of all my numbers, how? 

ASAP Utilities » Numbers & Dates » Change values to text values (adding ‘ in front) 
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48 Unhiding work sheets 

Is there any way to unhide multiple worksheets at one time? Currently, I can unhide a 

worksheet by clicking on Format, Sheet and Unhide and then double clicking on the specific 

worksheet. 

ASAP Utilities » Sheets » Unhide all sheets 

49 Is there a function to covert numbers into text? 

Is there a function to convert a number, for example 23, into text, for example twenty-

three? 

ASAP Utilities » Numbers & Dates » Spell/write out numbers or amounts (EN, DE, NL)...  

50 How to remove a macro 

How do I find a macro in a worksheet and then remove it? 

If you want to remove all macros from your workbook: 

ASAP Utilities » File & System » Remove all macros (VBA code) from current file 

51 Printing a list of all named ranges 

Is there a way to print a list of all the named ranges used within a worksheet/workbook 

along with their respective references? 

ASAP Utilities » Information » Create a list of all range names in the workbook 

52 Adding 1 before phone number 

I am looking to add a 1 before all of my long distance phone numbers...but I don't want to 

go through every cell and add 1...is there an easier way?? 

ASAP Utilities » Fill » Insert before and/or after each cell in your selection... 

53 Remove alphabet from a string 

May I know is there any function or any method that I can remove ALPHABET characters 

leaving only NUMERIC value? What I currently doing is that I been using formulas such as 

MID, LEFT & RIGHT to remove the ALPHABET and special characters. This method is indeed 

tedious. I am very curious to know if you have any better method to recommend. 

Example: 
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Invoice Number Result 

IV3F02/49271  30249271 

IES-30600001  30600001 

C31946   31946 

ASAP Utilities » Text » Delete all text characters in selection 

54 Negative sign at right of number acting as text field 

I am importing some numbers into a spreadsheet that have the negative on the right side of 

the number. Any idea on how to get that to be a number instead of a text?  The normal just 

clicking format and changing to currency doesn’t work, because it expects the negative sign 

in front. 

ASAP Utilities » Numbers & Dates » Move minus sign from back to front (e.g. 65- to -65) 

55 Printing wrapped columns 

I'm trying to print 2 columns of data over several columns on one page.  I've seen a few 

similar posts on other newsgroups but have not seen a solution.  Any help would be 

appreciated. 

ASAP Utilities » Columns & Rows » The paper saver (split columns)... 

56 Convert ALL CAPS to lowercase 

Is there a way that I can take an Excel sheet that is entirely in all caps, and with a few steps 

convert all text to lower case with first letter capitalized? 

ASAP Utilities » Text » Change to lowercase 

57 Save a sheet or range as XLS file 

How can I save only the active sheet or my selected range as Excel file? 

ASAP Utilities » Export » Export selection or active sheet as new file... 

58 Show locked cells 

I have an excel sheet with certain values to may not be changed and certain cells that users 

have to fill. However it now appears some of the input cell are also locked. How can I 

quickly see which cells are locked? 
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ASAP Utilities » Select » Select cells based on content, formatting and more... 

Now in the “Based on formatting and more” tab you can choose to select all protected cells 

or all unprotected cells. 

59 Find Duplicates 

I want to check for duplicate values in an array. If a duplicate is found I would like the font 

color changed to red. 

There are two options: 

ASAP Utilities » Range » Count and/or color duplicates in selection... 

This utility has the option to color all duplicates found. 

or 

ASAP Utilities » Select » Select cells based on content, formatting and more... 

Now in the values tab you can choose to select all duplicate values. When selected, you can 

paint them any color you want. 

60 Is There a Way to Print List of Worksheets 

I have a workbook set up with over 100 worksheets, each of which is labeled.  Is there a 

way to print only a list of all the worksheets in the workbook? 

ASAP Utilities » Information » Create a list of all sheet names 

 

You can also create an index sheet that contains a list of all sheet names with a hyperlink to 

the sheet: 

ASAP Utilities » Sheets » Create an index page with links to all sheets (clickable)... 

61 Saved HTML more efficient 

I need to make several Excel tables available as html. When I save them as .html in Excel the 

files get way to big and they contain a lot of inefficient html code. Is there a way or a 

program to create a more efficient (smaller) html output of Excel tables? 

ASAP Utilities » Export » Export selection as HTML table to clipboard... 
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62 Naming Sheet Tabs 

Is there a way to put a formula (or something) in a sheet tab that will enable me to name 

the tabs based on list in one of my worksheets?  Example: In a worksheet, A1=Mary, 

A2=Brett, A3=James.  The sheet tab 1 will be named Mary, sheet tab 2 will be named Brett, 

and sheet tab 3 will be named James?  Also, if I change the names on my list, then the sheet 

tab will auto update with the new entry. 

ASAP Utilities » Sheets » Insert multiple sheets (uses the cell values as sheet names)... 

63 Erase all links in spreadsheet 

I'm looking for a solution to remove all the internal hyperlinks I have in one spreadsheet. 

ASAP Utilities » Web » Remove all hyperlinks in selected cells 

64 Is there an easy way to make cells absolute? 

The only way I currently know how to make a cell absolute is to physically type in the "$" in 

front of the row and column references for the cell.  Is there a formatting tool that will 

allow me to highlight a section of cells that all need to be absolute so I won't have to type in 

"$" for the next 3 hours. 

ASAP Utilities » Formulas » Change formula reference style (e.g. A1 to $A1 etc.)... 

65 Right side negative 

In Excel, how can I convert right side negatives to left side easily? 

ASAP Utilities » Numbers & Dates » Move minus sign from back to front (e.g. 65- to -65) 

66 Function to write amounts. 

Is there a function for excel that writes amounts expressed in letters? I mean, if I have a 

column with $ 22, I’d like to have another column that says Twenty two dollars. 

ASAP Utilities » Numbers & Dates » Spell/write out numbers or amounts (EN, DE, NL)...  

67 Adding a character to every cell in a column 

I have a column of numbers, and I want to add a numeric code to the beginning of each of 

these number strings.   How do I add the same thing to multiple cells at once? 

ASAP Utilities » Fill » Insert before and/or after each cell in your selection... 
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68 Invert a selection 

I have certain cells which have a red background. I can easily find them with the find and 

then format commands. This will highlight only those cells which fit the find criteria, or red. 

Then, I want to invert the selection to find all cells which are not red. 

ASAP Utilities » Select » Select cells based on content, formatting and more... 

Select the based on formatting tab and choose cell color. Then select one of the cells as 

source for example cell D17 if that has the color of the cells you want to select. 

 

 

After you have selected all the red cells this way, you can use the following tool to inverse 

your selection: 

ASAP Utilities » Select » Inverse selection... 

69 Deleting rows with bolded text and numbers 

I have a large worksheet and I want to delete all rows with bolded text and numbers. Is 

there a quick way to do this? 

ASAP Utilities » Select » Select cells based on content, formatting and more... 

Select the “based on formatting and more” tab and choose “font=bold”. 

Then when all the cells with bold text are selected, you can delete the rows by using Excel’s 

Edit » Delete » Entire Row…. 

70 Deleting a Macro from a worksheet 

Somehow I created a macro in a worksheet that I'm working on. It is setup on a control box. 

I deleted the unwanted macro from the sheet, however I'm still prompted to enable macros 
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when opening the work sheet. I can't have this. I entered the VB editor and it’s still listed on 

the worksheet. 

ASAP Utilities » File & System » Remove all macros (VBA code) from current file 

71 Deselecting a cell or column once selected via Ctrl Key 

This happens on a regular basis, as I am Ctrl or Shift selecting a multiple range of cells via 

the Ctrl or Shift click method, I will hit a wrong cell or column or row. I want to deselect this 

selection, but have not found a way to do so. If I attempt to click on the area I just 

incorrectly selected, it highlights it but does not deselect it. 

How do I perform this task of deselecting without starting all over? 

ASAP Utilities » Select » Deselect cells 

72 Unhighlighting a single cell? 

In excel when you hit the ctrl button to highlight various cells you may highlight cells a1, a5 

a9 a13 but then decide you don't want a5 highlighted. How do you unhighlight cell a5 

without having to unhighlight all the others? This is very frustrating especially when you've 

highlighted many cells and then the very last one you don't want highlighted. 

ASAP Utilities » Select » Deselect cells 

73 I need to add the same data to all values in column 

I have a column of data for example the first couple of values in the column are: 3125019 

and 3125021, now this is a long list and I need to add the letters RT to the beginning of each 

value without doing so manually, any ideas? 

ASAP Utilities » Fill » Insert before and/or after each cell in your selection... 

74 Apostrophe’s gone mad 

I'm exporting a bunch of account numbers (all numeric) to Excel. The problem is that all the 

numbers are exported with an apostrophe. I do not need them. Is there any way I can 

remove all apostrophe’s? 

ASAP Utilities » Numbers & Dates » Convert unrecognized numbers (text?) to numbers 
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75 Converting 65- to -65 

Can someone help with a code or formula to convert 65- to -65? For example tailing 

negative sign to be made preceding the number 

ASAP Utilities » Numbers & Dates » Move minus sign from back to front (e.g. 65- to -65) 

76 Formatting PROPER to entire column? 

Is it possible to use the PROPER function to do an entire column instead of taking each cell 

separately? 

ASAP Utilities » Text » Convert to UPPERCASE 

77 Getting to underlying url in a cell 

I have pulled in info from a web table, in column A about 250 records is a named hyperlink 

(i.e. says Google) but the hyperlink is https://www.google.com. I would like to strip away 

the name and leave the hyperlink as the value of the cell. 

ASAP Utilities » Web » Extract hyperlinks 

78 Hyperlink Removal 

I have created a spreadsheet by copying and pasting information (all numerical) from the 

internet. With this copy and paste, hyperlinks also carried over with each of the cells (over 

10,000 cells). My question is this... Is there any way to remove hyperlinks from an entire 

spreadsheet w/o having to right click and remove in each individual cell? Also, is there way 

that I can copy and paste this information w/o also pasting hyperlinks. 

ASAP Utilities » Web » Remove all hyperlinks in selected cells 

79 Activate multiple URL's 

I have a list of many URL's and need to activate them all so that if they are clicked on this 

will link to the web page of interest. If I activate each link one at a time this would take 

forever. Is there a module I could use to activate all the URL's in a list (e.g. using fill down)? 

For example: 

URL 1 

URL 2 

URL 3 

URL 4 
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These cannot be accessed as they are not active hyperlinks. I need a way to convert them 

all into clickable links. 

ASAP Utilities » Web » Activate hyperlinks (create from cell values)... 

80 Absolute Copy/Paste 

If I cut and then paste a block of cells, formulas in the cells retain their reference to specific 

cells. If I Copy and then Paste a block of cells, formulas in the cells change to reference 

relative to the pasted cells. 

 

For example, if I have in cell B2 a formula "=A1" 

If I Cut B2 and Paste it in B3, I have in B3 "=A1" 

If I Copy B2 and Paste it in B3, I have in B3 "=A2" 

Is there any way I can copy and then paste and retain the references to the original cells? I 

know I can change just the formulas, i.e. make the formula "=$A$1" and then copy/paste at 

will, but there are lots of times where this would be problematic. 

Is there a simple way to do this Copy/Absolute Paste? 

ASAP Utilities » Formulas » Copy formulas without changing their cell references... 

81 Replacing blanks at end of text for =vlookup() 

I have a =vlookup() that is failing to find matches. I have two lists with names that appear to 

be matches; for example, "ALL CITY LOCK AND KEY" appears on both lists. The =vlookup() 

does not recognize the cells as the same. Using "if" function to test to see if the values in 

both is equivalent produces a not equivalent result. It appears that the actual values stored 

in the cell in the first list is "ALL CITY LOCK AND KEY", and in the second list "ALL CITY LOCK 

AND KEY ". I'm not sure why the spaces are being stored in this fashion. The data has come 

from a download from a site I do not usually use, and I have not run into this before. 

Is there any way I can loop through both lists and get rid of these recorded blanks after the 

last alpha-numeric value, or in some other way alter the lists to get the =vlookup() to 

function? 

ASAP Utilities » Text » Delete leading and trailing spaces. 

(note: this will also delete trailing spaces in each cell). 
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82 Removing Blank Lines 

I was sent a workbook with a sheet that has about several lines, all numbered 1, 2, 3 ..... 

However there is a blank line between each line. Is there an easy way of DELETING all the 

blank lines rather than highlight each one and delete them? 

ASAP Utilities » Columns & Rows » Remove all empty rows 

83 Add changes to entire column in excel 

I have over 1000 items, all unique with letters / numbers / symbols. What I need to do is 

down one entire column add something as simple as 01- to the front of each one. 

For example, say the column is IDs 

The first cell is h321dsa 

the second is wr2dafw 

etc.. 

Is there a script or some sort of query I can have it go through and modify straight down the 

column placing a 01- in the same cell so when it's done it looks like this: 

The first cell is 01-h321dsa 

the second is 01-wr2dafw 

etc... 

ASAP Utilities » Fill » Insert before and/or after each cell in your selection... 

84 Index of worksheet names? 

I have a workbook with 259 + worksheets. Is there some way that I can consolidate a list of 

the worksheet names in a new worksheet without doing it one-by-one? 

ASAP Utilities » Sheets » Create an index page with links to all sheets (clickable)... 

85 How do I column wrap an Excel printout 

I have 10 pages of 2 skinny columns to print out. 

In MSWord I would just CTRL-A, select the column button, select 2 columns and Wala - now 

I have a 5 page printout. The column on the left of a page continues on the top right of the 

same page - goes to the bottom and THEN starts a new page. 

I want: 

Page 1: Col A&B rows 1 -50 on the left of the page 
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Col A&B rows 51 -100 on the right of the page 

Page 2: Col A&B rows 101 -150 on the left of the page 

Col A&B rows 151 -200 on the right of the page 

etc., etc. 

I'm sorry for the "Column" definition problem between MSWord and Excel - I hope I have 

been able to explain this problem accurately 

ASAP Utilities » Columns & Rows » The paper saver (split columns)... 

86 Fill down 

Column A contains a date every 24 rows and i want it to automatically fill down all the dates 

until it gets to the next date (without overwriting any dates). 

This is what I want to do: 

On column B row 7 I have a date. Further down on column B in row 31 there is another 

date, as there is on B55, B79 etc.... all the way down (about 500). I want to insert the first 

date (the one in B7) into B8. B9. B10...B30. 

I want the date in B31 to automatically fill down to the next date...B54 etc etc 

ASAP Utilities » Fill » Copy values to empty cells below filled cells in selection 

87 Merging Multiple Spreadsheets 

I have 50 spreadsheets from various branches to merge every month. All spreadsheet 

contains the same header fields & number of columns. Instead of cut & paste, is there a 

better way to merge all the spreadsheets into one under one spreadsheet? 

ASAP Utilities » Import » Merge and/or import multiple files... 
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88 Will Excel tell me the number of sheets in a workbook? 

I've got a big workbook, it contains many, many sheets and I have no idea how to get Excel 

to tell me how many sheets there are. It must know. While this seems rather simple the 

only way I can think of working it out is to use the Create index sheet function in 

ASAP Utilities and then count the rows, but there must be an easier way. 

ASAP Utilities » Information » Counter number of sheets 

89 Pasting formulas without transposing 

I would like to know how to copy and paste formulae without changing the formulas (as if 

you were moving cells) and without using $ in every cell. 

ASAP Utilities » Formulas » Copy formulas without changing their cell references... 

90 Merging multiple Excel files into one 

I have hundreds of separate Excel files, each with information in only 'Sheet1'. Each 

file/sheet has the same information in the header (row1) and just one row of information 

below it in row 2. The information that I want to combine in one Excel file stretches from 

column A to column S inclusive. 

I need to create a completely new Excel file that contains one header row and combines the 

hundreds of rows of information below it. 
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Is there a quick and easy way of doing this rather than having to open each one and cut and 

paste into the new file? 

ASAP Utilities » Import » Merge and/or import multiple files... 

91 Adding occasions of Red and Green text 

Can I total a column in which there are two basic colors of text used? For example I want to 

total the number of times a planned date in RED text occurs and then the number of times 

a completed date occurs in GREEN text. 

You can use the following function to do this: 

= ASAPSUMBYFONTCOLOR (range, cell_with_color_to_count) 

For example if one of the cells with a green font is in B2 you can count all these cells by 

entering =ASAPSUMBYFONTCOLOR(A1:G200, B2) 

92 Find duplicates in a column 

How do you select an entire column and find and delete all of the duplicate information 

from all cells? 

To clear all duplicate values (make the cells empty), leaving only one original 

ASAP Utilities » Range » Clear duplicated values in selection (leave one original) 

 

To select all duplicate values: 

ASAP Utilities » Select » Select cells based on content, formatting and more... 

Then in the tab “based on content” select duplicate values 

 

To remove all rows containing duplicate values: 

ASAP Utilities » Columns & Rows » Conditional row and column select, hide or delete... 

Then choose “rows”, “delete” and duplicate values: 
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93 Color every other line 

How can I change the color of a row for 2000 rows? 

For example, row1 white, row2 grey, row3 white, row4 grey, row5 white, etc. 

ASAP Utilities » Columns & Rows » Color each n’th column or row 

94 Simple macro to import ALL xls files in dir into 1 workbook? 

I need a simple macro that will take ALL files in any directory that I point to and import 

them all into one workbook. 

ASAP Utilities » Import » Merge and/or import multiple files... 

95 Remove non value 

I need to remove these squares from numbers. The squares are in column D and E before 

and after some numbers and sometimes between the numbers where ever there is space 

between the numbers as in D6, 7, 9 and 11 

ASAP Utilities » Text » Advanced character remove or replace... 

96 Dropping Text 

Is there anyway that I can drop text within cells. For example column D has 120 cells all with 

different amount a characters but I want the column to show only the first 6 and drop the 

rest. 

ASAP Utilities » Text » Delete all after n’th character 
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97 How to identify repeated values and delete them? 

I have a sheet containing a lot of names. There are some names that are repeated. My 

question is simple: how can I delete repeated values automatically? 

 

To clear all duplicate values (make the cells empty), leaving only one original 

ASAP Utilities » Range » Clear duplicated values in selection (leave one original) 

 

To remove all rows containing duplicate values: 

ASAP Utilities » Columns & Rows » Conditional row and column select, hide or delete... 

Then choose “rows”, “delete” and duplicate values: 

98 Excel will not recognize imported numeric data 

The data was imported from an Access database (I believe), and put in columns at the end 

of the spread sheet. Excel doesn't seem to recognize the imported data, e.g. formulas won't 

recognize the data, and nothing happens when I change the format for the imported 

columns. It's only when I retype the data in an imported cell that Excel recognizes it. 

ASAP Utilities » Numbers & Dates » Convert unrecognized numbers (text?) to numbers 

99 Inserting an empty row after each row 

I have a table with several rows. How would I insert an empty row after each one row? 

So if I have: 

 

A 

B 

C 

D 

E 

F 

G 

I want to have: 

A 

 

B 

 

C 
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D 

 

E 

 

F 

 

G 

ASAP Utilities » Columns & Rows » Insert empty rows or columns in between... 

100 How can I mass-insert $ signs into a series of formulas? 

I have a spreadsheet with a several thousand cells with formulas I'd like to convert to 

absolute cell references. Some of the formulas already have $ signs in them, but what I 

have in mind is the same as when you're creating a formula one-by-one - when effectively 

by using F4 you can toggle the $ on, partially on or off. 

Rather than go through each formula separately, is there a simple way of 'mass' converting 

them? 

ASAP Utilities » Formulas » Change formula reference style (e.g. A1 to $A1 etc.)... 

101 Protecting and unprotecting each worksheet separately= 

PAIN! 

My workbook has 7 different sheets in it. Basically I have password protection to even 

opening the file, plus I protected each sheet individually with a password. But the problem 

I'm having is that each of the 7 sheets needs to be updated in some way periodically, and I 

don’t want to have to go to each sheet individually, unprotect it, type in the password, 

update the info, re-protect it, go to the next sheet, unprotect it, type in the password, 

update info, re-protect it, etc. I basically want someone to have either full access to the 

whole workbook and all the sheets by using one password, or else have no access at all 

(read only). 

I've put a password in so that it's required in order to modify anything in the workbook, but 

this only works if each sheet is protected. Is there any way to unprotect ALL sheets at the 

same time, and then re-protect them all at once? It's a pain to unprotect and protect each 

sheet over and over again. 

ASAP Utilities » Sheets » Protect multiple sheets at once... 

 

ASAP Utilities » Sheets » Unprotect all sheets 
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102 Huge Problem with blank spaces 

I have a workbook that I use for employee names and other data. All names are in the same 

column on every sheet and the last name is on the same row for every sheet. The problem 

is that I have 2 spaces between first and last name and need only one space. Would 

someone please tell me how to remove that one space? It is causing a lot of grief. 

 

An example would be: 

John  Doe (2 spaces between John and Doe) 

I need it to look like: 

John Doe (1 space between John and Doe) 

If it is always two spaces you can perform a simple search & replace in Excel. Search for for 

two spaces and replace them with one. Another approach which will also works if there are 

three or more spaces is: 

ASAP Utilities » Text » Delete leading, trailing and excessive spaces 

This will replace repetitive spaces to one and also removes all spaces at the beginning and 

the end of your values. 

103 Deleting hyperlinks and removing spaces 

I have 2 questions.  

Question 1: Is there a way to delete all hyperlinks on a worksheet without having to 

manually remove each one individually? 

Question 2: I have a column (A) that has names in it. However before the first name there 

are two blank spaces in front of each name. I would like to remove those two blank spaces 

so the name aligns to the left. I tried the align function but that doesn't work. How can I 

remove these blank spaces before the name? 

This can be often the result when you copy information from your internet-browser into 

Excel. 

ASAP Utilities » Web » Clean data and formatting... 
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104 Copy-paste multiple formulae without changing cell 

references 

I have multiple cells with formulas in them, which I want to copy to elsewhere in the same 

spreadsheet (about 20 rows below their current position). I would like to do this without 

changing any of the cell references; however none of the cell references are currently 

absolute. 

Is there any way of having excel automatically change all cell references from relative to 

absolute? (i would use find-replace, but all of the cell references are different, so it 

wouldn't work). 

ASAP Utilities » Formulas » Change formula reference style (e.g. A1 to $A1 etc.)... 

If not, is there any other way of moving the formulas without changing the cell references? 

ASAP Utilities » Formulas » Copy formulas without changing their cell references... 

105 Moving the "end" cell - Ctrl+End 

This has me stumped. How does one "move" a current end cell in Excel? 

 

Meaning if I have a something in G22 and D13, and then delete G22, whenever you go 

Ctrl+End it always ends up at G22 not D13 or if I have the "last" closest thing on say G10 or 

B22, etc. 

I tried deleting the whole row or column, but always end up at the "new" G22. 

Saving the workbook in most cases resets the last cell. Otherwise: 

ASAP Utilities » Sheets » Reset Excel’s last cell 
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By default this can be started with the shortcut Ctrl+Alt+R in ASAP Utilities. 

106 Putting Sheet Name in a cell 

I am creating multiple new sheets from names in a selected range of cells using 

ASAP Utilities. I then want to go into each sheet and use the sheet name and place it in the 

sheet itself. Is there a way to do this? 

ASAP Utilities » Sheets » Insert sheet(s) name in selected cell(s) 

 

107 Funny squares! 

Has anyone ever noticed that when you export data from databases (e.g. Lotus Approach), 

and open them using Excel, you get lots of little annoying squares in some of the cells. 

I was wondering if anyone had any top tips or tricks for getting rid of them? 

ASAP Utilities » Text » Advanced character remove or replace... 

108 De-selecting cells 

Can you please tell me how to DE-select a cell when I have already selected several cells 

and then selected a cell on accident? I would like to de-select that cell without de-selecting 

all of the selected cells. 

ASAP Utilities » Select » Deselect cells 

By default this can be started with the shortcut Ctrl+Alt+D in ASAP Utilities. 

109 Link to charts within spreadsheet 

I have a spreadsheet with a data worksheet and 30 charts I have built from the data, all on 

separate tabs. How do I hyperlink from some text in my data worksheet to the associated 

chart? Confused I don't know how to reference these charts. 

ASAP Utilities » Sheets » Create an index page with links to all sheets (clickable)... 
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110 Hiding error messages 

I need to work on a large spreadsheet that someone else put together of sales figures for 

the coming year. As the spreadsheet doesn't yet have many values, there are a lot of error 

messages where there are formulas, such as #DIV/0!, as a result the spreadsheet looks very 

messy. 

When I do a spreadsheet like this I generally use the following: 

=IF(ISERROR(formula), " ", (formula)) 

This works great, however, I need to clean up this spreadsheet that I received, and I am not 

relishing the idea of going into every single formula in it and inserting this wording. Is there 

any way of doing this sort of thing for the whole spreadsheet, instead of one cell at a time? 

Unfortunately, the formulas are all different (=sum, =vlookup =if =count). 

ASAP Utilities » ASAP Utilities » Formulas » Custom formula error message... 

111 Converting email address text to HTML Links 

I need to know how to take a column of email addresses and make them clickable. 

Currently, the addresses are static and I have to go through one by one and make them a 

live link. 

ASAP Utilities » Web » Activate hyperlinks (create from cell values)... 

112 Fill blank cells with previous cell data 

I have a spreadsheet that was populated with exported data. I have some cells with the 

correct data in them that needs to be filled with the previous cells data unless the cell is 

already filled. For example I have a cell populated with "a", I want that data copied to all 

cells below it, until the cell it encounters a cell that is already filled. 

ASAP Utilities » Fill » Copy values to empty cells below filled cells in selection 

113 Remove Drawing Objects 

Can anyone tell me how to remove ALL drawing object & pictures in a spreadsheet, without 

having to click each one & hit "delete". 

ASAP Utilities » Objects & Comments » Delete all objects in selected worksheets 

114 Multiple range copy 

Is there a way in Excel to copy multiple ranges? In other words, can you select non adjacent 

cells or ranges and then copy & paste them? 
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ASAP Utilities » Range » Copy multiple selected ranges... 

115 Removing leading Zero 

How do I remove the leading zero from lots of rows of numbers? 

For example: 

046534765 

046573737 

046533333 

065438373 

ASAP Utilities » Numbers & Dates » Convert unrecognized numbers (text?) to numbers 

116 Page borders in Excel 

I'm trying to make page borders print for a multiple page Excel sheet with changing 

information. Actually, the left-right borders don't change, and I can make a top border 

using the Repeat Rows at Top in Page Setup. So I just need the bottom border. 

 

A search turned up the idea of using the underline key in the footer. This looks like a 

horrible way to do it. For one thing, it doesn't create a continuous page border around the 

lower corners. Is there a way to do this using conditional formatting? Or is a macro 

necessary? 

ASAP Utilities » Format » Place a border around each page 

If your data or your page layout changes you have to re-run it. 

117 Converting numbers (such as $100) into words 

I often use excel to print invoices and would like to put a formula that converts numbers to 

words, such as: "100" converted into "one hundred". 

Example: Invoice Value $100, Value in words One hundred only. 

ASAP Utilities » Numbers & Dates » Spell/write out numbers or amounts (EN, DE, NL)... 

118 Copy Print Settings? 

Is there a way to copy print settings over from one worksheet to another? 

ASAP Utilities » Format » Copy a sheet’s page and print settings... 
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119 Randomize columns 

I have many columns of data. The records are sorted on the basis of column U. 

I want to randomize them on the basis of column U. I don't want ascending records. 

ASAP Utilities » Range » Sort the data in random order 

120 Excel: How to merge info from column A & B into column C 

How do I, for example, take the info in cell A2, B2, C2, D2 and merge it together in A1? 

There are manual steps with formulas to accomplish this. Another approach is: 

ASAP Utilities » Columns & Rows » Merge column data (join cells)... 

121 Identical cells 

Could someone tell me the easiest way to find identical numbers or text in a column? I have 

3000 cells in a column, the majority of which contain different numbers, but I want to find if 

there are any that contain the same number. I can't just use a custom filter because I'm 

never looking for one number in particular, just any identical. 

There are two options: 

ASAP Utilities » Range » Count and/or color duplicates in selection... 

This utility will tell you how many duplicate values there are and has the option to color all 

duplicates. 

or 

ASAP Utilities » Select » Select cells based on content, formatting and more... 

Now in the values tab you can choose to select all duplicate values. When selected you can 

color them any color you want. 

122 Converting DD/MM/YYYY to MM/DD/YYYY 

I have a column of dates and Excel doesn’t recognize them as dates: 

01/02/2003 

01/03/2003 

01/04/2003 

01/05/2003 etc 

 

Which should be : 

02/01/2003 
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03/01/2003 

04/01/2003 

05/01/2003 etc 

ASAP Utilities » Numbers & Dates » Convert/recognize dates... 

 

123 Unwanted Macros 

A file I copy annually to update for the current year has various macros. When I start the 

new year I delete the macros to avoid confusion but each time I open the new file I am still 

asked if I want to enable macros. How can this be when there are no macros listed and how 

can I get rid of the message? 

ASAP Utilities » File & System » Remove all macros (VBA code) from current file 

124 Deleting hidden Columns 

I have a file that generates 80+ report pages which are carved out & a ranged value copy is 

sent out for reporting. 

There are several different views I have to use - so there are lots of columns hidden & 

unhidden - The columns are not adjacent. To make the report small enough to email - got 

to delete the hidden cols. 

ASAP Utilities » Columns & Rows » Delete all hidden rows and/or columns... 

To see which columns and rows are hidden: 

ASAP Utilities » Columns & Rows » View and manage hidden rows and columns… 
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125 120 CSV files need to be pulled to 1 sheet 

I receive e-mails from a customer that each have 1 CSV file attached. To date I have 120 

received. I am looking for an easy way to save all the attachments and then open them all 

and copy them to a single sheet. The columns are always the same and there will never be 

any blank lines until the last row but the number of lines varies with each one. 

ASAP Utilities  

ASAP Utilities » Import » Merge and/or import multiple files... 

126 Parsing multiple sheets into one 

Hello, I was curious if there is a way, I can take a workbook containing multiple sheets, and 

parse them into one single file. Really doesn’t matter the format of the file, I can do 

another conversion on that. The reason I ask is I have a workbook, with like 600 separate 

pages in it. And it needs to be reduced to one output file, for importing into a DB. 

ASAP Utilities » Sheets » Put together rows or columns from several sheets... 

For the export: 

ASAP Utilities » Export » Export selection or active sheet as new file... 

Or first export the worksheet as separate files and then merge them together into one long 

worksheet with the data below: 

ASAP Utilities » Export » Export worksheets as separate files... 

 

ASAP Utilities » Import » Merge and/or import multiple files... 
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7 Troubleshooting FAQ 
In case you have any questions or face a problem then please first consult the Questions 

and Answers section on our website as we may have answered your question already: 

https://www.asap-utilities.com/faq.php 

 

For questions regarding ASAP Utilities or feedback, please contact us at: 

support@asap-utilities.com 

https://www.asap-utilities.com/contact.php 

 

Keep your question ASAP Utilities related 

We are willing to help you, but we do not answer general Excel questions. We simply don't 

have the time to. On our website we have several links to other resources where you most 

likely will find the answer or can ask the question. Excel is being used by millions of people 

for more than two decades. Keep in mind that most likely you are not the first one facing 

the problem you are facing. On the internet there are many websites where people share 

their Excel related problems and solutions. 

https://www.asap-utilities.com/links.php 

7.1 Priority support for customers 
If you are a registered customer then please include your order number, for a fast-track 

(priority) response. 

You'll find your order number the email you received after the purchase. 

You can also find your order details in the Excel menu: ASAP Utilities » Registered version. 

7.2 Bug report guidelines 

7.2.1 The basics: what you did, what you wanted, and what 

happened. 

Those are the three basic elements of a bug report. You need to tell us exactly what you did 

(for example, "ASAP Utilities » Range » Clear duplicated values in selection (leave one 

original)"), what you expected to have happen (to continue the example, "I expected to 

have all duplicates removed"), and what actually happened ("it selected the duplicate cells 

but didn’t remove them."). 

Yes, the example is silly. But if your bug report simply said "the duplicates function doesn't 

work," we wouldn't be able to know whether you used this tool or the Select » Select cells 

https://www.asap-utilities.com/faq.php
mailto:support@asap-utilities.com
https://www.asap-utilities.com/contact.php
https://www.asap-utilities.com/links.php
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based on content, formatting and more... tool, or the information » count duplicates tool. 

By telling us what you asked for, what you expected to get, and what you actually got, we 

don't have to guess. 

7.2.2 Excel and windows version 

When you report a bug please include information about the Excel and windows version 

you are using. To make this easier for you can go to: 

ASAP Utilities » ASAP Utilities Options » Settings, language and contact information… 

Then go to the tab “Contact information” and copy the information there in your email: 

 

7.2.3 Always search our website and documentation first 

Advice so good, we'll repeat it twice. Always search our website and documentation first. 

ASAP Utilities is used by a lot of users. The odds are good that if you've found a problem, 

someone else has found it, too. If you spend a few minutes of your time making sure that 

you're not filing a duplicate bug, that's a few more minutes someone can spend helping to 

fix that bug rather than sorting out duplicate bug reports. 
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7.2.4 Be brief, but don't leave any important details out 

This is a fine line to walk. But there are some general guidelines: 

Remember the three basics: what you did, what you expected to happen, and what 

happened.  

When you provide a workbook that demonstrates the problem, make sure it is small and 

remove information that is not subject to the problem. Otherwise it just contains a lot of 

information that has nothing to do with the problem, which just makes it take longer to 

figure out the real problem. (But don't forget to make sure that your workbook still 

demonstrates the bug you're reporting and doesn't have some other problem because 

you've accidentally removed something you thought wasn't important but was!) 

7.2.5 Use meaningful, specific subject headers 

A good convention for subject headers, used by many tech support organizations, is “object 

- deviation”. The “object” part specifies what thing or group of things is having a problem, 

and the “deviation” part describes the deviation from expected behavior. 

Bad:  I get an error 

Good: The tool “Create an index page with links to all sheets (clickable)” returns an error. I 

have attached a screenshot of the error and an example workbook to reproduce it 

with. 

7.2.6 Please use English or Dutch (if possible) 

Yes, the ASAP Utilities users are global and include a great many people who can speak a 

great many languages. But if you were to report a bug in a language other than English or 

Dutch we would probably not be able to help you. 

If you're worried about your English skills making it difficult to describe the bug, you might 

try asking the help a colleague or friend or provide a good example with some screenshots. 

Online translation tools such as Google Translate can also be of assistance. 

7.2.7 Don't report bugs about old versions. 

Every time a new version of ASAP Utilities is released many improvements are made. 

If you're not using the most recent version ASAP Utilities, you should upgrade to the latest 

version to make sure the bug you are experiencing still exists. 

You can see which version you have in the info screen. In the Excel menu go to: 

ASAP Utilities » Info 
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8 About ASAP Utilities 

8.1 History of ASAP Utilities 
ASAP Utilities is a powerful Excel add-in that adds new functionality to Microsoft Excel to 

save time and speed up your work. 

Since 1999 it has grown to become probably one of the world's most popular addition for 

Microsoft Excel. 

Time saving - speed up your work in Excel 

ASAP Utilities is the product of many time-saving features and additions for Excel. 

The extensive features are the result of years of experience and development, combined 

with the feedback from many respected users at different levels of experience. Particularly 

the feedback from users has been very important and will continue to be important in 

further development. 

ASAP = As Soon As Possible 

ASAP Utilities is called this way because it significantly reduces time-consuming work. ASAP 

is an acronym stat stands for "As Soon As Possible". Some choose to spell it out, others tend 

to pronounce it "aysap". The word “utilities” means something useful. Combined 

ASAP Utilities stands for useful time-saving macro tools for Excel. 

Most people struggle with managers, bosses or clients that tend to ask for you to get the 

job done yesterday, which of course is often difficult to pull off. ASAP Utilities doesn't allow 

you to travel back in time, but it can certainly help you to speed up your work in Excel. 

Constant improvement 

Since its first release in 1999, ASAP Utilities has been improved and extended with many 

new features and a friendly interface. It is under constant development, so new features 

and improvements are being added all the time. The first year I put the program on the 

internet, nearly every month a new version was released. Nowadays a new version is 

released at least twice a year. The input we get from users all over the world is a great 

stimulation for us to make it a better product every time. 

Time saving 

On average ASAP Utilities saves people 32 hours each year (measured among 142,522 users 

in March 2022). 

We have made it easy to see how many hours you saved with ASAP Utilities. Via 

“ASAP Utilities » ASAP Utilities Options » Show me the time that I saved by using 

ASAP Utilities”, you can create a report which you can use for example to calculate the 

Return on Investment or show it when you need to ask someone to approve the purchase. 



ASAP Utilities User Guide FREQUENTLY UPDATED 

 

326 Chapter 8 

 

 

Help by offering a free edition 

By offering a free version of ASAP Utilities (already since 1999) we want to contribute to 

society. 

The ASAP Utilities 'Home and Student' edition is free and is (only) for non-commercial use, 

such as home projects, schoolwork and use by charitable/non-profit organizations such as 

the International Committee of the Red Cross, UNICEF, Amnesty International, 

MSF/Doctors Without Borders etc.. 

Companies and governments however should buy a license. (They can try it for 90 days). 

Especially with providing it for free to students and charitable organizations, we hope to 

contribute to a brighter future. 

A must in every Office 

In my humble opinion I believe ASAP Utilities is a must in every office. We use it ourselves 

on a daily basis, and it saves us an incredible amount of time. On our website we have listed 

some reviews from independent magazines and websites about ASAP Utilities. 

I am proud to mention that ASAP Utilities is used worldwide in over 170 different countries 

by 750,000+ users and 23,500+ organizations. 

 

Kind regards, 

Bastien Mensink 

(author of ASAP Utilities) 

8.2 The primary goals of ASAP Utilities 
These are the main goals we try to accomplish: 

▪ Automate your work in Excel. 

▪ Perform tasks that otherwise would not be possible in Excel. 

▪ Merge several steps into one. 

▪ Reduce manual input of data. 

▪ Easy to operate with an intuitive and user-friendly interface 

 

The bottom line: 

▪ Make life easier for Excel users, both novice and expert 

▪ Save time 

 

We make you the company's Excel guru! 
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8.3 Testimonials 

8.3.1 Here's what our users say 

Our users and clients are often kind enough to share some feedback on ASAP Utilities. 

We're proud and happy that, ever since its first release in 1999, we can help Excel users all 

over the world. 

8.3.2 Enthusiasm and 5 star rating 

We're proud to see that all over the world people are enthusiastic about ASAP Utilities. 

See the feedback from users on our Trustpilot, Twitter, LinkedIn, or Facebook fan page, our 

blog, view the reviews from magazines, websites, radio shows and newspapers or just 

google for ASAP Utilities reviews. 

ASAP Utilities is rated 4.9 out of 5 based on over 2,500 reviews on Trustpilot: 

https://www.trustpilot.com/review/asap-utilities.com 

 

 

 

  

https://www.trustpilot.com/review/asap-utilities.com
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Below is a screenshot of a few of our reviews on Trustpilot: 

 

 

We strive to continuously improve and every review helps us to provide a better 

experience. For 23 years already we do everything possible to help our users and use their 

feedback to further improve ASAP Utilities.. 

We really want to help you and provide you with the best and most user-friendly add-in for 

Excel! 
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8.3.3  A small selection of the feedback we received in the 

past 22 years 

▪  Thank you for your message. I have downloaded the New version, in French !! I 

appreciate it very much and recommended it to my friends because you deserve it. 

These utilities are very well thought, useful and the service excellent.  

▪  Thanks, Bastien. ASAP rocks.  

▪  I absolutely LOVE ASAP utilities and it has allowed me to create some really functional 

spreadsheets in excel that look great, too! Thank you!  

▪  Just to let you know. I absolutely love this program. It is great.  

▪  Thanks for a wonderful tool that helps when I am stuck.  

▪  A terrific set of utilities! I think that they are invaluable.  

▪  Thanks for your quick support…..as I simply cannot do my work without ASAP Utilities 

every single day :-)  

▪  I just downloaded the ASAP utilities and find them to be very helpful.  

▪  You’re a genius!!  

▪  Good Morning. I purchased and have been using your ASAP Utilities. It is an excellent 

product.  

▪  Our research director has already fallen in love with ASAP.  

▪  You are the BEST!!! I wish other software companies were as easy to work with as you 

guys!!!!  

▪  Came across ASAP in 2007 while needing an Excel Solution - it was love at first sight!  

▪  I have been using the free version of ASAP utilities for at least the last five years, and 

probably longer. I have admired it as the best single utility I have ever run across in 25 

years of using computers.  

▪  Please allow me to say thank you for your fabulous product. I am indebted to you. 

Thanks very much!  

▪  ASAP Utilities is one of the best products I’ve ever utilized when working in Excel. Keep 

up the good work – this is an amazing product that I will find hard to live without…  

▪  A huge thank you for making my life easier with your great product.  

▪  Fantastic, you guys have thought of everything. Your response to emails is unmatched. 

Thank you so much.  

▪  Hi Guys, Continue like this, without You, excel will be much poorer.  

▪  Please know that I greatly admire you and your hard work over the years. I don't know 

exactly when I started using ASAP Utilities. My guess is that it was about 2005 or before, 

but I've been a faithful user and evangelist for you for years. Since I had benefitted so 

much from your hard work, I did register several years ago (don't quite remember when). 

I will continue to let folks know the benefits of ASAP Utilities and encourage them to 

register.  

▪  Hi Bastien - every time I download the upgrades, I remind myself how grateful I am for 

this utility. It's fantastic and makes my life less complicated. It has done miracles for work 

performance even though I'm still on Excel '97. Thanks for your hard work.  

▪  Thank you for a brilliant piece of software.  

▪  My Thanks again for a great Utility & for your personal response (sincerely appreciated).  
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▪  I love this tool. I use it every day!  

▪  First, I want to congratulate ASAP Group for this great idea! Although I recently acquired 

the software, it has done a huge amount of work for me and save a lot of time. I have 

recommended the software to my colleagues and my partners at my master degree 

program here in Colombia.  

▪  Thanks for your quick reply. I use the utility at home (and have for a number of years). 

Our company does not usually allow outside software to be loaded to the company pcs, 

but I can see a real cost savings to our Project Management group, so I will begin 

discussions about perhaps purchasing licenses. Thank you for your help.  

▪  Thanks! ASAP Utilities is a very nice add-on.  

▪  I just wanted to say thank you for ASAP Utilities. I am not an Excel expert, just an 

administrator with very basic knowledge and skills. I am not allowed to download your 

product at work so spent the whole afternoon trying to solve how to sort a column of 

dates by month. Searching the internet didn’t help either. I thought I’d try again at home 

on my laptop where I have your brilliant product and within a minute my list was sorted. 

I wasn’t at all surprised … you have helped me out on more than one occasion! This is 

truly one of the best things you will find on the internet. Thanks again  

▪  Thanks again. Your product is wonderful  

▪  I have found ASAP to be useful over the past few years and thank you for this excellent 

addition to EXCEL  

▪  Thank you for replying so fast and solving the problem. I will suggest even more friends 

to use this wonderful utility in excel and purchase it for using officially.  

▪  ASAP utilities is a lifesaver. I really enjoy its functionality, and regularly use a half dozen 

or so of its functions- especially the text functions such as change case, combine cell 

contents or remove extra spaces. Great job.  

▪  Thank you very much for this utility. It is a lifesaver.  

▪  I find the ASAP utilities very useful, although only use a fraction of them. Keep up the 

good work.  

▪  As always, I continue to be impressed with your program. Thanks for making it available!  

▪  Hello – I really enjoy using ASAP utilities every day. It saves me lots of time and that 

makes me happy!  

▪  Thanks so much for this program -- it is a wonderful tool!  

▪  I have loved using ASAP with excel for years and would be lost without it….Thanks and 

keep up the good work.  

▪  Thanks for your time. I truly appreciate your wonderful product!!!  

▪  Thanks again, and I have to say your program is so critical to my day-to-day worksheet 

activities and I can’t praise it enough!  

▪  I would just like to say that the ASAP Utilities are simply amazing and I would like to 

congratulate you on the wonderful work.  

▪  In honour of the 2010 Olympics, you deserve a GOLD MEDAL for this ;)  

▪  What a GREAT product. I would be totally lost without it.  

▪  I have bought the first ASAP about three years ago, and really, THANKS!.  

▪  I love the program what a great tool. It is a great time saver.  

▪  I have recommended your program to several of my co-workers and wish you much 

success with your business.  
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▪  I have been using the ASAP Utility for the last three years and found it to be very useful 

and thanx for the same.  

▪  Your utilities have saved me a lot of time. I have just purchased a license.  

▪  Thanks again for your time and PS. I'm a huge fan of the product!  

▪  I'm very pleased with your product and find it very helpful, even though I only use a small 

amount of its capabilities.  

▪  That was it! Thanks for your patience. By the way, love the product.  

▪ I will tell you something, the ASAP utilities are just great. I have been using them for 

many years... since they were free...hehe... My job involves TONS of time on Excel, and 

ASAP is an incredible time and effort saver. You also have an outstanding record of 

continuous development and improvement, always releasing updates. Thanks a lot for 

your work!!! 

 

8.4 Our clients, who uses ASAP Utilities? 
ASAP Utilities exists since 1999 and is used in a variety of organizations.  

Our list of clients exceeds 23,500+ organizations in more than 140 countries worldwide. 

The list below shows a few organizations that purchased ASAP Utilities. 

We're very proud to have these organizations among our clients: 

 

# 

▪ 20th Century Fox 

▪ 3M Company 

▪ 7-Eleven  

A 

▪ A.T. Kearney 

▪ Abbott Laboratories 

▪ Accenture 

▪ ACCO Brands 

▪ Accor 

▪ Adobe 

▪ ADP 

▪ Aegon Bank 

▪ Aer Lingus 

▪ Aero Inventory UK Ltd 

▪ Aetna 

▪ Agfa Corporation 

▪ Agilent Technologies 

▪ Ahoy Rotterdam NV 

▪ Air Products & Chemicals 

▪ Airgas 

▪ AkzoNobel Coatings 

▪ Alcoa 

▪ Alliant Energy 

▪ Allied Wate Industries Inc 

▪ Alpha Natural Resources 

▪ Altron Management 

Services 

▪ Amazon.com Services, Inc. 

▪ Ameren 

▪ American Electric Power 

▪ American Express 

▪ American International 

Group 

▪ Amerigroup 

▪ Ametek 

▪ AMN Healthcare, Inc. 

▪ AMNESTY INTERNATIONAL 

▪ Amo Plans 

▪ Anadarko Petroleum 

▪ Analysis Group 

▪ Aol 

▪ Aon Hewitt Limited 

▪ Applera 

▪ Applied Industrial 

Technologies 

▪ Aramark 

▪ ArcelorMittal 

▪ Arizona State University 

▪ Ashland 

▪ AT&T 

▪ Atlas Pipeline 

▪ Atletiekunie 

▪ Atos Origin 

▪ Australian Department of 

Business & Employment 

▪ Australian Department of 

Treasury and Finance 

▪ Australian Dept of Business 

& Innovation 

▪ Autodesk 

▪ Autoliv 

▪ AutoTrader.Com 

▪ Avery Dennison 

▪ Avnet 

▪ AXA Financial 

B 

▪ Bain & Company, Inc. 

▪ Baker & McKenzie 

▪ Baker Hughes 

▪ BANK OF AMERICA 

▪ BASF 

▪ Bausch and Lomb 

▪ Bayer CropScience Ltd 

▪ Bayer MaterialScience 

▪ Beckman Coulter 

▪ Belden 

▪ BELL HELICOPTER AIRPORT 

CENTER 

▪ Bentley Systems, Inc. 

▪ BEPCO, L.P. 
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▪ Best Western International 

▪ Beverly Hills Police 

▪ Bharat Heavy Electricals Ltd 

▪ BHPBilliton 

▪ Biomet 

▪ BKD, LLP 

▪ Blizzard Entertainment 

▪ BNP Paribas 

▪ BOEING 

▪ Boston Scientific 

▪ Boston University 

▪ BP America 

▪ Braun GmbH 

▪ Bridgestone Bandag Tire 

Solutions 

▪ British Airways 

▪ Broadcom  

C 

▪ Canon U.S.A., Inc. 

▪ Cardinal Health 

▪ Cargill 

▪ Carglass NV 

▪ Carl Zeiss Vision 

▪ CARQUEST CANADA LTD. 

▪ Cascade Aerospace 

▪ CASH AMERICA 

▪ Caterpillar 

▪ CBL & Associates 

▪ CenterPoint Energy 

▪ Central States Pension 

Fund 

▪ Cenveo 

▪ Cephalon 

▪ CH2M Hill 

▪ Charles Darwin University 

▪ Chevron 

▪ Chiquita Brands 

International 

▪ Christchurch City Council 

▪ CHS 

▪ CIBER 

▪ CIRQUE DU SOLEIL 

▪ Cisco Systems 

▪ Citrix Online 

▪ City of Fresno 

▪ CITY OF HENDERSON 

▪ City of Seattle 

▪ CITY OF TORONTO, Toronto 

Fire Services 

▪ Clear Channel 

Communications 

▪ Clorox 

▪ Coca-Cola 

▪ Colgate-Palmolive 

▪ Comcast 

▪ ConAgra Foods 

▪ ConocoPhillips 

▪ Consol Energy 

▪ Constellation Brands 

▪ Convergys 

▪ Corus Staal B.V. 

▪ Covance 

▪ Crane Group Limited 

▪ Critical Care Systems 

▪ CROSSMARK 

▪ Crosstex Energy 

▪ CSC 

▪ Cummins 

▪ CVS Caremark  

D 

▪ DAF Trucks N.V. 

▪ Deere & Co 

▪ Dell 

▪ Deloitte & Touche M.E. 

▪ Deutsche Lufthansa AG 

▪ Del Monte 

▪ DHL Worldwide Express 

▪ Dick's Sporting Goods 

▪ Dimension Data 

▪ Disney Consumer Products 

▪ Dollar General 

▪ Dorsey & Whitney LLP 

▪ Dover 

▪ Dow Chemical 

▪ Drankenorganisatie 

Nederland 

▪ Dreyers Grand Ice Cream 

▪ DSM NeoResins 

▪ DSM Nutritional Products 

AG 

▪ DuPont  

E 

▪ Eaton Aerospace 

▪ Ecolab 

▪ Electronic Data Systems 

▪ EMC 

▪ EMI Music Spain SL 

▪ ENSCO International 

▪ Environmental Protection 

Agency 

▪ EPCOR 

▪ Epic Games, Inc. 

▪ Epic Systems Corporation 

▪ Ericsson AB 

▪ Ernst & Young 

▪ Estee Lauder 

▪ EVO Payments 

International GmbH 

▪ EXEL 

▪ Exide Technologies 

▪ Expedia 

▪ ExxonMobil 

▪ EYEE ESTUDIOS 

EMPRESARIALES, AIE  

F 

▪ Facebook Inc 

▪ Faiveley Transport 

▪ Fannie Mae 

▪ FBI - ViCAP 

▪ FD Solutions 

▪ FedEx 

▪ Ferrero 

▪ Fidelity National Financial 

▪ FINANSBANK A.S. 

▪ Fiserv 

▪ FLEXTRONICS 

TECHNOLOGIES PVT LTD 

▪ Fluor 

▪ FMC Technologies 

▪ Folkeuniversitetet Oslo 

▪ Foot Locker 

▪ FOSSIL 

▪ France Telecom 

▪ FSD Fahrzeugsystemdaten 

GmbH  

G 

▪ GameStop 

▪ Gannett 

▪ GE 

▪ Gemeente Almelo 

▪ Gemeente Leiden 

▪ General Dynamics 

▪ General Motors 

▪ Genworth Financial 

▪ George Washington 

University 

▪ GfK Benelux MS B.V. 

▪ GlaxoSmithKline SA (Pty) 

Ltd 

▪ Global Tower Partners 

▪ GODADDY.COM 

▪ Goldman Sachs JBwere 

Services Pty Ltd 

▪ Google 

▪ GSK 

▪ G-Star Raw C.V. 

▪ Guess?, Inc. 

▪ Gulf Air  
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H 

▪ Halliburton 

▪ Harland Clarke 

▪ HCA 

▪ Heineken USA 

▪ HEINZ WORLD 

HEADQUARTERS H57 

▪ Hershey 

▪ Hewlett Packard 

▪ HOLLAND AMERICAN LINE 

INC. 

▪ Home Depot 

▪ Home Shopping Network 

▪ Honeywell 

▪ Hormel Foods 

▪ Hyundai Auto Canada  

I 

▪ IBM 

▪ IEEE 

▪ Ikon Office Solutions 

▪ IMF 

▪ IMS Health 

▪ Infor 

▪ ING Car Lease 

▪ Ingram Micro 

▪ InSites NV 

▪ Intel 

▪ International Paper 

▪ Intuit 

▪ INVISTA 

▪ Iron Mountain   

J 

▪ J.F. Shea Co., Inc. 

▪ Jabil Circuit 

▪ Jack in the Box 

▪ Jarden Leisure & 

Entertainment 

▪ John Deere 

▪ Johnson & Johnson 

▪ Johnson Controls  

K 

▪ Kaiser Permanente 

▪ KBR 

▪ Kelly Services 

▪ KEMA Consulting GmbH 

▪ Kiewit 

▪ Knight 

▪ KNSB 

▪ Koninklijke Bibliotheek 

▪ Kotak Mahindra Bank Ltd 

▪ KPMG 

▪ Kraft Foods 

▪ Kraton Polymers 

▪ Kuehne+Nagel AB 
 

L 

▪ L-3 COMMUNICATIONS 

▪ Land O'Lakes 

▪ Landal GreenParks 

▪ Lands' End 

▪ Legal Marketing Services 

Ltd 

▪ Leggett & Platt 

▪ Lennox International 

▪ Levi Strauss & Company 

▪ LexisNexis 

▪ Lexmark 

▪ Library of Congress 

▪ LinkedIn Corporation 

▪ LL Bean 

▪ Lockheed Martin 

▪ L'Oréal 

▪ Lyonnaise des Eaux 

M 

▪ Magellan Health Services 

▪ ManTech 

▪ Marriott International 

▪ Martin Marietta Materials 

▪ MasterCard 

▪ McCormick 

▪ McKesson 

▪ McKinsey & Company 

▪ MDA Ltd 

▪ MeadWestvaco 

▪ Media Markt 

▪ Medtronic 

▪ Meijer Inc 

▪ Melbourne University 

Student Union Ltd 

▪ Menard, Inc. 

▪ Meredith 

▪ METRO Cash & Carry 

Nederland B.V. 

▪ Microsoft 

▪ Ministerie van 

Economische Zaken, 

Landbouw en Innovatie 

▪ Ministerie van SZW 

▪ Mitsubishi Motor 

▪ Monsanto 

▪ Monster 

▪ Motorola Solutions 

▪ MTV Networks BV 

▪ MultiCopy 

▪ Musgrave Retail Partners 

NI   

N 

▪ N.V. Eneco beheer 

▪ National Oilwell Varco 

▪ National Semiconductor 

▪ National Steel & Ship 

▪ NCR 

▪ Nederlands Meetinstituut 

▪ Ness Technologies India Pvt 

Ltd 

▪ Nestle 

▪ Newell Rubbermaid 

▪ Newfield Exploration 

▪ NISSAN N.A. 

▪ Nokia Corporation 

▪ Norfolkline B.V. 

▪ Northern Operating 

Services Pvt Ltd 

▪ NORTHERN TRUST 

▪ Northrop Grumman 

▪ Novartis AG 

▪ Novo Nordisk 

▪ Nutreco Nederland BV 

▪ Nvidia Graphics  

O 

▪ OFFICE DEPOT 

▪ OfficeMax 

▪ OGE Energy 

▪ Oracle 

▪ owens & minor 

▪ Owens Corning   

P 

▪ Panasonic Australia Pty Ltd 

▪ Parker Hannifin 

▪ Peabody Energy 

▪ Pentair 

▪ Peopleclick, Inc. 

▪ PepsiCo 

▪ PerkinElmer 

▪ Perot Systems 

▪ PetSmart 

▪ Philips Electronics 

▪ Philips Healthcare 

▪ Pinnacle Security 

▪ Pioneer Foods 

▪ PPG Industries 

▪ Praxair 

▪ PricewaterhouseCoopers 

▪ Procter & Gamble 

▪ PUMA Benelux BV  

Q 

▪ Qatar Airways 

▪ QGC 
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▪ Queensland Treasury 

Corporation   

R 

▪ Rabobank Randmeren 

▪ Raiffeisenbank Austria d.d. 

▪ Raytheon 

▪ Redland Shire Council 

▪ Rentokil 

▪ Repco Pty Ltd 

▪ Repsol Services Company 

▪ Ricoh 

▪ Rio Tinto 

▪ Roche 

▪ Rockwell Automation 

▪ Rockwell Collins 

▪ Rolls-Royce Motor Cars 

▪ Ross Stores 

▪ RR Donnelley 

▪ RTL Nederland 

▪ Rural Telephone Service Co. 

Inc. 

▪ RUSSELL INVESTMENT 

GROUP  

S 

▪ SAGER ELECTRONIC 

CORPORATION 

▪ SAIC 

▪ Saint-Gobain Weber 

Cimenfix 

▪ Samsung Electronics 

America, Inc. 

▪ Sandvik 

▪ Sara Lee 

▪ SAS 

▪ Scope International 

▪ Seagate Technology 

▪ Sennheiser 

▪ ServiceMaster 

▪ Shaw Group 

▪ Shell Business Services 

Centre 

▪ Shutterstock 

▪ Siemens 

▪ SISTERS OF MERCY HLTH 

SYS 

▪ Sitel Inc. 

▪ Smith International 

▪ Smithfield Foods 

▪ Smurfit-Stone Container 

▪ Sodexo 

▪ Softcell Technologies 

Limited 

▪ SONY PICTURES 

ENTERTAINMENT 

▪ Sorenson Communications 

▪ Southwest Florida Water 

Management District 

▪ Spartan Stores 

▪ SPX 

▪ St. Jude Medical 

▪ Stahl Europe bv 

▪ Stanford University of 

School of Medicine 

▪ Staples 

▪ Steelcase 

▪ Subsea 7 

▪ Sun Chemical 

▪ Sun Healthcare Group 

▪ Supervalu 

▪ Sutter Health 

▪ Suzuki Austria Automobile 

Gbmh 

▪ Symantec 

▪ Syngenta Seeds  

T 

▪ Tenneco 

▪ Teters Floral Products 

▪ Texas Instruments 

Incorporated 

▪ The Australian National 

University 

▪ The British Library 

▪ The Coleman Company 

▪ The Dow Chemical 

Company 

▪ The George Washington 

University 

▪ The Laminex Group 

▪ The New York Times 

▪ The Nielsen Company 

▪ The University of 

Northampton 

▪ The World Bank 

▪ Thermo Fisher Scientific 

▪ Thomson 

▪ Thomson Reuters 

▪ Thule 

▪ Thyssenkrupp Aerospace 

▪ TIAA-CREF 

▪ Tiger Brands 

▪ Time Warner Cable 

▪ Timken 

▪ T-MOBILE USA 

▪ TORRENT 

PHARMACEUTICALS LTD. 

▪ Toshiba Europe GmbH 

▪ Tourism Tasmania 

▪ Towers Perrin 

▪ Toyota SA 

▪ Trane 

▪ Trinity Industries 

▪ Triumph Motorcycles Ltd 

▪ TUI Nederland 

▪ Tyco Electronics  

U 

▪ Ugam Solutions Private 

Limited 

▪ Uline 

▪ Unilever 

▪ United Rentals 

▪ Universal American 

▪ Universal Health Services 

▪ Universiteit Groningen 

▪ University of Brighton 

▪ University of Helsinki - 

Biomedicum 

▪ University of Richmond 

▪ University of St Andrews 

▪ University of the West of 

Scotland 

▪ UPC Broadband Operations 

BV 

▪ UPS 

▪ URS 

▪ US Department of Energy 

▪ US EPA 

▪ US Fish and Wildlife Service 

▪ US Foodservice 

▪ US Forest Service 

▪ USG 

▪ UTS CARRIER LLC   

V 

▪ Value Retail PLC 

▪ Varian Medical Systems 

▪ Vectren 

▪ Verizon 

▪ Verizon Communications 

▪ VirginMedia 

▪ Vital Forsikring ASA 

▪ Vodafone Romania 

▪ Volkskreditbank AG 

▪ Volkwagen AG 

▪ Volvo Truck & Bus Centre 

East Anglia  
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W 

▪ W.W. Grainger 

▪ Walker & Associates, Inc. 

▪ Walt Disney World Co 

▪ Washington University 

▪ Waste Management 

▪ Wells Fargo 

▪ Westminster City Council 

▪ Weyerhaeuser 

▪ Whirlpool 

▪ Williams-Sonoma 

▪ Windstream 

▪ workday 

▪ Wyeth   

X 

▪ Xerox 

▪ Xstrata Coal South Africa   

Y 

▪ Yahoo 

▪ Yamaha Golf Car Company 

▪ Yarden 

▪ Yellowbook USA 

▪ YUM BRANDS, INC   

Z 

▪ Zero Waste SA 

▪ Ziggo 

▪ Zumtobel AG 

▪ Zycus Infotech Pvt. Ltd
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9 Contact & Support 

9.1 Get the latest information on ASAP Utilities 
Our website contains the latest information on ASAP Utilities, tutorials, background articles, 

update information, links to relevant sites and more. 

https://www.asap-utilities.com 

9.2 Contact us 
We love to hear your opinion and comments or suggestions. Please get in touch. 

This helps us to make ASAP Utilities a better product every time. 

Due to the international nature of ASAP Utilities with different languages and time zones 

(we have clients in over 140 countries) we prefer contact by email. 

For questions regarding ASAP Utilities or feedback send email to: 

support@asap-utilities.com 

or: 

A Must in Every Office BV 

Molenweg 242 

8012 WT  Zwolle 

The Netherlands 

https://www.asap-utilities.com/contact.php 

 

For more information about ASAP Utilities, see our website at: 

https://www.asap-utilities.com 

9.2.1 Priority support for customers 

If you are a registered customer then please include your order number, for a fast-track 

(priority) response. 

You can find your order number in email you received after the purchase.  

You can also find your order details in the Excel menu: ASAP Utilities » Registered version. 

9.3 Social media 
You can also connect with us via: 

facebook.com/ASAPUtilities 

twitter.com/ASAPUtilities 

https://www.asap-utilities.com/
mailto:support@asap-utilities.com
https://www.asap-utilities.com/contact.php
https://www.asap-utilities.com/
http://www.facebook.com/ASAPUtilities
http://twitter.com/#!/ASAPUtilities
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10 Index 

A 

ASAP Utilities could not be found, 372 

ASAP Utilities menu, 33 

asap_custom_menu.ini, 376 

B 

Bug report, 321 

C 

certificate, 349, 378 

D 

digitally signed, 349, 378 

download ASAP Utilities, 12 

E 

Excel 2000, 13 

Excel 2002/XP, 13 

Excel 2003, 13 

Excel 2007, 13 

Excel 2010, 13 

Excel 2013, 13 

Excel 2016, 13 

Excel 2019, 13 

Excel 2021, 13 

Excel 365, 13 

F 

FAQ, 321 

G 

general Excel questions, 321 

H 

History of ASAP Utilities, 325 

I 

International versions of Excel, 13 

K 

keyboard shortcuts, 38 

L 

language, 9, 13 

library folder, 358 

M 

Macro security, 378 

N 

Network installation, 365 

P 

Priority support, 321 

Purchase, 28 

Q 

questions, 321 

R 

registration code, 30 

registry settings, 376 

Remove ASAP Utilities. See Uninstall 

right-click/context menu, 36 

S 

security, 378, 379 

T 

temporarily uninstall, 373 

translating, 9 



ASAP Utilities User Guide FREQUENTLY UPDATED 

 

338 Chapter 10 

 

 

Troubleshooting, 321 

Trust all installed add-ins and templates, 379 

Trusted sources, 379 

U 

Undo, 26 

Uninstall, 369 

Upgrade, 363 

Z 

zipped-package, 348 
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11 Appendix 1: Screenshots 

11.1 ASAP Utilities in Excel 365, 2021, 2019, 2016, 

2013, 2010 or 2007 

11.1.1 English/international 

 

11.1.2 Dutch (Nederlands) 
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11.1.3 German (Deutsch) 

 

11.1.4 Spanish (Español) 

 

11.1.5 French (Français) 
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11.1.6 Portuguese (Brazil) (Português do Brasil) 

 

11.1.7 Italian (Italiano) 

 

11.1.8 Russian (Русский) 
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11.1.9 Chinese (Simplified) (中文(简体)) 

 

11.1.10 Japanese (日本語) 
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11.2 ASAP Utilities in Excel 2000, 2002/XP or 2003 

11.2.1 English 

 

11.2.2 Dutch (Nederlands)  
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11.2.3 German (Deutsch) 

 

11.2.4 Spanish (Español) 
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11.2.5 French (Français) 

 

11.2.6 Portuguese (Brazil) (Português do Brasil) 
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11.2.7 Italian (Italiano) 

 

11.2.8 Russian (Русский) 
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11.2.9 Chinese (Simplified) (中文(简体)) 

 

11.2.10 Japanese (日本語) 
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12 Appendix 2: Technical 

information about the setup 

This chapter is aimed at system administrators and is mainly written to give some in depth 

information on how the setup process works. 

The latest information is available on our website: 

https://www.asap-utilities.com/setup-technical.php 

12.1 Installation 
ASAP Utilities is easy to install. 

12.1.1 Standard setup 

Just like most software, it is required that you have the sufficient rights to install software 

on the computer. Upon the installation of ASAP Utilities you must be logged in as an 

administrator or as a member of the Power Users group or you can choose to run the setup 

as administrator. 

Every user on the computer is able to use ASAP Utilities after the installation is finished. 

https://www.asap-utilities.com/faq-questions-answers-detail.php?m=109 

ASAP Utilities is automatically added to the Excel menu for the user that performs the 

installation. If other users of the same computer also want to use ASAP Utilities in Excel, 

you can specify this during the setup otherwise they need to perform steps 3 to 6 of the 

paragraph “Manual installation” on page 357 or run the 

'Add_ASAP_Utilities_to_the_Excel_menu.exe' program which only adds ASAP Utilities to 

the Excel menu for the user that runs it. This file does NOT require special/administrator 

rights, so any user can run it. 

Starting from version 7, this file is located in the ASAP Utilities program files folder (by 

default C:\Program Files (x86)\ASAP Utilities\). 

12.1.2 Non-admin setup 

For users with either Excel 2010 or later we have created a special version of the Business 

edition that standard/limited users can install. 

This is edition is also available as a zipped-package with just the xlam, txt and pdf files. 

This single-user setup does not require administrator rights during the installation. 

https://www.asap-utilities.com/setup-technical.php
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12.1.3 Automatic installation 

Automatic installation is as easy as to follow the steps presented to you when you run the 

setup file. During the setup you can specify the location where you want to install the files 

and at the end ASAP Utilities will be available in your Excel menu. 

ASAP Utilities does not require your computer to restart at the end of the installation. 

1 Prior to installing 

 

▪ Just like with most programs it is recommended that all programs currently running on 

your computer are closed before you run the setup. 

▪ It is not recommended to uninstall a previous version of ASAP Utilities. If you do so all 

settings will be reset to the default settings, such as your favorite tools menu and your 

registration information (license). 

▪ ASAP Utilities is digitally signed. This gives several benefits. For one example, it assures 

you that the files come from us and have not been tampered with. The company name 

you will see on the certificate is "A Must in Every Office BV". Windows might display this 

before the setup starts. 

The name of our company is A Must in Every Office BV:  

 

2 Performing the installation 

 

1. Download the ASAP Utilities setup file and run it. 

You can download the setup from: 

https://www.asap-utilities.com/download.php 

https://www.asap-utilities.com/download.php
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Select the language to use during the installation and choose OK. 

You can choose from the following languages for the setup: 

1. English 

2. Deutsch (German) 

3. Español (Spanish) 

4. Français (French) 

5. Italiano (Italian) 

6. Nederlands (Dutch) 

7. Português do Brasil (Portuguese (Brazil)) 

8. Русский (Russian) 

9. 中文(简体) (Chinese (Simplified)) 

10. 日本語 (Japanese) 

 

 

2. The installation wizard begins and the welcome dialog is displayed. Click on the Next-

button to continue.  

 

3. The License Agreement dialog is displayed. Please take time to read the license 

agreement. If you agree choose "I accept the agreement" and then click on the Next-

button. If you disagree with the license terms, choose "I do not accept the agreement". 
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If you do not accept the agreement the installation will be canceled. 

 

4. An information dialog is displayed. Click the Next-button to continue. 

 

5. Select a folder to install ASAP Utilities. We recommend you use the default folder, 

"C:\Program Files (x86)\ASAP Utilities" or "C:\Program Files\ASAP Utilities\" but any 

other location can be used too. 

ASAP Utilities + this PDF User Guide requires approximately 45 MB of disk space. 

If you have a previous version of ASAP Utilities installed and are upgrading, then the 

setup will automatically detect the previously used destination folder. 

Click the Next-button to continue. 
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6. If you want to, then ASAP Utilities can create an entry in your start menu. Click the 

Next-button to continue. 

 

7. Edition 

The following screen is shown only if you install ASAP Utilities on a system with 32-bit 

Excel 2010 or later.   

When the system that runs the setup has the 64-bit editions of Excel 2010 or later 

installed then the universal 32+64-bit edition of ASAP Utilities is installed without 

asking this question. When the computer that runs the setup has Excel 2000-2007 

installed then the 32-bit edition of ASAP Utilities is installed without asking this 

question. 
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8. Add ASAP Utilities automatically to the Excel menu for:  

If you want the ASAP Utilities menu to be automatically added in Excel for all users on 

this computer choose "Anyone who uses this computer (all users)". Click the Next-

button to continue. 

This will automatically add ASAP Utilities to the Excel menu for each user that logs in on 

the computer. This is also handy when you log in with normal user-rights and run the 

setup as an administrator. At the end of the setup, we'll show how to manually add 

ASAP Utilities to the Excel menu if needed (step 10). 

Trusted Publishers, Office Trust Center Setting 

During the setup you can have our company (A Must in Every Office BV) automatically 

added to the List of Trusted Publishers in Excel. 

Some people have their Excel security settings set to 'only allow macros run by Trusted 

Publishers', and then this can help. 
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9. Click "install" to install the files to the selected folder. 

 
 

The setup program now installs ASAP Utilities on your computer: 

 

10. The Setup is completed. Click the Finish button. 

 

11. The installation is finished, and you are ready to use ASAP Utilities. 
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Depending on the language of your Excel version, ASAP Utilities will appear in that 

same language if available. Otherwise it will default to English. 

In the Excel menu you will find a new item called "ASAP Utilities". 

(In the rare situation that you don't see ASAP Utilities in the Excel menu, read our FAQ: 

https://www.asap-utilities.com/add-to-excel-menu.php) 

ASAP Utilities in Excel 365, 2021, 2019, 2016, 2013, Excel 2010 or Excel 2007 

 

ASAP Utilities in Excel 2003, Excel 2002/XP or Excel 2000 

 

 

If you've chosen to create a start-menu folder at step 6, then a new program folder 

https://www.asap-utilities.com/add-to-excel-menu.php
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called "ASAP Utilities" is created in your Windows Start menu: 

 

3 Enter your license details 

To turn your copy of ASAP Utilities into a registered version do the following: 

▪ In the Excel menu choose the right-bottom button in the ASAP Utilities Tab 

(Trial version…, Enter License… or Home&Student Edition…). 

Then click on the button "Enter registration information". 

Excel 365, 2021, 2019, 2016, Excel 2013, Excel 2010 or Excel 2007: 
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Excel 2003, Excel 2002/XP or Excel 2000: 

 
▪ Fill in all the fields exactly the same as in the email with your full license details. 

You received two emails after the order was completed. The email from "ASAP Utilities 

(A Must in Every Office BV)" contains the full license information. 

After you entered the information click on the "Register" button. 

▪ We recommend you to use "copy and paste" to avoid typing errors. 

The information is case sensitive. 

You can use the shortcut Control+V to paste the information in the fields. 

 
 

 

12.1.4 Manual installation Excel 2000, 2002/XP, 2003 

Although we recommend the automatic installation, the manual installation is easy to do. 

You must be logged in as an administrator or as a member of the Power Users group when 

installing ASAP Utilities or you can choose to run the setup as administrator. When the 

installation is finished every user on the computer is able to use ASAP Utilities. 

https://www.asap-utilities.com/faq-questions-answers-detail.php?m=109 

Starting from version 4.1.1, ASAP Utilities is no longer available as a zipped-package; 

instead it can only be downloaded as an executable setup file. This paragraph about the 

manual installation is for your background information. 
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Walk through the following steps. 

1. Place all the ASAP Utilities files on your hard drive. It doesn’t matter what the location 

is, as long as all the files in the package are together. 

The recommended location is: “C:\Program Files\ASAP Utilities\” or 

“C:\Program Files (x86)\ASAP Utilities” 

2. Start Microsoft Excel  

3. In the tools menu, choose Add-Ins. 

 

4. Use the “Browse...” button to locate the ASAP Utilities.xla file 

(default is C:\Program Files\ASAP Utilities\ or C:\Program Files (x86)\ASAP Utilities) 

 

If Excel asks you to copy the file to the library folder, answer “no”. (this is important) 
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5. Check the “ASAP Utilities” check box. 

 

6. Next to “Help” in the menu, there is an option called “ASAP Utilities”.  

If ASAP Utilities is not there, you have to close and restart Excel. 

7. Installation is now finished. Have fun! 

12.1.5 Manual installation Excel 365, 2021, 2019, 2016, 2013, 

2010 

Although we recommend the automatic installation, the manual installation is easy to do.  

This paragraph about the manual installation is only kept as background information. 

Walk through the following steps. 

1. Place all the ASAP Utilities files on your hard drive. It doesn’t matter what the location 

is, as long as all the files in the package are together. 

The recommended location is: “C:\Program Files\ASAP Utilities\” or 

“C:\Program Files (x86)\ASAP Utilities” 
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2. Start Microsoft Excel  

3. Click on the upper-left icon or the File icon. 

Then click on the "Excel Options" button: 

 

4. Choose Add-Ins: 

 

5. Press the "Go..." button to manage the Excel add-ins: 

 

6. Click on the browse-button in the Add-Ins dialog to locate the ASAP Utilities.xlam file 

(by default in the folder “C:\Program Files\ASAP Utilities\” or 

“C:\Program Files (x86)\ASAP Utilities”) 

If Excel asks you to copy the file to the library folder, always answer "no". (this is 
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important) 
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7. Check the "ASAP Utilities" check box and press the OK-button. When you do that 

ASAP Utilities will be started. 

 

8. In the add-ins tab there is the menu of "ASAP Utilities". 

If you do not see ASAP Utilities in the menu you have to close and restart Excel. 

Installation is now finished. Have fun! 
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12.1.6 Upgrade to a new version 

If you install the new version in the same location as the previous version, it is not 

necessary to uninstall the previous version before installing the new one. The settings of 

your previous version (including the favorites menu) will then be kept. 

Important 

Do *NOT* uninstall your existing ASAP Utilities version before installing the new version; 

otherwise, you will lose your settings and you will have to re-enter your license details. 

Just install the new version “on top” of your current version. 

If you want to install ASAP Utilities in another location, we recommend you to back-up the 

favorite’s menu file if you have made changes to the favorites menu 

(asap_custom_menu.ini) and uninstall the old version first. 

Make sure Excel is closed and then run the setup or overwrite the old files. During the setup 

you have to install the files into the same location as the old version. Usually this is 

“C:\Program Files\ASAP Utilities\” or “C:\Program Files (x86)\ASAP Utilities”. 

If you are not sure about that location you can see it in ASAP Utilities. Start Excel and then: 

ASAP Utilities » ASAP Utilities Options » Settings, language and contact information… 
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1 Home & Student edition: Required upgrade once a year 

Since 2001 it's our policy to force an upgrade (free) once or twice a year to the 

free/unregistered (Home and Student) edition to make sure you are always using the latest 

stable and most complete version. This is the only way to make sure everybody is using the 

most recent version. In the past we were receiving too many emails from people with 

feature requests and bug reports that had already been implemented or solved in the new 

version. 

Starting from 2012 the required upgrade has been reduced to once a year. 

The new-version date is a pre-built-in date. No connection to the internet is made when 

determining if there is a new version available. When you start a utility in ASAP Utilities and 

this new-version-date is available, you will get a notice about the new version. 

When you start a utility in ASAP Utilities and this new-version-date has come, you will get a 

notice: 

 

When you click on the “Download from www.asap-utilities.com” button, Excel will try to 

open <www.asap-utilities.com> in your default browser. It will not automatically download 

the new version, you have to download the new version yourself and perform the 

installation. 
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This message will be shown only once a day when you start one of the ASAP Utilities tools.1. 

You have the option to turn off the message for the next ten days. This way you can 

continue to work without being bothered too much. Make sure you do the upgrade before 

the end date is reached. After the end date the current (old) version will no longer work. 

I’m sorry, but this is the only way to make sure people are using the most recent version. In 

the past we were receiving too many emails from people with feature requests and bug 

reports that had already been implemented or solved in the new version. 

If you can't download from our website (www.asap-utilities.com), we can send you the new 

version by email. Please send your request to newversion@asap-utilities.com and you will 

get a reply with the new version attached approximately 2-3 MB). You have a period of 

approximately 3 months to upgrade (free). 

 

Be informed by email when a new version is released 

Subscribe to our Newsletter and you will receive free e-mail updates when a new version or 

an important update of ASAP Utilities is released. 

https://www.asap-utilities.com/asap-utilities-newsletter.php 

Registered users / commercial organizations 

If you have a purchased a license and entered the license details in ASAP Utilities, then the 

program will never expire. You can choose your own time to upgrade to a newer version or 

just stay with your current version. This is one of the major benefits for large organizations 

with locked down computers. Buying a license for ASAP Utilities is possible since 

March 2007. 

https://www.asap-utilities.com/license-benefits.php 

https://www.asap-utilities.com/download-old-versions.php 

12.1.7 Network installation 

There are several options for a network installation. In this section we provide some tips 

about the way Excel works with add-ins. Please test them before you deploy. 

The latest (technical) information about network installations is available on our website: 

https://www.asap-utilities.com/setup-technical.php 

You can install ASAP Utilities (or place all files) on a central location on your network and 

have ASAP Utilities listed in the add-ins dialog in Excel or have it automatically loaded. If 

you manually place the files on a central location, make sure all files are in the same folder. 

The benefit of having ASAP Utilities on a central location on the network is that upgrading 

to a new version is as simple as installing it once into that folder. 

 

1 Starting in version 4.0 (August 2006) the update notice will not anymore be shown on 

Excel's start-up but only when you start one of the ASAP Utilities tools. In the old version 

3.10 the update notice will be shown during the upgrade period when you start Excel. 

https://www.asap-utilities.com/asap-utilities-newsletter.php
https://www.asap-utilities.com/license-benefits.php
https://www.asap-utilities.com/license-benefits.php
https://www.asap-utilities.com/download-old-versions.php
https://www.asap-utilities.com/setup-technical.php
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After placing the files on a network drive there a few things you might have to do: 

▪ Users have to be able to load ASAP Utilities (read access to the files). 

▪ You can have ASAP Utilities loaded for every user each time Excel starts. 

Excel stores which add-ins to load only on a per-user basis. Excel does not have a setting 

to have your add-in loaded for every user on a computer. However, if you want 

ASAP Utilities automatically added to the Excel menu for all users, you can specify this 

during the setup or, in the registry (12.3.3, “Add ASAP Utilities to the Excel menu for all 

users” on page 377) 

▪ Besides the installation you should also add the license information in the registry of 

every user (HKEY_CURRENT_USER) to make sure they get the registered version that 

does not expire. This is described in paragraph 12.3.512.3.5, “Registration/license 

settings” on page 378. 

1 Display ASAP Utilities in Excel’s Add-in list 

To have ASAP Utilities available in Excel’s add-in list you have to add it to the registry for 

each user. This will only show ASAP Utilities in the add-in list. It will not automatically load 

ASAP Utilities. 

Create a new string value in the registry key: 

HKEY_CURRENT_USER\Software\Microsoft\Office\ <version> \Excel\Add-in Manager\ 

 

For example, for Office 2016 this is: 

HKEY_CURRENT_USER\Software\Microsoft\Office\16.0\Excel\Add-in Manager\ 

Excel 2000 9.0 

Excel XP/2002 10.0 

Excel 2003 11.0 

Excel 2007 12.0 

Excel 2010 14.0 

Excel 2013 15.0 

Excel 2016 16.0 

Excel 2019 16.0  (same as Excel 2016) 

Excel 2019 16.0  (same as Excel 2016) 

Excel 2021 16.0 (same as Excel 2016) 

Excel 365 16.0  (same as Excel 2016) 

 

Create a new string value where the name is the full path and filename of ASAP Utilities.  

ASAP Utilities 7, 32-bit uses ASAP Utilities.xla 
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ASAP Utilities 7, universal 32+64-bit uses ASAP Utilities.xlam 

For example: O:\Apps\Office\Add-ins\ASAP Utilities\ASAP Utilities.xla for the 32-bit edition 

or O:\Apps\Office\Add-ins\ASAP Utilities\ASAP Utilities.xlam for the universal 32+64-bit 

edition.  

The value data is empty: 

 

When the user now starts Excel ASAP Utilities is available in the Tools » Add-ins list: 

 

2 Load ASAP Utilities on Excel startup 

To have ASAP Utilities automatically loaded every time Excel starts you have to follow the 

steps in this paragraph. If you want this for all users on the computer, please have a look at 

paragraph 12.3.3 Add ASAP Utilities to the Excel menu for all users on page 377. 

You can either do this by editing the registry either manually or via a script, or by running 

the program “Add_ASAP_Utilities_to_the_Excel_menu.exe” which is located in the 

ASAP Utilities program files folder and automatically adds ASAP Utilities to the Excel menu 

for the Windows user accounts that runs this program. 

To have ASAP Utilities automatically installed you have to write an entry to the registry key: 

HKEY_CURRENT_USER\Software\Microsoft\Office\<version>\Excel\Options\ 

Excel 2000 9.0  

Excel XP/2002 10.0  

Excel 2003 11.0  

Excel 2007 12.0  
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Excel 2010 14.0  

Excel 2013 15.0  

Excel 2016 16.0  

Excel 2019 16.0  (same as Excel 2016) 

Excel 2021 16.0 (same as Excel 2016) 

Excel 365 16.0 (same as Excel 2016) 

 

In Excel 2016 this is for example: 

HKEY_CURRENT_USER\Software\Microsoft\Office\16.0\Excel\Options\ 

 

In this key there are a set of ascending entries numbered OPEN, OPEN1, OPEN2, etc. The 

value of each of these entries is the full path to and the filename of the add-in. 

To add ASAP Utilities, you have to find the highest numbered OPEN<n> value and create a 

new value one higher. They must be continuous and in the following order: 

OPEN 

OPEN1 

OPEN2 

OPEN3 

etc. 

In a clean Excel installation without any add-ins installed there are no OPEN values. In that 

case you can add ASAP Utilities by creating a new value of the string type with the name 

OPEN and as value the full path and filename of ASAP Utilities, surrounded by quotation 

marks.  

ASAP Utilities 7, 32-bit uses ASAP Utilities.xla 

ASAP Utilities 7, universal 32+64-bit uses ASAP Utilities.xlam 

For example: 

"O:\Apps\Office\Add-ins\ASAP Utilities\ASAP Utilities.xla" for the 32-bit edition or 

"O:\Apps\Office\Add-ins\ASAP Utilities\ASAP Utilities.xlam" for the 32+64-bit edition. 

 You have to write the double-quotes (") around it because the path/filename contains 

spaces. 

 

 
If you precede the add-in name with a /R switch the add-in will be opened as read-only. 
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Example of the registry key with no other add-ins loaded: 

 

Example of the registry key when the MS Analysis Toolpack was already active as add-in, 

ASAP Utilities now uses the OPEN1 key: 

 

12.2 Uninstall 

12.2.1 Automatic 

The easiest and recommended way to uninstall ASAP Utilities is to do this via the Windows 

Control Panel. 

1 Windows XP and 2000 

Start > Settings > Control Panel > Add or Remove Programs 

or 

Start > Control Panel > Add or Remove Programs 
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Then select ASAP Utilities in the list of programs and click on the "Remove" button: 

 

2 Windows 11, 10, 8, 7 and Vista 

Start > Control Panel > Programs: Uninstall a Program 

Then select ASAP Utilities in the list of programs and click on the "Uninstall" button: 

 

3 Windows 8, Windows 10 and Windows 11 

Search for “Uninstall a Program” in the Settings group 

Then select ASAP Utilities in the list of programs and click on the "Uninstall" button: 

 

 

Note 

If other users on the same computer used ASAP Utilities too, you will have to manually 

remove ASAP Utilities from their list of Excel add-ins. This is something that can only be 

automated for the user that runs the uninstall due to the design/restrictions of 

MS Windows. In such a case the user has to follow step 4 till 7 of the manual uninstall. 
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12.2.2 Automatic uninstall #2 

As an alternative you can also use the following method to uninstall ASAP Utilities. 

You can also run “unins000.exe“, from the ASAP Utilities installation folder. The uninstaller 

removes all ASAP Utilities installation files and removes all ASAP Utilities entries from the 

registry. 

If you have specified an alternative location to store your favorites menu settings, you have 

to manually remove the file asap_custom_menu.ini from that location. 

 

 

12.2.3 Manual 

Another way is to manually remove ASAP Utilities but we recommend the automatic 

uninstall. 

1. Close Excel, if it is opened. 

2. ASAP Utilities 7, 32-bit edition only: 

Unregister the ASAP_Utilities.dll. To unregister the DLL use the command: 

RegSvr32.exe "<Drive + Folder>\ASAP_Utilities.dll" /u 

e.g. RegSvr32.exe "C:\ASAP Utilities\ASAP_Utilities.dll" /u 
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You can also use the shortcut “UnRegister DLL” we made for this: 

 

3. Delete the folder where the ASAP Utilities program was installed.  

Usually this is “C:\Program Files\ASAP Utilities” or 

“C:\Program Files (x86)\ASAP Utilities”. 

4. Start Excel, you will now receive an error, indicating that ASAP Utilities could not be 

found. 

 

5. Click OK. Then choose in the menu “Tools”, “Add-ins”. 
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6. Then uncheck the check box next to Asap Utilities. 

 

7. Excel will now ask you if you want to remove Asap Utilities from the list. Answer with 

yes. 

 

8. Now close the form, and ASAP Utilities is successfully uninstalled.  

ASAP Utilities is removed from your computer and Excel. 

 

12.2.4 Temporarily deactivating ASAP Utilities from startup 

If you want to temporarily uninstall ASAP Utilities, for example if you want to make 

screenshots and want the default Excel menu bar shown without ASAP Utilities, or if you 

think you have problems related to ASAP Utilities, you can do the following: 
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1 Automatically deactivate ASAP Utilities from starting up with 

Excel 

You can either uncheck ASAP Utilities manually from the add-ins list in Excel, or you can 

simply run the program “Remove_ASAP_Utilities_from_the_Excel_menu.exe” which is 

located in the ASAP Utilities program files folder. This will automatically remove 

ASAP Utilities from the Excel menu/deactivate it as add-in in Excel, for the Windows user 

accounts that runs this program. 

 

2 Excel 2000, 2002/XP and 2003 

In the Excel menu go to “Tools”, “Add-ins” and then uncheck the check box next to 

ASAP Utilities. This will remove ASAP Utilities from the menu. 
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If you want to enable ASAP Utilities again, check the checkbox next to ASAP Utilities again. 

3 Excel 2007, 2010, 2013, 2016, 2019, 2021 and 365 

In the Excel menu click on File (in 2007 the upper-left File “Office” button) and go to “Excel 

options”. 

 
Then choose “Add-ins” and choose Manage “Excel add-ins”. And then uncheck the check 

box next to “ASAP Utilities” or “ASAP Utilities x64”. This will remove ASAP Utilities from the 

menu. 
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If you want to enable ASAP Utilities again, check the checkbox next to ASAP Utilities again. 

12.3 User data and registry settings 
This chapter will tell you where ASAP Utilities saves its settings. 

12.3.1 Registry 

The settings of ASAP Utilities are stored in the registry in the following section: 

HKEY_CURRENT_USER\Software\VB and VBA Program Settings\ASAP Utilities\ 

12.3.2 Favorites menu 

The favorites menu, asap_custom_menu.ini, is by default stored in your application 

data folder, for example:  

C:\Documents and Settings\<UserName>\Application Data\ASAP Utilities\ 

or 

C:\Users\<UserName>\AppData\Roaming\ASAP Utilities\ 

 

However this can be changed via: 

ASAP Utilities » ASAP Utilities options » Settings, language and contact information... 

The folder where the favorites menu is located is stored in the value CustomMenuPath in 

the key:  

HKEY_CURRENT_USER\Software\VB and VBA Program Settings\ASAP Utilities\Setup 
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The location of the favorites menu file should preferably be writeable and editable, if not 

users can use the favorites menu but they cannot change it and will get a warning message 

when trying to. 

NOTE: In versions before 4.2.2 the file was by default placed in the same location where 

ASAP Utilities was installed, which was usually the program files folder. 

NOTE2: If you change the folder directly in the registry, make sure the .ini file exists in that 

location, otherwise the user will be prompted that the file wasn’t found there and asked to 

choose a new location. 

12.3.3 Add ASAP Utilities to the Excel menu for all users 

During the setup you can specify to have ASAP Utilities added to the Excel menu for all 

users or just for the user that runs the setup. 

If you specified to have ASAP Utilities added to the Excel menu for all users, then the 

program “Add_ASAP_Utilities_to_the_Excel_menu.exe” is added to the ActiveSetup to run 

once for each user on the system. 

HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Active Setup\Installed Components\ 

Or 

HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\Microsoft\Active Setup\Installed 

Components\ 

The program will run once for each user that logs on the system and due to the command-

line parameter /VERYSILENT it will run quickly and invisible to the user. 

12.3.4 Registering the DLL/COM add-in part (32-bit only) 

(This registry setting applies to the 32-bit-only edition of ASAP Utilities for Excel 2000-2007 

only. The ASAP Utilities universal 32+64-bits edition for Excel 2010 and later only uses xlam 

files) 

When the file ASAP Utilities.dll is registered it creates the following key. By creating this key 

in the HKEY_LOCAL_MACHINE ASAP Utilities can be used by all users on the particular 

computer. 

HKEY_LOCAL_MACHINE\SOFTWARE\ 

Microsoft\Office\Excel\Addins\ASAP_Utilities.adConnect 
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12.3.5 Registration/license settings 

The license is stored per user and the license information is stored in: 

HKEY_CURRENT_USER\Software\VB and VBA Program Settings\ASAP Utilities\setup\ 

The following string-values are used to store the registration information: 

▪ name 

▪ key 

▪ order 

▪ orderamount 

▪ organization 

Note: Some of these values are stored encoded. You will see this if you register 

ASAP Utilities manually. 

12.4 Macro security 
ASAP Utilities is digitally signed.  This gives several benefits. For one example, it assures you 

that the files come from us and have not been tampered with. 

The company name you will see on the certificate is "A Must in Every Office BV" 

 

During the installation ASAP Utilities will be installed as default add-in. This means that 

every time you start Excel, ASAP Utilities will be loaded and is ready to use. 

In order to use ASAP Utilities your security need to be set at a certain level. This level can be 

high, since ASAP Utilities contains a digital signature, you can choose to always trust us. 

In Excel 2003 and newer you also have the option to set the security lever to “Very High”, 
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however when you do that you won’t be able to use ASAP Utilities unless you set the level 

back to high, or choose to “Trust all installed add-ins and templates” (see the next chapter). 

You only need to change the below values if you encounter problems: 

In Excel’s menu choose: 

Excel 2003: 

Tools » Macro » Security » High 

Excel 2007: 

Office button » Excel options » Trust Center » Trust Center Settings  

Excel 2010, 2013, 2016, 2019, 2021 and 365: 

File » Excel options » Trust Center » Trust Center Settings  

 

Then choose “Disable all macros except digitally signed macros” or “Disable all macros with 

notification” 

 

ASAP Utilities will never(!) require you to lower your security settings to low. 

12.4.1 Trusted sources and security settings to “very high” 

If you want to run ASAP Utilities in Excel 2019, 2016, 2013, 2010, 2007 or 2003 with the 

security settings to “Very High”: then you have to have the “Trust all installed add-ins and 

templates” check box checked. This is the default setting of Excel so most likely you don’t 

have to change any settings. 

In Excel 2007 and newer choose in the Excel ribbon: 

Office button/File » Excel options » Trust Center » Trust Center Settings  

 

The default option that Excel uses is “Disable all macros with notification”. 
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By default add-ins are enabled in Excel 2007 and newer. 

Unlike Excel 2003 you won’t have to turn it on, but instead you can turn all Add-ins off. 

(Turning all add-ins off will also disable ASAP Utilities) 

 

 

To verify or change this setting in Excel 2003, choose in the Excel menu: 

Tools » Macro » Security 
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Then go to the “Trusted Publishers” tab and make sure the check box in front of “Trust all 

installed add-ins and templates” is checked. 
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12.5 How to use ASAP Utilities in your own macros 
Excel doesn't record the actions you do with add-ins, such as ASAP Utilities when you use 

the macro recorder. However, you can start the tools in ASAP Utilities from within your own 

macro. 

You do have to know the basic understandings of macros/VBA (Visual Basic for 

Applications). We do not officially support running ASAP Utilities macros from within your 

own macros and offer help on this, but it can be done. 

More information and a few examples are on our website: 

https://www.asap-utilities.com/run-as-part-of-a-macro-vba.php 
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